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1 General Features

TPG ProjectPowerPack (PPP) is a cloud-based app for project and portfolio management.
Additional apps are integrated into PPP that fulfill various tasks.

The TPG Scheduler is integrated for project planning. The TPG Scheduler provides all the essential

functions for project scheduling.

The TPG Scheduler@ can be found in the Schedule tab.

PPP

Project Details  Schedule ProjectTeam  Board  ResourcePlan  Commitments  Financials — Status Update  StatusReport  Risks lssues Changes Documents Actions Decsions Stakeholders
Ded - o 5 F et
i Mam oy s Finish Duration  Predeces ssigred By e e
a @ a Bl - @ a o
Q2062025 02.06.2025 Oduys
2 v () ceosznes  eroszces Hdas 1
ER 3 02062025 ey P
P 16062025 todep 3 o M
5 & ) wees0rs 27062025 Sdaps 4 P
T (o) arsess  arosstes Odaps 8 5ched uler
v ws 8112028 s 6
] a 032028 07.11.2028 Sdays L]
s 2 * Detailed Planning (%) tonas 21120 0der 8 L
w a * Feancing W) zanzs 2a11208 sdus 9 ™
1 & * Planning Completed =Y mn2es 2112005 Odas 7 L
2 ~  Phase 3 Eaecation 4. 01122025 13012026 32 days n

1.1 Views and Functions PPP
TPG PPP offers numerous views and functions:
= Programs and portfolios

= Project lists[ s 1 with traffic light indicators and project attributes (progress, KPI, start and finish

date, etc.)
= Kanban view of actions/ ]
= Resource management@ with resource attributes (department, cost rate, availability)

= Project requests with drivers and approval process

TPG PPP - Scheduler User Guide 2.16 EN
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= Assignment of project types and templates

= Task pIanning@ and resource allocation! & 1 with TPG Scheduler

= Recording of budget, forecasts and actual values| 13l in time periods

. Risksm, problemsm, changes@, actions+esland decisions 2l at project level
= Project assignment: drivers@, objectives@, benefits@, requirements@
= Stakeholder analysism and Lessons Learned|zs)

® |nter-project Links[ 751

= Status Update|1_oa and Status Reportm

= Comprehensive reporting packagem

= Drivers and priorities of project proposals and projects

= Functions for list entries

e Grouping

Hiding and showing columns

Sorting in ascending / descending order

Filter

Export to Excel
e Import from Excel

= Available languages: German, English, French, Arabic, Portuguese, Italian

P> Access rights are assigned via groups and roles.

TPG PPP - Scheduler User Guide 2.16 EN
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1.2 Configuration Options PPP

Company-specific configurations are possible in TPG PPP. The configurations are carried out by The

Project Group or by administrators.
Possible configurations:

* Layout adaptation to Cl

= Languages for the user interface

= Currency

= Users

= Resources and contacts

= Availability (calendar)

= Departments

= Project types

= Preset views (fields, dashboard)

= QOptions in some drop-down menus

= Color settings for heatmaps

= Time units for resource and cost planning (by default: months)

= Workflows

= Notifications

2 User Interface

The PPP user interface is explained below:
= Overview/ 101
] Workspacem
= Language settingsm

= Navigation bar[ 1]

TPG PPP - Scheduler User Guide 2.16 EN
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2.1 Overview
When TPG PPP is opened, the “My work” page opens as the start page by default.

This page provides an overview of the user's current work with project names, status information and

links to the data records.
Linked data records:
= My Actions Items
= My Active Projects
= My Active Risks

= My Active Issues

': e Welcome PPP Project Manager
B Dashbosd
Requents

3 Project Requests

Projects
B Fortiokos
My Action lbems My Active Projects My Acthve Risks : My Activn e
W Progeams
Rl [ selectan 1 [ setectai 1 [ Setect an 1 [ selectan
B Adions Mabinahene 2 E PPP Imglementation
In Progress 20241017
People
Malinahme 1 Projact A
B Rescurce Funs 1n Prograes 2023-1001
A Rescuross
- Project C2
N data mvailable Ho data svaiatle
Timsesheats Projact K
@ Timesheets
@ Approvas Projekt B2
| « <

- ekt XY
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2.2 Workspace

The

workspace in the TPG PPP is divided into 4 areas:

Header bar: Search function, buttons for quick data entry, notifications, personalization settings,

etc.
Command bar:[ 1 1Buttons depending on the content area

Navigation bar| s & Access to pinned and recently viewed pages. Access to home pages,

applications, projects, reports, etc.

Content area: “My work”, dashboard, workspace for reading and editing data records

© e Command bar Header bar

P Content area

— Navigation bar

2.3 Language Settings

The

TPG PPP is available in the following languages: German, English, French, Arabic, Portuguese,

Italian.

You

can specify the language under Personalization Settings:

> Click on the settings icon in the header bar (1)

TPG PPP - Scheduler User Guide 2.16 EN
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» Click on Personalization Settings (2)
Settings X
General
About
Privacy & Cookies Cf
Legal terms =7
More Settings
|F‘ersona|izatic|n Settingsl 2
Advanced Settings Cf
» Click on the Languages tab (3)
» Click on the User Interface Language field (4). » A drop-down menu opens.
> Select the desired language (e.g. English) (5).
Set Personal Options T X
Change the default display settings to personalize Microsoft Dynamics 365, and manage your email templates.
Gereral | Symehronization | Actwities | Formats  Emad Templates  Emall Signstures  Emaidl  Privacy 3
Sefect the language you prefer to see Miorosoft Dynamics 365 displayed in
Yiou can change the display Bngusge u f ifems guch &S menus and disiog bemes.
Base Larguage [E |
IJ:e' Filarface LANGuaGE Engiish bt I 4
Help Language: English -
ArBDIC I
| 5
French
Garman
Italian
Portuguese (Portugal)

Customize formats of number, currency, time and date information:
> Click on the Formats tab (6).

» Click on the Current Format field (7). » A drop-down menu opens.

TPG PPP - Scheduler User Guide 2.16 EN
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> Select the desired language (e.g. English (United Kingdom)) (8).

Set Personal Options ? %
Change the default display settings to personalize Micrascft Dynamics 365. and manage your email templates,
General | Synchronization | Actiities Email Tempiates  Email Signatunes Email  Privacy  Lanquages

Persanal Standards and Formats

Seiect how Microseft Dynamics 365 displays number, Curmency, Tme, and cate formais. Seiect  Tormat of CRck Cusiomipe 1o specy Custom formans.
Current Format

English (United Kingdom)

w |} Customize...
English [South Africa)

al
English (Triridad and Tobaga)

English [Wnibed Aral: Emnirtes)

English (United Kingdom)

English [United States)

> Click on OK (9)

Set Personal Options

T X
Change the default display settings to personalize Microsoft Dynamics 365, and manage your email templates.

General | Synchronization | Activities  Formats | Email Templates | Email Signatures  Email

Privacy | Languages
Personal Standards and Formats

Select how Microsoft Dynamics 365 displays number, currency, time, and date formats. Select a format or click Customize to specify custom formats.
Current Format
English [United Kingdam])

.
— Format Preview

Number

Cumenty

Time

Smort Date

Long Date

9 e

P The language, with the character formats, is set.

TPG PPP - Scheduler User Guide 2.16 EN
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2.4 Command Bar
The Command Bar is located above the Content Area m

The Command Bar contains buttons that provide you with various functions depending on the Content
Area (e.g., Home, Portfolios, Programs, Projects, Actions). Some of these buttons are standardized and

the same in every view, while others are displayed additionally depending on the Content Area.
Projects Content Area view

The following section explains the buttons using the Projects Content Area as an example:

—— _

I visalize thes vew O Email a Link B Flow ) Excel Templates @ Expont to Excel @ import from Excel

7 8 9 10 11 12

= Pneed

Requests

i Progect Requests

= Go Back: Navigates to the previously opened page. (1)
= Read Only Grid: Gantt Chart is hidden. (2)

» Click on Read Only Grid » The Gantt Chart is hidden and only the table with the active projects
is displayed.

» Click on TPG Project Gantt to display the Gantt Chart again.

< | B8 TPG Project Gantt

Active Projects

= Show Chart: Displays charts for the data records in the table in the Content Area (e.g., Projects).

(3)

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 14 /271



Tl

THE PROJECT GROUP

» Click on Show Chart. > A diagram will be displayed. Various options are available:

< P9 TPG Project Gantt  [5] Hide Chart

- New Project  [I] Delete | ~ (0 Refresh

Active Projects —<#—— Drop-down Menu for Project Selection

Projects by Health

System Charts

Projects by Health

Projects by Program

Top 10: Prioritization Score by Name

Total Budget by Project
5
Drop-down
Menu for
selecting the
Data displayed in
the Chart

3

Projects

2023 2024
Year (Start Date)

_|x

[J ProjectiD~

o7

Bl o= = 4+ m

Expand Chart
Refresh

Save As

New

Import
Export

Move right

4-1017

12-1001

4-1011

4-1018

4-1014

2025

» Click on Hide Chart, to hide the chart.

< B TPG Project Gantt

Active Projects

TPG PPP - Scheduler User Guide 2.16 EN
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O 2025-1019
[ 2025-1020

[] 20241016

Drop-down
Menu with
additional
Functions for the

Chart

Rows: 8

1 visualize this

Narr
PPP
Praje
Praoje
Praje
Praje
Praje
Praoje

Upg
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= New Project: Create a new Project. (4)

= Delete: Deletes the Projects. (5)
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/\ This action cannot be undone.

= Refresh: Page is being updated. (6)

= Visualize this view: Creation of a visual report in Power Bl about the current view. (7)

= Email a Link: Sends a link to selected data records by email. (8)

» Click the down arrow to send a link to the current view.

21 Email a Link | 2 Flow @0 Excel Templates

21 Of Current View

= Flow: Runs a Flow for the selected project. (9)
» Click the down arrow to manage Flows.

%2 Flow 8H Excel Templates

Manage

2 Create a flow

2 See your flows

= Excel Templates: Creation of Excel documents or templates. (10)

» Click the down arrow to create Excel templates.

@H Excel Templates B9 ExporttoE

Create Excel Template

T Upload Template

4 Download Template

Personal Excel Templates

B View All My Templates :‘

TPG PPP - Scheduler User Guide 2.16 EN
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= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot table.

(11)

= |mport from Excel: Import data from Excel spreadsheet. (12)

P Standard chart views are displayed automatically when enabled. Most tables already contain
basic charts, and additional charts can be added individually. Please contact your administrator
or TPG Support for assistance with this.

View with selected project

Once one or more projects have been selected or marked, additional commands appear in the

Command Bar:
= Fdit: Edit Project.
= Activate: Activate Project.
= Deactivate: Deactivate Project.
= Assign: Changes the owner of the selected Project.
= Share: Shares the Project with selected individuals or teams without changing ownership.

= Word Templates: Creates Word documents and templates.

B8 TPG Project Gantt  F5] Show Chart |;f edit [9 activate [ Deactivate | @ Delete = [ Email 3 Link 2 Flow ~ |8 word Templates ~ | @ Export to Excel

Active Projects T3 Ec

@ ProjectiD v Name 1~ % Complete ~  Start Date ~ Finish Date ~ Current State Overall KPI -
O 20241017 PPP Implementation 4 07092023 25.01.2024 Project Created @ Green
[ 2023-1001 Project A 25 10.02.2024 25.03.2024 Project Created @ Green
( 2024-1011 Project €2 37 00.00.2024 02122024 Active © Green
2024-1013 Project X 18 23.02.2024 21.05.2026 Project Created @ Green
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2.5 Navigation Bar

The navigation bar is on the left-hand side of the user interface. The navigation bar offers the following

navigation options:

Drop-down menu with the most recently viewed pages (1)
Drop-down menu with the bookmarked pages (2)
Start:
= My work: direct access to your current actions, projects, etc. (3)

Links to the lists with existing data records (4)
Reports:

= Dashboard: graphical overview of all projects, portfolios and programs (5)
Link to drivers for project applications and projects (6)
Project priorities: Graphical overview of drivers and project priorities (7)
Listing of financial data (8)

Switch to Settings and Aboutl 191 (9)

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 18 /271



(& Home

EEE——
Frow ]2

Start

% my Work 3

Requests

% Project Reguests

Projects
& Portfolios
# Programs
=l Projects

EX  Actions

People
# Resource Plans
Ak Resources

A contacts

Timesheets

(O Timesheets

{2 Approvals

Reports

Foe 5

Portfolic Strategy

6
¥ Priority Dashboard 7
8

S Enterprise

2.6 Product Information

In the About section, you will find important information about PPP:
= Version number (1)
= Links to user manuals, release notes, and licenses (admin only) (2)
® |ntegrated components (admin only) (3)

To access the product information, follow these steps:

<>

4

>

THE PROJECT GROUP

» Click on Enterprise in the bottom navigation bar. » A dropdown menu will appear.

TPG PPP - Scheduler User Guide 2.16 EN
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» Click on About.

Change area
v/ Enterprise

Settings

. AN
ﬂ Enterprise v

About

& Pinned ~ TPG ProjectPawerPack v2.11.0

2 Quick Links

Relewte Meter Liaring a

Coemponents

3

Vou need to be an sdministrator to losd solution versions.

Opening User Guides and Release Notes:
» Click on Online Documentation to access the User Guides.
Or

» Click on Release Notes to access the Release Notes.

» The TPG Help Portal will open.

TPG PPP - Scheduler User Guide 2.16 EN
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TPG Help Portal

TPG Help Documentation for TPG ProjectPowerPack (PPP)

Welcome to the TPG Help Portal for TPG ProjectPowerPack (PPP). Here you can find documentation, guides, and release notes.

TPG ProjectPowerPack (PPP)

TPG Scheduler v

Release Notes (English) v

» Click on TPG Scheduler. » A dropdown menu will appear.

TPG ProjectPowerPack (PPP)

TPG Scheduler N

TPG Scheduler 2.11.0 (Deutsch)

TPG Scheduler 2.11.0 (English)

TPG Scheduler 2.10.0 (Deutsch)

TPG Scheduler 2.10.0 (English)

TPG Scheduler 2.9.0 (Deutsch)

TPG Scheduler 2.9.0 (English)

TPG Scheduler 2.8.1 (German)

TPG Scheduler 2.8.1 (English)

Release Notes (English) v

» Click on the User Guide that corresponds to the version number of your installed product. » The

User Guide will open.

P To open the Release Notes, follow the steps described above.
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3 Project

This section describes how to create a new project with TPG PPP.
= Create new Project@

= Project Overview| 2

3.1 Create new Project
To create a new project in TPG PPP, follow these steps:

» Click on Projects in the navigation bar. P> A list with all active projectsl?ﬂ opens.

Projects
Ed  Portfolios

E@ Programs

. Il Projects

Actions

» Click New Project in the command bar. P The Project Details tab opens.

TPG Scheduler

L3 B Read Only Grid [ Show Chart = New Project B Delete

Active Projects -

g @ @ O d b

[ ] ProjectID Mame T % Cor
2024-1017 * PPP Implementation

[] 2023-10m + Project A
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» Fill in the project master data. (see Project Details@)

» Click Save in the command bar.

=7 ._.: ﬁ“ Savve & Close & Apply Template

Mew Project - Unsaves
Project Deta...  Schedule Board Resource Plan  Fimancials

Ganeral

P A new project is created.

3.2 Project Overview
In TPG PPP you will find a list of projects under Projects. All active projects are listed by default.
The views are divided into two areas:

= Table: Columns for selecting individual data records, links for opening the data records and other

columns that you can select via Edit columns (2).

= Graphical: Graphical project overview with various Features (5).

€ BradoyGid ESovCun f Newhoed @ Odete v Ofsteh  d Vaalietiier CEmilalink | v B Fow v @ EoTanote v W Bpotibe | v P g4 [ & s - |
Y
@ fecent ~ Active Projects 1
% Poed v T
TR 5 [i= rewe

Start

= e [0 rFojectic Hame * % Complets StwtDate  FinishDats  CumentState OversiKPl  Owner Croated On — . — — -

®  Custboard 20241017 - FPP Implementation 4% OTPINEI  2SOM2028 Frojec Creaed @ Green

Requeits. + ProjectA 2% 0022004 25032024 Progect Crested @ Green

A Project Requests ¥ 09092004 o2122024 hotve © Grean

Projects Ry S— oW 21304 MO Pegect Crented @Grean

B2 FPortiolios 0O | zeamne o Progelt B2 Ik Qa0 18062028 hemn & Grewn

W Programs

Pregeket ¥ % 06022005 08122027 O Grenn

Ir Prcjsces

B Acins Pregekt XY2 0% 20022005 Project Craated @) Grewn ]

3500 0% 0GISE4 OV Projest Cronted @ Grean FPP Propect My 25032024
I
B fusourcatios | Gravhicalloroi .
A Link to open the data records raphical project overview
A Contacts . . - .
Column for marking individual data records

Timaesheats

D Timashests

@ Appreals
[ = =
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There are options to customize the view:

= Selection menu of displayed projects (1): Active projects are displayed by default. Further display

options are available for selection:
= Click on the arrow. P> A drop-down menu opens.
= Click on the desired display option.

Active Projects -

O Search views

~ Active Projects Default
All Projects
Inactive Projects
My Active Projecis
Overview
Portfolio Summary
Project Priority
Status
Template Lookup View

B Manage and share views

= Edit columns (2): Add columns and change the order of the columns using drag & drop.
= Click on Edit columns. (2) » A form opens.
= Click on Add columns and select the columns you want to add.

Edit columns: Projects X

- Add columns

Project ID

]

H

MName

B

% Complete

&

Start Date

&

Finish Date

Current State

Overall KPI

© O O

Owner

&

Created On
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= Click on the column you want to move and drag the column to the desired position while

holding down the mouse button.

= Click on the 3 dots in the column and select Remove from the drop-down menu to delete a

column.
MName
Remowve
=] 9 Complete O
T~ Move up
59 Start Date
J, Move down

E il Thi_a_

= Click Reset to default to restore the default settings.
= Click on Apply to apply the changes to the view.

= Edit filters (3): Filter options for displayed projects.
» Click on Add. » A drop-down menu opens.

> In the drop-down menu, select whether you want to add a row, a group or an associated

entity.

Edit filters: Projects

| "4 Reset to Ge.‘ault"q Delete all filters |

Field Operator Value
::l ‘ Status Equals | Active X v
- :—] ‘Tcm;:l.}te o | Does nat equal . | Yes X

— :l ‘ Is Variant ’ | Does not equal v | fes
1 4+ Add -

(B Add row

= Add group

AR Add related entity

> Set the attributes according to which the projects are to be filtered.
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» Click on the three dots next to the filter and click on Delete to delete a filter.

Field Qperator Value

Status Equals Active ¥ - E
Template Does mot equa : Yes L E Delete |

Is Variant Dioes not equa Yes b

» Click on Delete all filters to delete all filters.

» Click Reset to default to restore the default settings.

» Click on Apply. P Only the projects to which the desired filters apply are displayed in the table.
= Filter by keyword (4):

» Click on the Filter by keyword field.

» Enter the keyword you want to filter by.

» Click on the cross in the Filter by keyword field to delete the filter.

P The projects whose names contain the keyword are displayed.
= Features (5): Elements in graphical overview.

» Click on the arrow. P> A drop-down menu opens.

» Click on the elements to be displayed in the graphical overview.

I
93 v

ik

A,

= Featurez D
Show project names

Draw today indicator

Show more lines
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4 Project Details

The Project Details tab provides you with the most important information about a project.

= = B Hiwe &Fsnehooe B apyTemptte [ Desctvate W Croste Tam W8 TeamsSettings O Retesh O Creckaccess 68 varues  BI Process A onssgn B flow
t o w
G Home
) Project Manager, Project State,
& Recwn b Workflow @ PP Project Munsger | Preject Crasted  Grawen 29
2 Pioned v 1 KPls, %Complete Pretbisage Posasite Otk % Compiee
- o) 5
Initiating (3 Moj) Flanning Executing Controlng Closing
£y wone
ProjectDeta.. Schedule 8oard  Resource Plan  Financials  Status Update  Staws Report  Risks lssues Changes Actions Decisions Stakeholders Objectives Benefits  Requirements  Lessons Leamed -
# Dashbosd
Requests Genaral Praject KPls Project Estimates.
AT Dl Nepisss Project 1d & 20081018 Cverall KPI % Complete &
® Green 2
P .
D=t Hame ' projectx
B Portfolos Cemt R Start Bate *
Deser - 2,200
W Programs ® Groen 23122004
I projects - Finigh Dube &
= 21042005
Eb Actions ® Green
Total Budget B
Propect Mansger v PP Prosest Macaotr [DMinel % Resource K91
e et Manag @ 22 Proisct Manager (Offine) s
® Green
B Rescorce Pans Partfolo
B Rescurces Sehacide K
Program
A Contacts ® Groen
Department Work KPi
Timsesheets
Project State Project Crasted ® Gieen
@ Timesheets
@ Appeovsls Project Ruquest
Template 000€
Entarpriss Project Type petaudt Prosect Tyoe: % 0 Last updated:
15 Datauie Prosect Tyoe 26032005 1347

[ [

The information is grouped into 4 areas:
= Generall
= Project KPIs[ 2]
= Project Estimates| ar]

= Template@

4.1 General

This section displays general information about the project:

P To make edits on the other tabs, the mandatory fields must be completed. All mandatory
fields are marked with a red star.

= Project Id: |s assigned automatically.

= Name: Name of the project.
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» Click in the field and enter the name of the project.
= Description: Short description of the project.

= Project Manager: By default, the person who created the project is entered as the project

manager. You can change the project manager:

» Click on the search icon (magnifying glass) in the Project Manager input field. » A drop-down

menu opens.

> Select the project manager from the drop-down menu.

Project Deta.. Schedule Board Resource Plan  Financisls  Status Update  Status Report  Rigks  kBfues Changes A

Rigasltd from s Becent setpegh
il .
Press - .
E Ll - ..
LTt .
k
el s
@ P Lo D

= Portfolio: Assign project to a portfolio.

P Follow the steps described above for the Project Manager.

= Program: Assign project to a program.

P Follow the steps described above for the Project Manager.

= Department: Assign project to a department.

P Follow the steps described above for the Project Manager.
= Project State: Set project state.
» Click on the arrow in the Project State input field. » A drop-down menu opens.

> Select the project state from the drop-down menu.

Pragict Crasted D

%

Select--

Progect Bequest
+" Project Created

Ermterpre Propeat Type .
Aatree

Calendar Gn Hold
Cancelled

Seaud Mansgers -
Completed

Archived
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Project Request: Assign project to a project request.

P Follow the steps described above for the Project Manager.

Enterprise Project Type: “Default Project Type” is selected by default. You can change the
Enterprise Project Type.

P Follow the steps described above for the Project Manager.

Calendar: The “Default” calendar is selected by default. You can change the calendar.

P Follow the steps described above for the Project Manager.

Status Managers: Team that can approve and reject time recording requests for the project. This
field is automatically filled in by PPP as soon as a time confirmation is made in the project for the

first time.

Scheduling Engine: In the Scheduling Engine field, select the scheduling logic for the project. This

determines how dates are calculated and how changes affect the project plan.

Calendar C --Select--

~ TPG Scheduler

Status Managers ]
Microsoft Project Desktop

Scheduling Engine | TPG Scheduler -

4.2 Project KPIs

This section groups the key performance indicators (KPIs) of your project into various categories. These

categories help you to quickly understand the progress and performance of your project at a glance.:

The KPIs are divided into the following main categories:

Overall KPI: This KPI provides an overview of the overall progress and status of the project.
Cost KPI: This KPl monitors the actual costs compared to the planned budget.
Issue KPI: This KPI shows problems and risks in the project.

Resource KPI: This KPI shows the utilization and availability of project resources, such as

personnel, materials and equipment.

Schedule KPI: This KPl monitors progress against the schedule.
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= Work KPI: This KPI shows the productivity and efficiency of the project work (does work
performance meet expectations).

Project KPls
Qverall KPI
® Green

Cost KPI

® Gieen

Issue KPI

® Green

Resource KPI

® Green

Schedule KPI

® Green

Work KPI

® Green

The status of each KPI is visualized by a traffic light indicator:
= Green: There are no problems.
= Yellow: There are minor deviations or risks that should be monitored.

= Red: There are significant problems or delays that require immediate attention.

P This traffic light indicator enables you to quickly recognize the current status of the project
and take action if necessary.

You can change the status of the KPlIs in this area:
> Select the KPI whose status you want to change.
» Click on the KPI. > A drop-down menu opens.
» Click on the color that visualizes the desired status.

P The status of the KPI is changed.

Project KPIs

Overall KPI

® Green

--Select--
® Red
Yellow

® Green

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 30/271



>

THE PROJECT GROUP

4.3 Project Estimates

In this section you will find an overview of the project budget and schedule:

» %Completed: Progress of the entire project in percent.

P This field is updated automatically. The progress is calculated on the Schedule tab. (see
Progress Indicatorm)

> Start Date: Start date of a project

» Click on the calendar icon and select the start date in the calendar.

Start Date *

06.02.2025

Februar 2025

S0 Mo Di Mi Do Fr Sa
26 27 28 29 30 3 1
2 3 4 5 & T 8
9 10 11 12 13 14 15
% 17 18 19 20 21 22

23 24 25 26 27 28 1

» Finish Date: Estimated end date of the entire project. End of the last task in the project plan.

P This field is updated automatically. The end date is calculated on the Schedule tab. (see
Define Duration of Taskm)

= Total Budget: Total financial framework available for the project.
= Total Forecast: Current estimate of the total cost of the project.

= Total Actual: Actual costs incurred up to a certain pointin time.

P Budgets are entered on the Finances tab.

Recalculate Total Budget, Total Forecast and Total Actual:

» Click on the calculator icon (1). The Recalculate button appears.
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» Click on Recalculate. (2)

P The value is recalculated.

Project Estimates

% Complete & 3

Start Date * 06.02.2025 [E5]
Finish Date & gg122027

Totsl Budget 1 15.000,00 €

Last updated: 27.03.2025 DE:4T

Total Forecast B 1550000€

Last updated: 27.03.2025 0647

Total Actusl B qp50000 €

Last updated: 27.03.2025 0647

Last Timesheet Rollup 5]

= [ast Timesheet Rollup: Last summary of the time confirmations of all project members. This field

is updated automatically.

P Data records can be found under Timesheets. (see Navigation Barm)

4.4 Template

In the Template area, you can save the current project as a template to use it as a template for other

projects.

P The slider is set to No by default.
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» Click on the Template slider. » The slider jumps to Yes.
> Click on Save in the command bar| 1.

P The project is saved as a template.

Template

Template

@ -

5 Task planning in the Schedule

In this chapter, you will learn how to plan and manage processes in the TPG Scheduler. We will guide

you through the process step by step:
= Scheduler| a1
= Create Taskl a1
= Move Task[ 4]
» Undo and Redo Actions| 1
= Define Duration of Taskl ]
= Convert Task to Milestonel )
= Define dependencies between Tasks| 491
= Assign Task Attributes| s ]
= Create and edit Inter-Project Linksl 751

= Ressource Planning| s
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5.1 Schedule - Views

Task planning and resource allocation take place on the Schedule tab. TPG Scheduler provides a tabular

(left) and graphical (right) overview of the project:

Sched...
+ Add + B8 @ & 4 4 b = Features = Baseline + Export/impon O S B
) 024 Derembe 2025 Januar 2025 Februsr 2025 Mz 2025 April
LAY Nama % Complete  Start Finish Duration Predecessors Assigned Re - o5 " W O o2 o I 25 ;@ 0 % Zﬂ ® n
+  Progect Start @ 232024 23204 0 days
2 v Phage 1: Initiation @ 23122024 30.01.2025 29day: 1 pr———
3 2 + Create Project Request @ 232024 2322024 1ay I
42 + Review Project Request @ 06012025 17012025 Wdays 3 ]
5 & - entfy Risks @ 0002025 30012005 Sdays 4 : [ ]
L = Initation Completed @ 30012025 300.2025 Odays 5 ‘
7 “ Phase 2: Planning @ 32005 27022025 M days & r—
8 « Prafiminary Planning @ 012025 06.02.2025 5 days [
s « Dewailed Fianning O 07022025 20022025 Wdays 8 [
0 + Finandng ) NO2 27022005 Sdms 9 [ ]
+ Planning Completed .'!\ 27022025 27022025 Odays 7
P - Phase 3: Fescution ; ROPADS 140805 e 11 4

P You can customize your display settings. These settings will be saved.

Tabular view and functions:
= Buttons for adding, editing, hiding and displaying tasks (1)
= Listing, properties and editing of tasks (2)

= Restoration of the standard display and immediate recalculation of the project (3)

Sched

+ add Z tan [i] Delete - ] G & & 14 bl ot 2 = Festures = Baseline — Expory/impen OV R

i 024 Dezernbe 2025 lanuar 2025 Februar 2025 Mirz E Resot view settings
LI Name % Complete  Start Finish Duration  Predecessors Assigried Ry N
15 ! 05 1”2 19 2% 0 09 % 23 02 09 1w/ X I ~
i Recakulate project

1 *  Project Start @ 23122024 2322024 0days
2 ~ Phase T Initiation @ 2312.2024 30.01.2025 Z9days 1 ’
3 & + Create Project Request 32202 232200 1day p |
s 2 + Review Project Raquest sEouzs TS Wi 3 |
s & - igentity Risks 0012025 30012025 sdus 4 [ ]
5 - - Iniiation Completed 0012025 30012025 odms S *

 Phase 2: Planning @ 31012026 27.002028 Wdus 6 r
8 + Pretminary Plaaring @ noiz02s 0602205 S days ]
3 . Detated Planning O 07022025 20022025 0dns 8 [
0 + Financing £)  aoaxzs  zoazs Sdis 9 [ |
" + Planning Completed =Y moexes  ameraas odms 7

F
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Graphical View as Gantt Chart and Functions:
= Gantt Chart with summary tasks, subtasks, milestones, etc.
= Display options for Gantt Chart (4)
= Reload the schedule (5)
= Switch views (6)
» Click on the right arrow P table view only

» Click on the left arrow P> chart view only

P The divider can be moved left or right by holding down the left mouse button.

4]

Features *~ =; Baseline |=—> Export/Import 5 Al s I
024 Dezembe 2025 Januar 2025 Februar 2025 Marz 2025 April

:decessors  Assigned Re
05 12 19 26 02 09 16 23 02 09 16 23000 06 13

Summary Task
F |

|

Subtask
6
[
<O Milestone
¢

—
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5.1.1 Schedule - Buttons

Above the tabular and graphical view of the tasks is a command line with buttons that you can use to

customize the view.

1 2 3 4 5 67 8 9 101 12 13 14 15

= Add (1): Add a new task.

= Edit (2): Edit task.

= Delete (3): Delete task.

= Undo last action and Redo last undone action. (4) (see Undo and Redo Actionsm)
= Qutdent task or Indent task (5): Move task to another level.

= Show all subtasks (6): All subtasks are displayed in the tabular and graphical view.

= Hide all subtasks (7): All subtasks are hidden. Only the summary tasks and milestones are

displayed in the tabular and graphical view.
= Zoom out and Zoom in (8): Zoom in or zoom out view in Gantt Chart
= Zoom to fit full Gantt (9): The entire project is displayed in the Gantt chart.
= Scroll left and Scroll right (10): Jump in the Gantt chart to the start or end of the project.
= Scroll to selected task (11): Selected task line is displayed.

= Features (12): Drop-down menu with features.

= Click on the arrow. P> A drop-down menu opens.
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= Click on the elements to be displayed in the Schedule tab.

= Features =: Baseline

sy

| Draw dependencies
D Show task labels
D Show critical path
Draw start and end
Draw today indicator
Highlight non-working time
D Show more lines
D Show resource utilization
Show inter-project links
D Show timeline
D Show full resource names

Timeline size >

= Baseline (13): Display baseline or save the current status as a baseline.

= Click on the arrow. P> A drop-down menu opens.

= Baseline i— Export/lmport
D Show baseline
€

Set baseline

= Click on Show baseline. P The baseline is displayed in the Gantt chart.
Or
= Click on Baseline. » The current status is saved as a baseline.

= Export/Import (14): Export project, print as PDF or import from another project.
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= Click on the arrow. P> A drop-down menu opens.

— Export{lmport

' g2 Export to Project (XML)
B3 Export to Excel

Print PDF

1 )
& Import Project (MPP)

= Select the desired action.

= Refresh, full screen mode or reset view settings and immediate recalculation of the project. (15)

5.1.2 Scheduler - Table

The tasks are listed in tabular form in the view on the left-hand side. The following applies:

= Row = a task

= Column = attributes of the task (e.g. Name, Start, Finish, Duration, %Complete, etc.)

The columns can be moved using drag & drop.

P A list of available columns can be found under Task Attributes|_5eh|.

Columns can be shown and hidden. There are 3 methods for showing columns:
Display multiple columns:
» Right-click on New Column. (1) » The drop-down menu with Filters and Columns opens.

» Click on Columns. (2) P> A list of all columns opens. All displayed columns are marked with a

check.

» Click on the columns to be displayed. (3)
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P Columns are displayed in the table.

B Predecessors

— Export/Import
B Assigned Resources

1 ¢
Y Filter >
Effort
@ Columns 2 >
Actual Hours y

displayed Columns =~

Or
Selection via drop-down menu:
» Click on New Column. (1) » The drop-down menu with attributes opens.
» Click on the desired column (e.g. Milestone). (2)
P Milestone column appears in the table.
1 25 So 23 Mar
Link
Locked

Manually scheduled

Milestone 2

Name
Note
Planned % Done

Predecessors

Or

Enter in text field:
» Click on New Column. P> The drop-down menu with attributes opens.

> Enter "Milestone" in the New Column field.
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P Milestone column appears in the table.

25 S0 23 M3

S SMDM

Milestone

P It may happen that not all columns are available for selection when you try to show columns.
This depends on the configuration of the TPG Scheduler. If you cannot find the desired column,
try another method to show columns.

Hide columns:
» Right-click on the column to be hidden. P The drop-down menu opens.
» Click on Hide column.

P The column is hidden.

Predecessars Assianed Resc
W Filter >
M Columns >

© Hide column

iy

T Sort ascending
3 Sort descending

4 % Multisort >

P Columns that you hide may no longer be displayed in the drop-down menu if you want to

show them again. Reload the project. The column will then be displayed in the drop-down
menu again.
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5.1.3 Schedule - Gantt Chart
In the view on the right-hand side, the processes are displayed graphically in the form of a Gantt chart.

By default, the Project start date, Today's date and the Project end date are marked on the timeline in
the Gantt chart.

Dezember 2025 Januar 2025 Februar 2025 Marz 2025 April 2

05 12 19 26 02 09 16 23 02 09 16 23 Fuﬁ 13

P The project tasks are placed one below the other on the timeline. (see Scheduler - Viewsm)

The tasks are visualized with various symbols:

Summary Task —

Subtask

Milestone

The dependencies between the tasks are visualized with arrows in the Gantt chart. (see Define

dependencies between Tasks)m

Move the mouse pointer over an operation to obtain information about it:

l Detailed Planning

Start: 7. Feb. 2025
End: 20. Feb. 2025
Duration: 10 days
Complete: 89%

‘ -
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5.1.4 Board Tab

A Kanban board is integrated on the Board tab to display the tasks of a project. This Kanban board

offers the option of dividing tasks into groups - the buckets - and organizing them.

By default, all tasks are in the bucket Backlog. You can add further buckets and move tasks into

buckets.
Board
ket
Backlog <
Subtask 1
Miestone 1
Subtask 5
ibtask (<]
Task 2
| Subtask 3 (]

Create Bucket:
» Go to the Board tab.
> Click on Bucket.

-+ Bucket

» Enter the name of the bucket. (e.g. in Progress)

» Click on Add.
Add bucket
Name
‘ in Progress
Add Cancel
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P A new bucket is created.

Move task to another bucket:
> Select the task you want to move to another bucket.
» Move the task using drag & drop.

Or
» Right-click on the task. » A drop-down menu opens.
» Click Change column.
» Click on the desired bucket (e.g. in Progress).

P The task is moved to the desired bucket.

>

# Edititem

Resources

THE PROJECT GROUP

in Progress

B Backlog

Backlog 8)
Subtask 1
Start: 07.02.2025 03:00
Milestone 1
Start: 06.03.2025 08:00

Further functions and editing options:

You will find further functions in the drop-down menu.

¥ Remove item

B inFrogress

B Done

A Warning: All functions affect the schedule. Deleting a task not only removes it from the

bucket, but also from the schedule.

= Edit item: Edit task.
= Resources: Assign a resource to the task.

= Remove item: Delete task.

You can customize the view in the Kanban board for greater clarity. You can find a detailed explanation

in the section Actions - current Project|1_es'1
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Show bucket in the schedule:

You can show the Bucket column in the Schedule (see Task Attributesm). The bucket to which the task
is assigned is displayed there. You can select a different bucket and assign the task to a different
bucket.

Mame % Complete  Start Finishi Duration  Predecessors Assigned Reso...  Key Milestone Effort Actual Hours  Bucket
~w Task1 ‘.') 06.02.2025 15022025 10 days 236 hours
* Sublask1 07022025 W02 2025 2 days 16 hours m X &
» Sublask 2 O .02 2025 17.02 2025 Sdays 2 20 hours
« Sulbtask 3 \D 1.02.2025 19022025 7dKs 355 56 hours in Progress

5.2 Create Task

The tasks for the project are created in the Schedule.

The following describes how to create new tasks, tasks on the same level, tasks above and below,

subtasks and milestones.
Create new task:
» Click on the Add button. (1) » A new task is created.

> Enter the task name (2) and confirm with the Enter button.

+ Add | & Edit [i] Delete ©) o A
1

# 1 Name 2 %% Complete Start

1 « || Task 1 0 06.02.2025

Insert task on the same level:
Repeat the process described above to create a task on the same level.
» Click on the Add button. P> A new task is created.

» Enter the task name and confirm with the Enter key.
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Add further tasks and milestones:

Further tasks and milestones are added via the drop-down menu:

» Right-click on a task. P The drop-down menu opens.

» Click on Add. You can create further tasks and milestones:

» Click on Task above. (1) > Task on the same level is inserted.

» Click on Task below. (2) P Task on the same level is inserted.

» Click on Milestone. (3) P Milestone is inserted at the same level.

» Click on Subtask. (4) P Task at next lower level is inserted.

>

THE PROJECT GROUP

» Click on Successor. (5) P> Task that follows the current task is inserted.

» Click on Predecessor. (6) P Task that precedes the current task is inserted.

# Edit
MName
i Copy
+ Task1 % cut

t Finish

12.2025 07.02.2025

Inter-Project Links >
W Filter >
+ Add.. > 4 Task above 1

& Convert to milestone

W Delete

@ Color
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& Milestone 3
& Subtask 4
= Successor 5

= Predecessor §
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5.3 Move Task

P The order of the tasks can be changed using drag & drop.

Move task to another level:
You can use the Outdent task up and Indent task down buttons to move tasks to other levels.
» Click on the task that you want to move to another level.

» Click on Outdent task. (1) P Task is moved to a higher level.

» Click on Indent task. (2) » Task is moved down one level.

& Edit ] Delete “
1 2

Name % Comple
v Task 1 0
* Subtask 1 0
* Subtask 2 0

5.4 Undo and Redo Actions

Last actions can be undone and redone using the buttons with the curved arrows.
Undo action:

» Click on the left-curved arrow. (1) P The last action is undone.
Redo action:

» Click on the right-curved arrow. (2) > The last undone action is redone.

+ Add ¢ Edit [i] Delete ) ° ¢ °
1 2
# 1 Name
1 “ Task1
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5.5 Define Duration of Task
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You can define the duration of a process in the Duration column. The duration is specified in days. By

default, the duration of a newly created task is 1 day.

# 1 MName

1 v Task1

2 @ *  Subtask 1
3 2 « Subtask 2
4 a2 Subtaszk 3
5 * Subtask 4
6 * Subtask 5
T * Subtask 6
5 @ + Milestone 1

> Select the task for which you want to set the duration.

Duration

15 days

2 days

2 days

2 days

2 days

2 days

15 days

0 days

% C

> Double-click the cell in the Duration column. P> You can now enter text in the cell.

» Enter the estimated duration in days.

P The duration of a summary task is calculated automatically as soon as the dependency is
defined (see Define dependencies between Tasksm).

P The end date of the task in the Finish column is calculated automatically.

By default, the duration is specified in the unit “days”. You can specify the duration of a task in a

different unit. The following units are supported:

day
week

year
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Change unit for duration:
> Select the task for which you want to change the unit of duration.
» Double-click on the cell in the Duration column. P> Text can now be entered in the cell.

» Enter the expected duration in weeks (w) or years (y).

P You can enter the unit or the abbreviation.

5.6 Convert Task to Milestone

You can convert an task into a milestone.

There are 3 options for converting a task into a milestone.
1. In the Duration column, set the duration to 0.

2. Select Convert to milestone from the drop-down menu.

» Right-click on the task that you want to convert into a milestone. » The drop-down menu opens.

> Click on Convert to milestone. P The task is converted into a milestone.

Subtask 3 ¥ Filter >

+  Milestone 1 + Add.. »

v Tack 2 & Convert to milestone

3. Show the Milestone column (see Schedule - TabIe@) and activate the checkbox.

# 1 Name Duration Milestone

1 “ Task1 4 days

2 @ + Subtask 1 2 days

3 2 Subtask 2 2 days

4 2t Subtask 3 2 days

5 @ + Milestone 1 0 days |
———n
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5.7 Define dependencies between Tasks

You can create dependencies between tasks. The dependencies can be created either in the table or in

the Gantt chart. There are 4 different dependency relationships:

FS (Finish-to-Start) The task starts when the
predecessor is finished (normal
sequence).

SS (Start-to-Start) The task starts only when the
predecessor also starts (start
sequence).

FF (Finish-to-Finish) The task ends when the

predecessor is finished (end -
sequence).

SF (Start-to-Finish) The task ends only when the
predecessor starts (jump
sequence).
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5.7.1 Define dependencies between Tasks - Table
In the table view, there are various options for defining dependencies between tasks.
FS relationship:

> Select the task to which you want to assign a predecessor (e.g. Subtask 2).

» Double-click in the cell in the Predecessor column. (1)

» Click on the down arrow. » The drop-down menu opens.

> In the drop-down menu, click on the task that you want to define as the predecessor (e.g. Subtask
1). (2)

» Click outside the menu to exit.
» The two tasks are linked with a finish-to-start relationship.

P Subtask 2 only starts when subtask 1 has been completed.

Jai EUET

# 1 Mame % Complete  Start Finish Predecessors Duration  Ass
19 Jan

1 w Task 1 3;) 06.02.2025 26.02.2025 15 days
2 @ + Subtask 1 07.02.2025 10.02.2025 1 2 days
3 a * Subtask 2 11.02.2025 12.02.2025 a & 2 days
4 + Subtask 3 \'D 11.02.2025 12.02.2025 Y

Subtask 5 (6)
] * Subtask 4 ED 11.02.2025 12.02.2025

Subtask 6 (7) 2
& * Subtask 5 40 07.02.2025 1.02.2025

- Subtask 1 (2) e a

7 = Subtask 6 W 06.02.2025 26.02.2025

Subtask 4 (5)

Or

» Enter the number of the task to be assigned as the predecessor in the Predecessor column.

# Marmse % Complete  Start Findsh Predecessors
w Task 1 !"-\,I 06022025 26022025
E & = Subiask @I e e kL) 002 2025
3 2 = Sidagk 2 @ Mo2202s 12022025 E
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Define SS, FF and SF relationship:

To define the other dependencies, proceed as follows:
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> Select the task to which you want to assign a dependency to another task.

» Double-click in the Predecessor column.

» Enter the number of the operation that you want to relate to the current task and enter the

dependency SS, FF or SF.

P The two tasks are linked to the desired dependency.

2 Feb 2025 So 09 Feb 202!

# 1 Name Start Finish Predecessors
MDMDF
1 v Task 1 06022025  26.02.2025 AR
2 @ « Subtask 1 07022025  10.02.2025
3|a Subtask 2 11.02.2025 12.02.2025 2
4|2 Subtask 3 11.02.2025 12.02.2025 355
5 « Subtask 4 11.02.2025 12.02.2025 AFF
6 + Subtask 5 07022025  11.02.2025 5SF
P Alternatively, you can show the Successor column and define the subsequent task as
described above.
5.7.2 Define dependencies between Tasks - Gantt Chart
You can define dependencies between tasks in the Gantt chart view.
» Hold down the mouse button and connect the ends of the task bars.
P The two tasks are linked with the desired dependency.
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Example 1: FS relationship

l From Subtask 1

PlleA <

l To  Subtask 2

——

Example 2: SF relationship

From Subtask 4

To  Subtask 5

4 PlEA <

T

TPG PPP - Scheduler User Guide 2.16 EN

© The Project Group GmbH | All rights reserved 52 /271



>

THE PROJECT GROUP

5.7.3 Define dependencies between Tasks - Information Window

In the Task information window, you can change the dependency types and insert a lag between two

tasks.
There are 2 ways to open the Task information window.
» In the table, click on the task you want to edit.
» Click on Edit. > The Task information window opens.
Or:
» Double-click on the task bar in the Gantt chart. > The Task information window opens.
» Click on the Predecessor or Successor tab - depending on the relationship you want to edit.
» Click on the Type field. (1) » The drop-down menu opens.
» Click on the desired dependency. (2)
» Click on the Lag field. (3)
> Enter the number of days.
> Click on Save. (4)

P The dependency between two tasks is changed and a lag is inserted.

Information X

GEMERAL PREDECESS0ORS SUCCESSORS RESOURCES ADVANCED )

Name Type 1 Lag Active
Subtask 1(2) inish-to-Startils v
Start-to-Start

Start-to-Finish

Finish-to-5tart 2

Finish-to-Finish

4 “ Delete Cancel
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Dependencies between tasks can also be changed via the Edit dependency window.

» Double-click on the dependency arrow in the Gantt chart. » The Edit dependency window opens.

» Click on the Type field. (1) » The drop-down menu opens.

» Click on the desired dependency.

» Click on the Lag field. (2)
» Enter the number of days.

» Click on Save. (3)

P The dependency between two tasks is changed and a lag is inserted.

Edit dependency

From

Subtask 1

To

Subtask 2

Type

End to Start

Lag
Odays |2

ik

Active

Save

Delete ‘ ‘

Cancel
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5.7.4 Deactivate dependencies between Tasks
To deactivate a dependency between two tasks without deleting the dependency, proceed as follows:

» Open the information window of one of the two tasks. (see Define dependencies between

operations - Information Window@)
» Click on the Predecessor or Successor tab - depending on the relationship you want to edit.
Or
» Double-click on the dependency arrow in the Gantt chart. P The Edit dependency field opens.
» Click on the Active checkbox. (1) P The checkbox is deactivated.

> Click on Save. (2)

Information x

GEMERAL PREDECESSORS SUCCESSORS RESOURCES ADVANCED o

Hame Type Lag Acthve
Subtask 1(2) Finich-to-5tart 0 days E
+ W

2 E petete -

Edit dependency X
From
Subtask 1
To
Subtask 2
Type
End to Start v
Lag
0 days -
1
Active |:|
2
Save ‘ ‘ Delete ‘ ‘ Cancel

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 55 /271



>

THE PROJECT GROUP

5.8 Task Attributes

You can use the column options to assign attributes to each task. Various options are available.

The following columns are displayed by default after project creation:

L MName % Complete  Start Finish Duration Predecessers  Assigned Resources Key Milestone Effort Actual Hours  Actions

# (number of the task line): Unique number assigned to each task in the project plan.

L
i : Information on the task in the form of symbols, e.g. Assigned Resources ™ or Key Milestone

Customer "&"
Name: Name of the task.

%Complete: Progress of the task. Percentage of how much of the task has already been

completed -> (see Progress Indicatorm)
Start: Start date of the task.
Finish: End date of the task.

Duration: Total time required to complete the process. Specified in days. (see Define Duration of

Taskm)

Predecessor: Task that must precede the current task. The cell contains the number of the

predecessor task line.

Assigned Resources: Resources that are assigned to the task, e.g. people or departments. (see

Assign Resources in the Schedule@)

Key Milestone: Important event or goal in the project.

Effort: Estimated amount of work required for the task. Specified in hours.
Actual Hours: Actual hours worked to complete the task.

Actions: Actions that must be completed during the execution of the task. (see Actions)
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+ Add 27 Edit [ Delete 2 °='° % @

v i Name % Complete  Start
1 - Project Sue @ 23122024
H “ Phase 1. Initiation @ 23122024
3 a4 +  Create Project Request 23122024
Ry | + Review Project Request 06.01.2025
5 a2 + Idenify Risks 20.01.2025
6 * Initiation Completed @ 30012025
7 w Phase  Flanning O 31012025
] + Praiminary Planning @ 31012028
9 . Detaded Planning O 07022026
« Financing -) 21022025
n + Planning Completed aY 22z

Further columns or task attributes:

B 4

Finish

23922022

30.01.2025

27.02.202%

06.02.2025

20022025

27022025

27022025

Duration

0 days

23 days

0 days

20 days

5 days
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Features. = Baseline + Export/import

Predecessors  Assigned Resources Key Milestone Effort  Actual Hours  Actions

-

Ohours

160 hours

B hours

80 hours

72 hours

Customner 0 hours

245 hours 15

8 hours

85 hours

& hours

0 hours

Start Variance

Finish Variance

Bucket

Duration Variance
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Difference between the planned and the actual
start date of the task.

Positive variance = task starts later than planned

Negative variance = task starts earlier than

planned

Difference between the planned and the actual
end date of the task.

Positive variance = task ends later than planned

Negative variance = task ends earlier than

planned

Group in which tasks can be collected and
organized on the Board Tab. (see Board Tabm)

Difference between the planned and actual

duration of a task.

Positive variance = actual duration is longer than

planned duration
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Effort Unit

Constraint Type

Constraint Date

Color

Early Start
Early End
Baseline Duration

Baseline Start
Baseline Finish
Total Slack
Locked
Inactive

Calender

Link
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Negative variance = actual duration is shorter

than planned duration

Unit in which the effort for the task is specified
e.g. hour.

Assign a constraint to the task:

As soon as possible, As late as possible, Must start
on, Must finish on, Start no earlier than, Start no

later than, End no earlier than, End no later than

Assign the date (day) for the constraint type to
the task.

Color of the task bar
The earliest date on which a task is allowed to

start.

The earliest date on which a task is allowed to
finish.

Planned total time required to complete the task,
specified in days.

Scheduled time at which the task starts.
Scheduled time at which the task ends.
Total period provided as a buffer.

Task cannot be edited or moved.

Task is deactivated (see Deactivate Taskm)

Assign task to a calendar. (see Set Calender for a

Taskm)

Link between tasks or projects.

Hardlink = A hardlink is a fixed and direct
connection between two tasks or projects.
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Changes to a task or project are immediately
transferred to the linked tasks or projects.
Softlink = A soft link is a flexible connection that
refers to the path or position of another task or
project. If the original task or project is changed
or deleted, the soft link can become a broken
link.

Manually scheduled Plan the task manually. The start date, finish date
and duration are set by the project manager.

Milestone Event in the project e.g. completion of a project
phase.

Successor Task that follows the current task. The cell
contains the number of the operation line of the
successor.

Note Comments on the task (see Add Notem)

WBS Work Breakdown Structure, hierarchical

representation of all content levels of a project.

Scheduling Mode Mode for scheduling tasks within a project. There
are three scheduling modes: Fixed Duration, Fixed
Effort, Fixed Units. (see Define Scheduling
Mode@)

Scheduling Direction Method used to structure the scheduling of a
project: Forward or Backward

Priority Importance and urgency of a task: Urgent, High,
Medium, Low

Ignore Resource Calendar The calendar of the assigned resource is not
considered when scheduling a task.

Rollup Display subtasks and milestones in the Gantt
chart directly under the bar of the higher-level
summary task. (see Create RoIIupm)

Sequence The order in which tasks are performed.

Deadline Time (date) by which the task/milestone must be
completed.

Late Start Latest time (date) at which a task may start.
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Late End Latest time (date) at which a task may end.
Todos Jobs that need to be completed within the task.
Show in timeline The task is displayed in the timeline above the

table and the Gantt chart. Timeline must be
shown. (see Schedule - Buttons|_3s'1)

P The columns and task attributes listed are available to you in the TPG Scheduler. It is possible
to add further columns and modify the TPG Scheduler to meet your specific requirements.
Please contact your administrator or TPG Support for more information.

Assign task attributes:
» Show the desired column (see Schedule - Table|_ssh|)

> Fill in the cells as described in the following chapters.
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5.8.1 Change color of Task bar
To highlight tasks in the TPG Scheduler, you can select colors for the task bars.

Change the color of task bars:

» Right-click on the task in the table or the task bar in the Gantt chart. » The drop-down menu

opens.

» Click on Color. » The color palette opens.

Name % Complete Start Finish Duration
o Task 1 sh 06022025 26022025 15 days
«  Subitask 1 Fannk A7 02 2025 10.02 2025 2 days
#,E
»  Subtask 2 022025 12.02.2025 2 days
W% Copy
« SubmE 3 022025 12.02.2025 2 days
¥ Cut
. Subtask £ 022025 12.02.2025 2 days
« Subtask 5 rber~Eroject Links 5 022023 02,2025 2 days
- Subtask 6 ¥ Filter » 022025 26022025 15 days
«  Milestons 1 + Add- 2 10532025 DED3 2025 0 days
o Task2 & Convert to milestone 1032025 0812 2027 3 years
= Outdent
W Deiete

X XX
@ Color » .. .

o]

O

G
@ 00X

» Click on the desired color in the color palette.

P The color of the task is changed.

Or

» Open the information window of the task. (see Define dependencies between tasks - Information
Window@)

» Click on the Color field. (1) » The color palette opens.
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» Click on the desired color in the color palette. (2)

» Click on Save. (3)

Information X

GEMNERAL PREDECESSORS SUCCESSORS RESOURCES ADVAMCED ]

Name

Subtask 1 X

% complete Effort

100 £ 16 hours =
Start Finish

< 07.02.2025 il > < 10022025 i
Duration Color 1

2 days =] Ne coler -

2
e:-0000
000000

» The color of the task is changed.

P If you want to reset the color to the default setting, select No color in the color palette.

| Mo color '

P The color selected for a summary task is also applied to the subtasks.

P You can assign a different color to subtasks by defining a different color for individual tasks.
To do this, proceed as described above.
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5.8.2 Define Scheduling Mode

When scheduling a task in the TPG Scheduler, the work is calculated from 3 variables: Duration, Units
and Effort. This means:

Work = Duration * Units * Effort

In order to plan a task realistically, there are 3 planning modes that can be defined for a task in the TPG

Scheduler. One variable is defined for each planning mode:
= Fixed Duration = duration of the task remains constant.
= Fixed Units = number of assigned resources remains constant.
= Fixed Effort = number of working hours/days remains constant.
Define scheduling mode:
» Show the Scheduling Mode column. (see Schedule - Tablem)
» Click in the Scheduling Mode cell during the task. » The drop-down menu opens.
» Click on the desired scheduling mode Fixed Duration, Fixed Units or Fixed Effort.

P The desired scheduling mode is defined for the task.

P The default setting for the scheduling mode is Fixed Duration.

P As soon as a resource is assigned to a task, the TPG Scheduler calculates an effort of 8 hours
per day and resource.

P If you want to use the Fixed Effort scheduling mode for a task, you must first enter the
desired effort and only then assign the resource. If the resource is assigned beforehand, the
effort is automatically set to 8 hours.

If a scheduling mode (e.g. Fixed Duration) is selected, the other variable (e.g. Units) is recalculated

when one variable (e.g. Effort) is changed. The variables are related as follows:

Change of ... Number of Assigned Resources l Duration l Effort

Scheduling Mode leads to the recalculation of

Fixed Duration Effort Effort Units 1
Fixed Units Effort 2 Effort Duration
Fixed Effort Duration Units 3 Duration
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Example 1: Fixed Duration (5 days): Change of Effort (20 hours) leads to recalculation of Units

(Assigned Resource: Developer 50%).

Example 2: Fixed Units (number of Assigned Resource): Change of Units (1 — 2) leads to recalculation
of Effort (80 hours)

Example 3: Fixed Effort (56 hours): Change of Duration (10 days) leads to recalculation of Units

(Assigned resource: Consultant 70%).

Duration Assigned Resources Scheduling... Effort
10 days Fixed Duration 236 hours
2 | Developer 50% Fixed Duration 16 hours
1 5days . Fixed Duration 20 hours
7 days Fixed Effort 56 hours
2 5days Fixed Units 80 hours
2 | Consultant 70% Fixed Duration 8 hours
3 10 days c Fixed Effort 56 hours

Edit variables in the Task information window:

» Open the information window. (see Define dependencies between Tasks - Information
windowm)

The following tabs are available in the Task information window:

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 64 /271



>

THE PROJECT GROUP
> General: Here you can adjust the effort and duration of the task.
Task information X
General Predecessors Successors Resources Advanced r
Name [ Financing X ]
% complete 45 : Effort 40 hours :
Dates
Start < 24.11.2025 i@ > Finish < 28.11.2025 [
Duration 5 days : Color . Light-green v

Save Cancel
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> Resources: Here you can add or remove resources and change the unit and effort of the

resources.
Task information X

General Predecessors Successors Resources Advanced r

Resource Units
“ a2 PPP Project Manager 100%

Effort Units
40 hours 100% x

+

Save Cancel
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» Advanced: Here you can set the scheduling mode for the task.

Task information X

General Predecessors Successors Resources Advanced r
Ignore resource
Calendar Default calendar N
calendar
Scheduling mode Fixed Duration b Effort driven
Constraint type None X w Rollup
Constraint date = Inactive
Manually
scheduled

> Click Save.

5.8.3 Set Calendar for a Task

To calculate the task data, TPG Scheduler uses the calendar that is set on the Project Details tab in the
project master data. The “Default” calendar is set by default. (see Project Details Generalm)
N

Enterprise Project Type Default Project Type X

Calendar * (@ Default x

Itis possible to use a different calendar for individual tasks.

P Calendars can be configured by an administrator in the Settings area.

Set task calendar for individual tasks in the schedule:
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» Show the Calendar column. (see Schedule - TabIe@)

> In the task row, click on the cell in the Calendar column.

>

» Click on the arrow on the right in the cell. » The drop-down menu opens.

» Click on the desired calendar.

P A task calendar for a single task is set.

Mame

~ Task1

= Subtask1

s Subtask 2

s Subtask 3

s Subtask 4

% Complete

D)

Start

06.02.2025

07.02.2025

1.02.2025

1.02.2025

13.02.2025

Finish

19.02.2025

10.02.2025

17.02.2025

19.02.2025

19.02.2025

Set task calendar for individual tasks in the information window:

Duration

10 days

2 days

5 days

7 days

5 days

THE PROJECT GROUP

Calendar Predeces

Default
Monday to Thursday

Half Day Workweek

> Open the information window for the desired task. (see Define dependencies between Tasks -

Information window@)

» Go to the Advanced tab.

» Click on the arrow on the right of the Calendar field. » The drop-down menu opens.

» Click on the desired calendar.

» Click Save.

P A task calendar for a single task is set.
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Task information x
General Predecessors Successors Resources Advanced r
| . Ignore resource
calendar
38hrs
Scheduling mode Effort driven
19hrs
Test1
. Default
Constraint type Rollup
Monday to Thursday
Constraint date Inactive

Half Day Workweek

Manually scheduled

Cance'

P If no calendar has been selected for a task, the calendar field in the task editor is blank by
default. This makes it clear that no calendar is currently assigned.

P If a calendar is changed, the finish date of the task is adjusted. The nominal duration remains
unchanged. The effort is calculated at 8 hours per day, regardless of the daily working hours
defined in the calendar.

5.8.4 Create Rollup

In the TPG Scheduler, you can display subtasks in the Gantt chart directly below the bar of the higher-

level summary task:

» Show the Rollup column. (see Schedule - TabIe@) P Checkboxes appear in the task rows.

» Click on the checkbox of the subtask in the Rollup column.
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P The subtask appears directly below the parent task in the Gantt chart.

'024 Dezember 2025 Januar
Rollup
05 12 19 21
Summary Task
—
. Rollup [—1

Subtask -

Or

» Open the information Window of the task. (see Define dependencies between Tasks -

Information Windowrsahl)
» Click on the Advanced tab. (1)
> Click on the Rollup slider. (2)
> Click on Save. (3)

P The subtask appears directly below the higher-level Summary Task in the Gantt chart.

Task information x
1
General Predecessors Successors Resources Advanced r
Calendar . Ignore resource
calendar
Scheduling mode Fixed Duration v Effort driven

Constraint

Constraint type Start no earlier than X - Rollup 2 |§|

Inactive

[

Constraint date 07.02.2025

Manually scheduled
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5.8.5 Deactivate Task
You can deactivate tasks in the TPG Scheduler. Proceed as follows:
» Show the Inactive column. (see Schedule - TabIe@) Checkboxes appear in the task rows.

» Click on the checkbox of the task in the /nactive column.

P The task is crossed out in the table view and the task bar is colored gray in the Gantt chart.

Mame Inactive
' Task 1 o

= Subtask 1

= Subtask 3

Or

> Open the information window of the task. (see Define dependencies between Tasks -
Information Window@)

» Click on the Advanced tab. (1)
» Click on the Inactive slider. (2)

» Click on Save. (3)
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P The task is crossed out in the table view and the task bar is colored gray in the Gantt chart.

Task information

1
General Predecessors Successors Resources Advanced r
Calendar
Scheduling mode Fixed Duration
Constraint type Start no earlier than x
Constraint date 07.02.2025

4

Ignore resource
calendar

Effort driven

Rollup

Inactive 2 |§|

Manually scheduled

3 Cancel

5.8.6 Progress Indicator

You can specify the percentage of completion for each task using the progress indicator. The progress

indicator is found in the %$Complete column. This column is displayed by default.

> Select the task to which you want to assign a progress.
> Double-click the %Complete cell.

> Enter the progress percentage in the field.

P The percentage of progress will be displayed.

P The percentage is calculated automatically for summary tasks.
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v Task 1

Subtask 1

Subtask 2

Subtask 3

Subtask 4

Subtask 5

Subtask 6

% Complete

= [ L =1 L
SIoJ01010)010,

Recalculate total project progress:

>
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» Click on the down arrow on the right-hand side of the screen. (1) » The drop-down menu opens.

» Click on Recalculate project. (2)

P The total project progress is recalculated.

1
o v~ &M

[El Reset view settings

o Recalculate project | 2

5.8.7 Add Note

You can add notes to a task in the TPG Scheduler.
> Show the Note column. (see Schedule - Tablem)
> Select the task to which you want to assign a note.

» Double-click on the cell in the Note column.

» Click on the arrow in the cell. (1) » The note field opens.

> Enter the note for the task. (2)

» Click outside the note field to end the note.
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P The note is added.

Note Name

Mote on the Task El 1 v Task1

Note on the Taski Sub

2 - Sub

» Sukb

Or

» Open the information window of the task. (see Define dependencies between Tasks -
Information Window|_53h|)

> Click on the pictogram on the right. (1)
> Enter the note in the text field. (2)

> Click on Save. (3)

P The note is added.

Task information X

General Predecessors Successors Resources Advanced r 1

Note onthe Task 2
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5.9 Inter-Project Links

For better coordination between projects, you can create soft links in TPG PPP between tasks of the

current project and tasks of other projects.
This is possible on the Schedule and Inter-Project Links tabs.

The following section explains how to create inter-project links in the Schedule.

P Inter-project links created in the Schedule are also displayed on the Inter-Project Links tab
and vice versa.

5.9.1 Create Inter-Project Links
You can create inter-project links on the Schedule tab as follows:

» On the Schedule tab, select the task you want to link.
» Right-click on the task. » The drop-down menu opens.

» Select Inter-Project Links and click on Edit. » The Inter-Project Links overview opens.

Mame "7 nplete Start
# Edit
' Task1 . 9 06.02.2025
1§ Copy
Subtz % Cut EZ') 07022025
Subtz EZ') 11.02.2025
-
+  Subt Inter-Project Links > & Edit
-
Subtz Y Filter ? D 13.02.2025
+ Add S ™
» Click on Add.
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» The Quick Create: Inter-Project Link form appears.

Quick Croate: In'bqr-Prnjqct Link "

' el Bk XY

Bk

Btiara gt [rate

Ganeral

Bt Incdimter T G s e o T

Aite

Fegte

Dowrar : e‘ BPF Prowct Marnages [0S X
(o o | [
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» Complete the Quick Create: Inter-Project Link form.
Provider = Project that provides information to the current project.
» Click in the Project field and select the provider project from the drop-down menu.
» Click in the Task field and select the task from the provider project from the drop-down menu.
» Click in the Relevant Date field and select Start or Finish from the drop-down menu.

Consumer = Current project. Project that receives information from the provider project.

P The Project and Task fields are filled in automatically.

» Click in the Relevant Date field and select Start or Finish from the drop-down menu.

General

» Click in the Buffer Indicator field and select from the drop-down menu how the buffer should

be displayed in the Inter-Project Links overview.

+" Green when provider is the earlier date

Green when consumer is the earlier date

MNone

» Click in the Note field to enter a note for linking the tasks.

P The project manager of the consumer (current project) is automatically entered in the Owner

field.

» Click on Save and Close.

P The Inter-Project Link has been created.
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P The Inter-Project Links are displayed in the Inter-Project Links overview.

Inter-Project Links X
Project x| Provider 7 W
Task Create Project Request
Start 23. Dez. 2024
End 23. Dez. 2024
Duration 1 day
Buffer ssdays | Buffer Indicator

P The buffer is green if a buffer is available.

P The buffer is red if the buffer has been exceeded.
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5.9.2 Edit Inter-Project Links
In TPG Scheduler, you can edit inter-project links on the Schedule tab as follows:

On the Schedule tab, a link icon in the indicator column shows when a task is linked to tasks in other

projects.
# 3 MName
1|@ v Task 1
2 = Subtask 1

» Right-click on the task. » The drop-down menu opens.

» Go to Inter-Project Links and click on Edit.

Mame 7 nplete Start
# Edit
“ Task1 . 9 06.02.2025
i Copy
Subtz % Cut D 07.02.2025
= Subtz D 11.02.2025
—
Subt Inter-Project Links > ¢ Edit
-
Subtz Y Filter ? D 13.02.2025
+ Add B ™

» Click on the editicon. (3) » A form opens.
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» Click in the field you want to edit to edit the form. (1)
Mew Inter-Project Link 2 B X
o B |@See & SsvesCose| 4 New [ Dextiate [ Deete () Refresn [ S - |
Mew Inter-Project Link - caved
Inter-Project Link
General
Provider 1
Project & ™ Project X
Task @ [ Create Project Request
Relgvant Date " Start >
Cates
art & 23122024 08:00
Finish B 23122024 17:00
Consumer (This Projed
Project &l Projeid Xy
Tasic & B Ikl
Relevart Date Start W
Dates
Start 8 De0e2025 08:00
Finish 2 19022005 17:00
General
Buffer Indicator Green when provider is the earlier date v
Nete
Oumer " @ PBR Project Manager (Offine) 0
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P The command bar of the form contains buttons to deactivate the links or share them with

others.
MNew Inter-Project Link B X
= [ B Save & Save & Close Mew [ Deactivate [i] Delete () Refresh
), Chedk Access
New Inter-Project Link - saved A, Assign
Inter-Project Link B Flow 5
General = Word Templates 3
Run Report b3

» Click on Save or Save & Close. (2)
» Close the Inter-Project Links window.
Delete links:
» Click on the delete icon. (4) P A confirmation prompt appears.

» Click on Delete.

Inter-Project Links X
Project X & ||
Task Create Project Request 3 4
Start 23. Dez. 2024
End 23. Dez, 2024
Duration 1 day
Buffer 45 days

Jump to the linked task of the other project in the Gantt chart:
> Activate Show Inter-Project Links in the Gantt chart. (see Schedule - Buttons @)

> Right-click on the task.
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> Go to Inter-Project Links, Scroll to and click on the task (e.g. Create Project Request).

#

P The linked task is highlighted in the Gantt chart.

i .-
# Edit

& ¥ Copy
K Cut

.

-

-4 Inter-Project Links

2t i@ Y Filter

+ Add..

% Complete

& Edit

)

Start Finish

06.02.2025 19.02.2025

07.02.2025 10.02.2025

11.02.2025 17.02.2025

11.02.2025 19.02.2025

Scroll to

>

Create Project Request

AA S ST P T T T T T

P Inter-Project Links can only be edited or deleted in the project in which they were created.
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6 Resource Planning
You can plan resources in the TPG Scheduler.
There are three options with different procedures for resource planning and allocation:

= Assign resources to tasks directly in the schedule. [g5]

You can then transfer the data to the resource plan to check resource availability.

= Assemble the project team manually on the Project Team tab.l &)

If your project contains the Project team tab, you can assemble the project team manually and
then assign the tasks in the schedule.

= Create resource plan manually on the Resource plan tab.[s]

This allows you to see the availability of the resources before you assign tasks to them.

P Assigned resources and their tasks can be synchronized in the resource plan. The availability
of the resources is displayed there. If a resource is assigned to a task in the Schedule, the
resource is automatically added to the team on the Project team tab.

There are two views available for resource planning:
= Standard viewl ss : monthly view for a single year.
= Multi-year view:| 10l view spanning several years.

The following section explains how to work with these views.

6.1 Assign Resources in the Schedule
On the Schedule tab, you assign the resources to the tasks.
» Go to the Assigned Resources column.

> Double-click in the cell of a task.

» Click on the arrow. (1) » A drop-down menu opens in which you can search for the resources.
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P If you have already put together a project team, the drop-down menu shows the members
of the project team. You can also search for other resources. Assigned resources are
automatically added to the project team.

» Enter the name of the resource or the name of the department in the filter field. (2)
» Enter an asterisk (*) as a placeholder for parts of the name.
» Enter two asterisks (**) to display a list of all resources in the resource pool.
» Select a resource from the search results.
» Click on the checkbox of the resource you want to assign to the task. (3)
Adjust the working time of resources:
» Double-click on the Units column to adjust the percentage of working time.
Or
» Double-click on the Effort column to adjust the number of hours.
> Enter the desired value. (4)
> Click on Save. (5)

P The resource is assigned to the task and appears in the schedule.

SUUE TED

Duration | Assigned Resources | Scheduling Mo... Eff
SMDM
5 days N
[ h 4 2 Units Effort
1 day
v Consulting
10 days
3 C Consultant 4] 70% 56
0 days
O PU PPP Project User 8
9 days
v Development 2
10 days
I:I D  Developer 8
5 days
0 PM PPP Project Manager 8
7 days
5 days
5 Save Cancel
5 days
10 days Consultant 70% X 1" ] Fixed Effort 56 ho
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P The effects of changes to units and efforts are described under Define Scheduling Model es .

By default, the name of the resource is displayed as an abbreviation in the schedule:

Duration Predecessors Assigned Resources
20 days
2 days D PM
5 days 2 D
0 days 355 PM PU
5 days AFF C D
1 day 5 C

You have the option of displaying the full name of the resource in the schedule:
» Click on Features. P A drop-down menu opens.

» Click on Show full resource names.

= Features ~ =; Baseline

<

. . Draw dependencies
D Show task labels
D Show critical path
Draw start and end
Draw today indicator
Highlight non-working time
D Show more lines
D Show resource utilization k
Show inter-project links

D Show timeline

Show full resource names

Timeline size >

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 85/271
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Duration

20 days

2 days

5 days

0 days

5 days

1 day

Predecessors

355

AFF

Assigned Resources

>
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Developer 63%  PPP Pr

Developer 50%

PPP Project Manager 0%

Consultant 100%  Deve

Consultant 100%

If Show resource utilization is activated in the Features menu, the resources and the allocated working

hours are displayed in a table below the schedule.

+ Add * O aQ @ & 1 Pl
# i MName % Compl... Start Finish Duration
1 @ w  Vorgang 1 49) 03.11.2025 28.11.2025 20 days
2 A Teilvorgang 1 03.11.2025 04.11.2025 2 days
3 a Teilvorgang 2 05.11.2025 11.11.2025 5 days
4 2 Teilvorgang 3 \?_0) 05.11.2025 05.11.2025 0 days
5 a2 wigh Teilvorgang 4 5‘9 03.11.2025 07.11.2025 5 days
6 - Teilvorgang 5 2\;\ 10.11.2025 10.11.2025 1 day
7 - Teilvorgang 6 h; 17.11.2025 28.11.2025 10 days

Resource f Task T Start Finish Units

> € Consultant 03.11.2025 09.12.2025 100%

> D  Developer 03.11.2025 02.12.2025 100%

> PM PPP Project Manager 06.02.2025 28.11.2025 100%
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P & Draw dependencies Okt 2025 50 02 Nov 2,
re i
DFSSMDMPD
D Show task labels
D Show critical path

Draw start and end PP R

Highlight non-werking time
355 0%
[] show more lines

AFF —
Show resource utilization|

5 Show inter-project links

—
.

2 Draw today indicator -
—

D Show timeline

Show full resource names
Okt 2025  So 02 Nov 2
nt

Timeline size » DFSSMDMD
256h 8 8 & 8
130h 1313 12 12
74h BiE] o
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6.2 Project Team Tab - Assemble project team manually

P Only for project types with the Project Team tab.

» Go to the Project Team tab.

» Click on New Team Member.

| t  Mew Team Member | ) FRefresh = Flow

P Resource type Enterprise is preset. |.e. a member of your organization that is listed under
Resources.

> Click in the Resource field.

Quick Create: Team Member

Resource Type " | Enterprise
Resource Look for Resource /“:’
Project " Il Project B

> Search for the desired person.

» Add further team members: Click on the arrow next to the Save button and select Save &
Create New.

Save 8 Create New

Save and Close | | Cancel

» Click Save and Close to complete the task.

TPG PPP - Scheduler User Guide 2.16 EN

© The Project Group GmbH | All rights reserved 87/271



>

THE PROJECT GROUP

Add people to the project team who are not listed as a resource:

> Select the Local resource type in the Quick Create form.

Quick Create: Team Member e
Resaurce Type * || Enterprize |~ |
Enterprise
Project * Il Project B

> Enter the name of the person you want to add to the project team.

Quick Create; Team Member

Resource Type ° Local
Mame |
Froject " Pzl Project B

> Click on Save and Close.

P Local resources cannot be entered in the resource plan. Local resources can be assigned in
the schedule.
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6.3 Resource Plan Tab - Create Resource Plan manually

You create the resource plan on the Resource Plan tab. You can plan the operating times of the

individual resources.
Available views in the resource plan

There are two different views available in the resource plan, which differ in terms of the period

displayed:

= The monthly view for a single year is the default view.
In this view, resources are planned and displayed on a monthly basis within a calendar year. This

view is particularly suitable for detailed planning within a year.

® |n addition, the Multi-year view is available.
In this view, resource planning is displayed over several years. The Multi-year view facilitates an

overview of long-term planning and resource utilization that extends beyond the end of the year.

P The resource planning steps described in this section apply to both views.
P For clarity, the steps are shown using the default view.

P The use of the Multi-year view is described in the section Use Multi-year view in Resource

PIan|1_oa.

P By default, planning is at monthly level. Other time units can be configured.

Add Resources and enter work values:

» Click Sync (1) to transfer already assigned resources to the resource plan. » The Synchronize rows

dialog box opens.
» Click on the Overwrite existing checkbox.

» Click on the Include work values checkbox if you also want to apply the work values of the

resource.
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» Click on Update. P> The resources and their tasks are transferred to the resource plan.

Synchronise rows

Synchronise tasks and team members with this
resource plan

Owverwrite existing

Include work values

» Click on New (2) to add resources manually. » A new row appears in the table.

Bl2oss 206 (92027 2028 v W R | &3 Compare
= i Resource Department @ 1 2
(] Resouree Department Assignment Comments Total  Year ¥ Jan Feb Mar
O v~ Development(2) 134,50 2.50 80,00 12,00
O Development PPP Project Manager Identify Risks 20,00 2025

O Development Developer 11450 2025

» Click in the cell in the Resource Name column. P A drop-down menu opens.

> Select the name of the desired resource in the drop-down menu.

Resource Department Resource Mame Assignment

~ Development (2)

Development PPP Project Manager X ¥ Risks
Development o}
v IT(2) ¥ Consulting
50%Res 7.6
IT
Consultant
IT PPP Project User

P The Resource Department column is filled in automatically if data is available.

P The resource is added.
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Colors show the utilization of the individual resources. The following color scheme applies:

Rezsources 100% availakle
Iare than 10% of resources
available

Resources between -103%
and =10% available

Less than -10% of resources
available

Assigned task

The mouseover shows the number of days on which the resource is available or otherwise scheduled.

2,50 Availability for period: 20,50 d | Other project work: 0,00 d

P In the monthly field, you can enter the number of days for which you are scheduling the
resource.

P Resources that are not assigned to a department are not displayed with an availability
indicator in the heat map. Instead, the message “Availability for period: NA” appears.

Duplicate or delete entries:
> Select the task you wish to duplicate or delete.
» Click on the checkbox at the beginning of the line of the task. (1)

» Click on Duplicate or Delete. (2)

03 2025 [0 2026 [@ 2027 [0 2028 - T4 L | 8 Compare & Syne -+ New | = Duplicate

il Resource Department &
2 Resource Department Resource Name Assignment Comments Total  Year 7 Jan Feb Mar Apr May
-] v Development (2) 13450 250 80,00 12,00 20,00

2000 2025

PPP Project Manager fentify Risks
| 1 Development Developer 11450 2025

P The task is duplicated or deleted.
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Further functions:
The buttons in the Resource Plan tab offer you even more functions:
= Graphical representation of the data:
» Click on the graphic pictogram. (3) P A diagram is shown or hidden below the table.
= Export all selected rows to Excel:
» Click on the Excel pictogram. (4)
= Show more rows or reset display settings:

» Click on Settings (gear wheel). (5)

3 4 5

L Sync -+ New T Duplicate [i] Delete (O |wt| . |88 | |EE v

D Show more lines
=! Reset view settings
Feb Mar Apr May Jun I:L .
= Change standard groupings:

> Drag column header over table.

» Remove column headings: Click on the cross.

i Resource Department €

= Resource Department Resource Mame

— v  Development (2)

] Development PPP Project Manager
Development Developer

» Show and hide columns:
» Click on Columns. (6)

> Activate or deactivate the checkboxes.
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> Create pivot table:

» Click on the Pivot Mode button to activate the pivot mode. (7)

You can determine the order of the column titles using drag & drop.

May (3 pivot Mode | 7 6
m
B search. g
E
i Resource Name -
[] #i Resource Name (Team ...
] i Assignment
H o Assignment

Navigating between years:

» Click on one of the years displayed to view its resource planning. The currently displayed year is

underlined in blue.
Or

» Click on the down arrow to select a specific year from the drop-down menu.

P The view will jump to the corresponding year.

B 2025 [ 2026 [ 2027 [ 2028 -] 2

= i Resource Department @ 2024
[ 2025
:] Resource Department R s
2026
= “ Development (1)
2027
] Development
2028

]
)
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6.4 Automatically share a project with team members

When a project team member is added, the corresponding project is automatically shared with that

person so that they can view and edit it in the Scheduler.

When a task is assigned to a person, they automatically receive write access to that item so they can
edit and update it.

Sharing Mechanisms

PPP uses two different mechanisms for automatic sharing:
1. Project Approval via Access Teams

Process:

1. A project team member is added (see Project Team Tab - Assembly project team manually@hl),

modified, or removed.

2. The system identifies the associated project and searches for an access team named “Team

Member [Project Name].” If no such team exists, it is automatically created.
3. The access team is assigned the following permissions for the project:

= Read

= Append

= Append To

4. Next, all project team members with the “Contribute” permission (not “None”) are identified

and synchronized with the access team:
= New members are added.

= Removed members are removed.
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= Members with the “None” permission are also removed.

Developer - saved

Team Member

General
Resource Type “ Enterprise 7
Resource s Developer X =
Standard Rate o] 110,00 €
Max Units &
Permission Contribute i

--Select--

v Contribute
Mone

P The access team functions as a dynamic, automatically synchronized user group. All users

included in it inherit the defined project permissions.

2. Approval of Actions (Direct User Approval)

Process:

1. When an action is created, the user specified in the “Assigned to” field (see Edit Actions|1_e7'1) is

automatically granted write access.
2. If the task is assigned to another person, the new assignee receives the following permissions:
= Read
= Write
= Attach
= Append to

Access is revoked from the previously assigned user (unless they are the owner of the record;

owners always retain access).

3. No access team is used for tasks; access is granted directly to the respective user.
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Summary:
= Access is granted automatically whenever a task is created, modified, or deleted.
= Access management is handled dynamically and without manual intervention.

= Permissions can be controlled at the level of individual team members (e.g., via “Contribute” or
“None”).

® The approval of tasks is handled by a separate mechanism.

P Existing Data: Existing entries are automatically set to the “Contribute” permission during the
next deployment. Manual adjustment is not required.

P Tasks: Assigned users can edit their tasks without additional approvals. Upon reassignment,
access rights are automatically transferred.
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A warning appears if you open a schedule in which open tasks are assigned to a deactivated resource.

Inactive resources

X

There are assignments of inactive resources on

open tasks.
Inactive resources:

* PPP Project User

The indicator column of the task shows a warning symbol next to the resource symbol.

a A

The name of the inactive resources is crossed out in the resource plan of the schedule and in the

resource plan.

J T Units
P
24
* Consulting (2)
i PPP-Project User 100% ko
J Consultant e
= Development (2)
.—I Duveloper i
n
B

I PPP Project Manager

Sawe Cancel

PEP Project | o 56
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6.6 Resource Plans Overview

The Resource Plans overview provides a comprehensive view of all available resources in a tabular

format.
To access the Resource Plans overview, follow these steps:

» Click on Resource Plans in the navigation bar.

P The Resource Plans overview opens.

B8 Show As B showChan (0 Refresh ] Visualize this view O] Email a Link 2 Flow

]

G Excel Templates W Expottobxcel v @7 Impont from Excel

T} Recent \_ Resource Plans

Resource Department O
Retource Department Project Rescurce Nase Cemments vy sl ™ Fet Mar pr May Aan o

~  Consulting (8) 5.00 20.00

2025 250
2025 250

2025

~  Development (&) X 250 BA50 12,00 20,00

Timesheets

Timashests
@ Approvals
2025 i 250 5000
Reports
2025

This view allows you to capture important information at a glance:

= Resource Overview: All resources are listed in a table.

Department Assignment: Each resource is assigned to the corresponding department.

Project Assignment: The table shows the projects on which the resources are currently working.

Resource Name: The name of each resource is displayed.

Planned Working Time: The planned working time of each resource is broken down by month.
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Color Scheme of Resource Availability:

The Resource Plans overview displays a heatmap that shows the availability of resources in percentage

terms. This display is based on the totality of all resources in a department.
The following color scheme applies:
= White: Indicates that the resources are 100% available.
= Green: Indicates that more than 10% of the resources are available.
= Yellow: Indicates that the availability of resources is between -10% and +10%.
= Red: Indicates that less than -10% of the resources are available.

The Mouseover shows the availability as a percentage:

2,50 80,00 12,00 20,00

Myailakility for period: 89,13% | Other work: 0,00%
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6.7 Use Multi-year view in Resource Plan

The Multi-year view in the resource plan displays all resource lines over several years. This makes

resource planning beyond the turn of the year easier to recognize.

14 Previous | Next -=- v + 3 &% Compare ™ L Sync 4+ New
Years displayed
= ii Resource Department @ play
| 2024 > 2025 > 2026 > 2028 <
O Resource Department Resource Name Assignment Comments Total Total
Total Total Total Jan Fet
O v Development (8) 0.00 168.00 114.00 54.00
O Development Developer Review Project Re... 0.00 16,00 16,00 0,00
O Development PPP Project Manager Identify Risks 0,00 3,00 3,00
O Development PPP Project Manager Planning Complet... Total sum of 0,00 0.00 0,00
O Development PPP Project Manager Preliminary Planni... all years displayed 0,00 25,00 25,00
O Development PPP Project Manager Financing 0,00 30,00 30,00 0,00
O Development PPP Project Manager Review Project Re... 0.00 9,00 9,00
O Development PPP Project Manager Detailed Planning 0.00 21,00 9,00 12,00
O Development PPP Project Manager Create Project Re... 0,00 64,00 22,00 42,00

P If the Multi-year view is not available, it must be activated by an administrator. In this case,

contact your administrator.

P The number of years displayed can be changed by the administrator.

P The creation of the resource plan is described in detail in the section Resource Plan Tab -

Create Resource Plan manuallyl se |
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Navigating between years:
» Click Previous to switch to the display of previous years.
> Click Next to switch to the display of subsequent years.

» Click the down arrow to select a specific year from the drop-down menu.

P The view will jump to the corresponding year.

| Previous [>| Next

= i Resource Depart 2019

2020

O

Resource Departme 2021 n

2022
O ~  Developmer

2023
L] Develop 2024
O Develop 2025
O Develop 2026
— 2027

Develop

2028

Develon
Expand or Collapse Years
» Click the icon (arrow pointing right or left) to expand or collapse a year.
> Collapse years you do not need in order to reduce the view.

> Expand additional years to display more time periods.

2024 > 2025 2026

Total Total Jan Feb
44,21 30,50 12,00

5.26 4,00 4,00

10,53 7,75 1,00
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Total amount over several years:

The software automatically calculates the total number of working hours across all currently visible

years. This total is displayed in the Total column (1).
Total per calendar year:

The software also determines the total number of working hours within a single calendar year. The

annual total - for example, for the year 2025 - appears in the Total column (2).

1 2024 > 2025 > 2026 <

Total 2
Total Total Jan Feb
86,71 44,21 30,50 12,00
13.26 5.26 4,00 4,00
19,28 10,53 175 1.00
10,87 1,37 2,50 1.00
10,26 5.26 3,00 2,00
3,00 0,00 2,00 1.00
10,37 7,37 2,00 1,00
13,62 1,37 5.25 1,00
6,05 1,05 4,00 1,00
42,84 26,84 8,00 8,00
17.32 1.32 8,00 8,00
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Labor costs are not calculated automatically in TPG PPP. You can enter financial data on the Financials

tab for a cost overview.

Available views in cost planning

There are two different views available in cost planning, which differ in terms of the period displayed:

= The monthly view for a single year is the default view.

In this view, costs are planned and displayed on a monthly basis within a calendar year. Itis

particularly suitable for detailed cost planning within a year.

|ﬂ 2025 [0 2026 [ 2027 [0 2028 - ~ |? 0 E &2 Compare

Hi CostType @ b Il CostCategory @

Cost Type Cost Category Expense Type Details Y. ¥ Jan

v o3 60.000

V(3 60.000
20.000
10.000

30.000

= |n addition, the Multi-year view is available.

60.000

60.000

20,000

10.000

In this view, cost plans are displayed over several years. The Multi-year view facilitates an

overview of long-term cost developments and planning across annual boundaries.

14 Previous | Mext v + O IE~ &3 Compare ~

= U CostType © » Bl Cost Category @

“+ New

|2023>

2025 > 2026

O Cost Type Cost Categery Expense Type Details Total Total
O ~  Forecast (1) 0 -
O v  Budget(l) 0 -
O ~  Actual (1) [} 40.000
O ~om o 40.000
(]} Actual L] 40.000

20.000 20.000

20.000 20.000
20,000 20,000
30.000 30.000
30.000 30.000

30,000

5
III g

20.000 10.000 10.000

20.000 10.000 10.000

20.000 10.000 10.000

P The functions of the buttons are the same as in the Resource Plan tab. (see Resource Plan tab

- Create Resource Plan manuaIIy@)

P For clarity, the steps are shown using the default view.
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P The use of the Multi-year view is described in the section Use Multi-year view in Resource

Plan|1_ogl.

Add financial data:

> Go to the Financials tab.

» For each cost item, create rows for the Budget, Forecast and Actual cost types:
» Click on New. (1)
» Click in the Cost Type cell. > A drop-down menu opens.
» Click on Budget, Forecast or Actual. (2)
» Enter the available budget and the expected costs for each time period of the project.

» Click in the cell of the desired time period. (3)

» Enter the amount.

P Total updates automatically.

(2024 [ 2028 (206 32027 -

% @ | 1 O m S @
CostType @ » I Cost Category @
Cont Type Cost Categary Expense Type Detaily . ¥ Tatal Jan Feb Mr g May Jan Jad Aug
] 3 Foracast(l) 15.500 5.000 4,000 6500 E
v Budget(l) 15.000 15.000 3
S |
~om 2 15.000 3 15.000
Budget 2025 15.000 15.000
> Acual(t) 10.500 5.000 3.000 2500

| IID n L

W Budget [ Forecast [ Actual

Add to or update the actual data and forecasts as the project progresses.

P Totals are also displayed on the Project Details tab under Project Estimates. (see Project

Detailsm)
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8 Status Update

On the Status Update Tab, you can create status updates in the form of status reports on the current

project schedule and share them with stakeholders.

Status reports are an essential tool for monitoring the progress of a project, ensuring transparency and
making informed decisions. Status reports help to keep everyone involved up to date and identify

potential problems at an early stage.
We will guide you through the process step by step and show you how to work with status updates:
= Add Status Update|1_os'1
= Edit Status Updatem
= Deactivate and Activate Status Update@
= Adjust Table[ ]

= Further Commands for Status Updatesm

8.1 Add Status Update
To add a Status Update, follow these steps:

» Click on New Status Update. > The Quick Create: Status Update form for creating a status report

Status Update
All Statug Reparts Refresh F
Repert.. | Status Summary Subemitted To Accomplished Activities ~ Missed Activities v Planned Activities Spe
06032025 Action 2 completed late @1 po Project Mansger (O Action 2
12022025 Delay after Phase 1 @ ppe Project Manager (Off.. Action 1 Action 2. due o resource shortage:

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 105 / 271



Quick Create: Status Update

Status Details

Report Date *
Project

Status Summary *
Owner "

Submitted To *

Email Status Update

Updates

Accomplished Activities

Missed Activities

Planned Activities

Sponsor Actions

> Fill in the form:

0

=l ProjectX X

@ eer Project Manager (Offline x 0

Jo

@ -

Save and Close . Cancel

>
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P To add a status update, the required fields must be filled out. All required fields are marked

with a red asterisk.
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= Status Details:
= Report Day:
» Click on the calendar icon and enter the date on which you are creating the report.

= Project: The current project is selected by default.

P You can select a different project by clicking on the search icon (magnifying glass) and
choosing another project from the dropdown menu.

= Status Summary: Description of the Status Update

> Enter a description for the status update. It should be as detailed as possible (e.g., Delay
after Phase 1).

= Owner: Creator of the status update. By default, the current user is entered.

P You can select a different user as the owner by clicking on the search icon (magnifying glass)
and choosing another user from the dropdown menu.

= Submitted to: Stakeholder to whom the status update is submitted.

» Click on the input field, press Enter, and enter the desired stakeholder.
= Email Status Update: enabled by default.

» Click the toggle switch to disable sending the status update via email.

= Updates: Description of the status updates.

» Enter the descriptions of the status updates in the corresponding field. The description should

be as detailed as possible.
> Click Save and close.

Or

» Click the down arrow and select Save & Create New to add another status update.

Save & Create New

Save and Close -
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P A status update has been added.

P The status update appears in the table All Status Reports.

8.2 Edit Status Update
A status update can be edited as follows:

» Click on the preview in the Status Summary column. » The form for editing the status update

opens.

[] Report.. T+~ Status Summary v Submitted To ~

] 12022025 Delay after Phase 1 @ PPP Project Manager (C

Or
> Click on the row of the status update to select it.

» Click on Edit.

All Status Reports ~ & Edit
E Repoert.. T~  Status Summary v Submitted To ~ Accomplished Activities ~ Missed Activities ~
12,02.2025 Delay after Phase 1 @ PPP Project Manager (Off... Action 1 Action 2, due to resource shorl

» Enter the desired changes in the form.
» Click Save (1) to save the changes and continue editing.

Or
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» Click Save & Close (2) to save the changes and finish editing.

¢ () @’ Save & Close| [ Deactivate [i] Delete () Refresh € Check Access A, Assign 2 Flow @H Word Templates ~  {] RunReport

Delay after Phase 1 - ssved

Status Update

General

Status Details

Report Date " 12022025 B Owner " @ £PP Project Manager (Qffing) X

Status Summary " Delay after Phase 1 submitted To o EFP Project Manager (Offine)
Email Status Update @ ) nNo

Accomplished Activities Action 1

Missed Activities Action 2, due to resource shortage

Planned Activities

Sponsor Actions

8.3 Deactivate and Activate Status Update

By default, status updates are active. You can deactivate status updates:
» Select the status update you want to deactivate.
» Click on the row of the status update to select it. (1)

» Click on Deactivate. (2)
& kit B Acivate B Delete Status Update

All Status Reperts

- Report I~ Status Summary ~ Submitted To ~ Accomplished Activities ~ Missed Activities ~ Planned Activities - Spe
06.03.2025 Action at ager (OF, Agtion 2
1B 2020 Delay afte agec(Off.. Action 1 Action 2 due to resource shortage.

» The Confirm Deactivation field opens.
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» Click Deactivate to deactivate the status update.

Confirm Deactivation X

Do you want to deactivate the selected 1 Status Update? You can reactivate it later, if you

wish.

This action will change the status of the selected Status Update to Inactive.

Activate status update:
> Select the status update as described above.

» Click on Activate.

Al Status Reports + # wat [B _sawte |G oocuate 8 uetostans saste
A Filter by keyword
@ Report.. Accomplished Activities = Missed Activities = Planned Activities Spr
06.03.2025 ... Action 2
B 12022025 Action 1 Action 2, due to hortag

P The Confirm Status Update Activation field opens.

» Click Activate to activate the status update.

Confirm Status Update Activation X

Are you sure you want to activate the selected 1 Status Update?

This will set the Status Update to the Active state.

Activate Cancel

By default, all active and inactive status updates are listed in the table. You can display only inactive

status updates in the table:
» Go to All Status Reports.

> Click the down arrow.
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» Click on Inactive Status Reports.
All Status Reports ~

System Views

All 5tatus Reports

Inactive Status Reports

8.4 Adjust Table

For better clarity, you have the option to customize the table. Depending on the column, various

options are available to you:
» Go to the table header.
» Click the down arrow to the right of the column header. » A dropdown menu opens.

Status Summary
T AtoZ
l ZtoA
=B Group by
S Filter by
Column width
— Move left

— Move right

> Select the desired option:

= Sort: Older to newer/Newer to older (Date) or A to Zor Zto A.
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= Group by: Group status updates by column header (e.g., Status Summary).
All Status Reports v
[] | Group by: Status Summary Report... |~  Status Summary v
D ~  Action 2 completed late (1)
J 06.03.2025 Action 2 completed late

[J > Delayafter Phase 1(1)

= Ungroup: Remove the selected grouping.
= Filter by: Select various filter options (e.g., Equals) to display only certain status reports.

Status Summary ~

Filter by >

‘ Equals -

‘ Delay after Phase 1 ‘

P In this example, only status reports whose status summary exactly matches the entered text
"Delay after Phase 1" are displayed.

= Clear filter: Remove applied filters.
= Column width: Adjust the column width.
= Move left: Move the column one position to the left.

= Move right: Move the column one position to the right.

Refresh table:
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» Click Refresh to update the table.

- New Status Update O Refresh =~  Flow ™~

8.5 Further Commands for Status Updates
Above the table, you can perform additional commands for status updates:

» Click on the 3 dots above the left side of the table. » A dropdown menu opens.

late () Refresh =  Flow D

Run Report h

. B Excel Templates >
wcti

B Export Status Updates >

B8, See associated records

P If you have selected a status update, the dropdown menu contains additional commands
related to the selected status update.

ictivate lil Delete Status Update

A, Assign Status Updates

S

Share
\cti

&

Email a Link

Flow >

B | %

Run Report >

B

Word Templates >

[ |
fra)

Export to Excel

See associated records

a

» Select the desired command:
= Delete Status Update: delete the selected status update. The action cannot be undone.

= Assign Status Update: change the owner of the status update.
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= Share: share these status update with selected people or teams. Ownership is not changed.
® £mail a Link: send a link via Email to the selected records.

= Flow: run a flow for this status update.

= Run Report: select a report to run.

= Word Templates: generate Word documents or new templates.

= Export to Excel: export the selected records to data to a static Excel worksheet

= See associated records: shows records associated with this view.
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challenges at all times.

Project - Status Report

Status Rep...

>

1 Schedule R Cost 3 Progres
A @ o L]
= Actual Efle F ey £
38 61

e cive Risk Active Actice

5 8 4 3

e Cha Open Decisicns
3 3 5
Accomplished Ac ned Act s1ed A Sporar

THE PROJECT GROUP

The Status Report tab provides a central overview of the current status of the current project. All

relevant reports and key figures are bundled here so that you can keep track of progress and potential

I i 5~ s |

2

Detailed
Reports on
individual
aspects

¥

such as:

Project Name, Project Manager, and Project Number (1)

On the start page of this tab, you will find the most important information about the current project,

Progress of the entire project and traffic light display (red, yellow, green) for the individual Project

kPisl 21(2)

Project start and end dates (3)

Cost development (4)

Information and link to the last Status Update|1_osh| (5)

Actions from the last Status Update and their implementation status (6)

Number of active Issuesm, Risksm, Changes@, Actions, open Decisions@, and Lessons| 2| (7)

Links to the home page and other reports: Portfolio, Request, Resource (8)

on individual aspects of the project:
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= Timelinel ]
* Financials[1sl
= Effort] )

= Issues| 1zl

= Risks/1zs]

] Changes@
= Actions| ]

= Decisions/ 1z
= Lessons @
= Benefits| 1zl
= Objects|1_3h

] Requirements@

= Stakeholderm
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P You will find links to all reports on the Home page.

Portfolio Reports
rg
Cashboard Status
Artifacts Timeing
Schedule Financials
Effort Issues
Risks Cranges
Actions Decisions.
Banafits Lessons

Reports

Timaling

Lessons

Otjactves

Stakahcider

Summary

Dashbord Availabiity Chart

Availability Heatmap Utilization

Rescurce Plan Time) Resource Plan (Cost)

P The language of the reports is set centrally. It is not possible to change the language via the
Personalization Settingsm. Available languages: English and German.
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9.1 Timeline

On the Timeline tab, you will find a visual representation of the project progress in the form of a table

and a Gantt chart:
Table:
= Rows: Task of a project
= Columns: Start, end, days, and progress of the task
Gantt chart:
= The duration and timeline of a process are represented by colored bars.
= Hovering over a bar displays details about the respective process.
= You can zoom in or out on the display:
» Move the mouse pointer over the Gantt chart.

» Use the mouse wheel to zoom in or out to adjust the view.
Project - Timeline i Home B Pomtolic [l Projea G Reauen R Resource

Project X ~ = Drop-down menu to switch projects
2 1=

Task Start End Days Progress

¥ PROJECT X MM HOSE  33Ud

Phase ProjectX
Task Phase 1:Initiation
Start Mon, 23 December 2024
End Thu, 30 January 2025
Days 394
. Assignee undefined Mouseover with

Progress 1% information about the task

|
|.
B-
| e

Status Report Financialy Effort Issues Risks Changes Actions Decisions Lessons Bemafis Ctjectives Requirements Stukeholoer
Adjusting the time scale of the Gantt chart (1):

The time scale of the timeline can be adjusted flexibly:

> Click on the desired time scale.
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= Years (default view)

= Months

= Days

= AJl: Automatically displays only the period relevant to the project (project start to project end).
Expand and collapse tasks (2):

» Click Collapse. » All tasks are collapsed.

» Click Expand. » All tasks are expanded.
Additional options (3):
= Copy timeline as graphic. (4)
= Apply filters to influence the visual representation. (5)
= Show only enlarged timeline. (6)
= More options (7):
= Export data
= Display data as table
= Highlight timeline

= Show insights

4 5
o =

.
~J

) Export data

N ) .
: & Show as a table

L& Spothight
@ Get insights
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9.2 Financials
The Financials tab provides a detailed overview of the project's financial key figures:
= Project name and traffic light display for evaluating the current cost situation (1)
= Numerical information on costs (2):
= Budget Cost

= Forecast Costs

Actual Cost

= Remaining Cost

Cost Variance
= Filter and customize data using two drop-down menus (3):
= Select the year for which you want to view financial data.
= Select the cost type.
= Bar charts show cost development and project costs by type (4)
= Annual overview of costs in table form (5):
= Actual
= Budget

= Forecast

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 119 /271



>

THE PROJECT GROUP

e

Project - Financials & Home B oo [l Projec
Project X ~ Cost Budget Cast Farecast Cost Actual Cast Remaining Cast Cost Variance )
1 L ] € 34,000 €32,100 €31,100 € 1,000 €2,900
Vesr Budget Cost by Categery Forecast and Actual Cost by Vear Project Cast by Type
. € 24 @ Cost Actual @ Cos Forecast —Cost Budget
€311K 4
3 €346
Expense Type €3
B I
Year 2025
Quarter Qi Q2 Q3 a4 Total
Category Expense Type  Cost Type Jan Feb Mar Total Apr May Jun Total Jul  Aug Sep Total Oct Nov Dec Total
Actual €4400 €2000 €5200 €11.600 €1000 €6500 €3000 €15500 €4000 €0 €0 €4000 €0 €0 €0 €0 €31.100 €
5 Budget €4500 €2000 €5500 €12000 €1000 €5000 €7000 €16,000 €6000 €0 €0 €6000 €0 €0 €0 €0 €34.000 €
Forecast ‘€4_300 €1800 €5200 €11,300 €1000 €7500 €6500 €15000 €5800 €0 €0 €5B800 €0 €0 €0 €0 €32,100 €
Status Repert Timalng m shan lazoes Risks Changes Aetions Ducisices Lesscns Eamains Otjectives Baquremants Sakholder

Additional display options for the

bar chart:

The bar chart compares actual costs with projected costs. The following options are available:

Copy bar chart as graphic (6)

Apply filters to influence the

More options (9):

= Export data

Display data as a table
Highlight bar chart
Display insights

Sort axes
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6 7 8 9
Forecast and Actual Cost by Year &1 Export data
@ Cost Actual @ Cost Forecast —Cost Budgat & Show as a table
. e ~ M Spotlight
- 2 Get insights
€ 34.0K .
£ 20K Sort axis > v Year
Cost Actual
£ 0 Cost Forecast
0= Cost Budget
£l Sort descending
~ % Sort ascending
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9.3 Effort

The Effort tab provides a detailed overview of all efforts in the project:
= Project name and traffic light display for evaluating the amount of work involved (1)

= Status overview of tasks:

A bar chart (2) shows the current status of all tasks, divided into:
= Overdue tasks
= Completed tasks
= Delayed tasks

= Comparison of actual and estimated effort:

A column chart (3) compares the actual effort with the estimated effort.

= Tabular list of tasks:

Below the charts, you will find a table (4) listing all tasks, including:
= Start Date and Finish Date
= Progress
= Duration

= Forecast Effort

Actual Effort

= Remaining Effort
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S— e EE e — A W
: Tasks By State @ Actual Effort
x v
e SForecst Bt bl )
1 oo [ - ' . 3
—
" Dec Jan Fed Apr
Late I 2004 208

Index Task StartDate Finish Date Progress  Duration Forecast Effort  Actual Effort  Remaining Effort
00001 Project Start 2312204 23.122024 |MNIO0R [] [] 0 0
00002 Phase 1: Initiation 23122024 30012025 |NO0R 29 160 160 0
00002.00001 Create Project Request 23122024 2322024 |NENOO% 1 ] H 0
00002.00002 Review Preject Reaquest 06012025 17012025 |NNO0R 10 80 80 0
0000200003 Identify Risks 20012025 30012025 (IEO0R 9 2 72 0
00003 Initiation Completed 30012025 30012025 |ENOGR 0 0 0 0

4 00004 Phase 2: Planning 31012025 27.022025 -x 20 25 0 5
00004.00001 Preliminary Planning 31012025 06022025 [0S [ 8 ] ]
0000400002 Detailed Planning 07.022025 20022025 |INEGE: 10 L] ] 1
0000400002 Financing 21022025 27022025 [ 45% 5 ] 4 4
00005 Planning Completed 27022025 27022025 Ml 2% o 0 ] ]
00006 Phase 3: Execution 28022025 18042025 - 43% 32 32 4 18
00006.00001 Task 1 28022025 27032025 |NOs: 20 8 6 2
00006.00002 Task 2 28022025 18.04.2025 _m 32 8 5 3
00006.00003  Task3 28022025 19032025 Ml 25% 14 8 2 6
Duraton in days | EMort in houn

‘Stanas Report Timeine Financialy m lnsues Risks Changes Actions: Decisions Leszons Benefs ‘Objecthves. Requirements Sakehcider
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9.4 Issues

The Issues tab provides a detailed overview of all issues in the project.

Project overview (1):
= Project name
= Traffic light display for evaluating the current issue situation
= Number of active issues
= Number of overdue issues

Visualization of issues:
= Bar chart by priority: Shows the distribution of issues by priority level (2)
= Graphical representation by category: Visualizes the issues by category (3)
= Tabular list of all issues with the most important information and link to the issue (4)
= Color legend (5)

Project - Issues A Home B rotioic | Projen Q Requen gl Besouce ‘

Issue lssues by Priority lezues by Category

Projact X =l -
1 i | | _ 1
Active lssues Overdue lssues Schedule
Budget
Meciuar Y= - .

lssue Age (Days) State Briority Category Assigned To
Problem 2 19 W Active Medium Schedule PPP Project Manager
Problem 3 1 W Active Low Other
Problem 4 1 * Active Low Other
Problem 5 6 K Active Low Scope
Problem 6 6 K Active Low Budget
4 Problem 7 6 W Active Medium Vendor
Problem & 6 W Active Medium Schedule
Problem 9 6 K Active Medium Vendor

\

Link to the Issue

B [CUZDATE W Red = Overdus | Amber = Misting and not clozed |

‘St Report Timeling Financials Effort Issues Risks. Changes Actions Dedsiens Lassens Benefns Otgectives Requiremants Stakeheider
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9.5 Risks

The Risks tab provides a detailed overview of all risks in the project:
Project overview (1):

= Project Name

= Number of active Risks

= Number of overdue Risks

Visualization of risks:

Graphical representation by category: Shows the distribution of Risks by category (2)

Risk Matrix (3): Shows the Risks according to probability of occurrence and consequence

Tabular list of all Risks with the most important information and link to the Risk (4)

Color legend (5)

Project - Risks

Project X w

Active Risks Overdue Risks
s N
Risk Age (Days) State Exposure Category Assigned To Due Date
Risk1 214 6 Budget (13022025
Risk 2 33 W Acive 12 Budget
Risk3 21 n Acive 6 Scope
Risk4 21 * Acive [TE0
Link to the Risk
B [[CUE0ATE W Rad = Gverdus | - Amber = Missing and notclosed |
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9.6 Changes

The Changes tab provides a detailed overview of all changes in the project.

Project overview (1):

= Project Name

= Number of active Changes

= Number of overdue Changes
Visualization of changes:

= Bar chart by priority: Shows the distribution of Changes by priority level (2)

= Graphical representation of all Changes by type (3)

= Tabular list of all changes with the most important information and link to the Change (4)

Project - Changes A Home B Fomtelic [l Projea 0 Request g Resource ‘
2

Changes by Priori Changes by T

Project X " | Chansesty ty nges by Type

Active Changes Overdue Changes

1 1
L deraty

Change State Approval Age (Days) Impact Planned Start  Planned Finish

Change 2 Approved 1 Low

Change 3 Requested 1 High

Change 1 o Active Requested 19 Low 10.02.2025 03.03.2025
4 Link to the Change
Status Raport Timating Finamcials Efor: laruss Risks Aetions Duacisions Lessons Eanain

Objactives Requirerments Suakaheldar
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9.7 Actions
The Actions tab provides a detailed overview of all actions in the project.
Project overview (1):
= Project Name
= Number of active Actions
= Number of overdue Actions
Visualization of Actions:
= Bar chart by priority: Shows the distribution of Actions by priority level (2)
= Graphical representation of all Actions by status (3)

= Tabular list of all Actions with the most important information and a link to the Action (4)

Project - Actions A Home B rontolia [m] Project { mwauen  Fh Resource ‘
2

Briarity A "
Project X v Actions by Priority Actions by State
2 In Progress 3
In Progress Actions Owverdue Actions
1
Hig Medium 1

Action Related Task Name Age (Days) State Priority  Assigned To Due Date

Agtion 1 Review Project Requ... 214 % In Progress . High

Agtion 2 187 (O Not Started Medium PP Project Manager

Action 3 Review Project Requ... n7 | Defered Medium
4 Link to the Action
Status Regpon Timeine Financials iffor Iasaes Risks Changes Actions Decisions Lessons Benefis Cbjectives Requirements  Stkeholder
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9.8 Decisions
The Decisions tab provides a detailed overview of all decisions in the project.
Project overview (1):
= Project Name
= Number of active Decisions
= Number of overdue Decisions
Visualization of Decisions:
= Bar chart by priority: Shows the distribution of Decisions by priority level (2)
= Graphical representation of all Decisions by status (3)

= Tabular list of all decisions with the most important information and a link to the Decision (4)

Project - Decisions A Home B fortolio | [t] Projec § Reques Gk Ressurce ‘

Projact X o Decisions by Priority Decisions by State
Active Decisions Overdue Decisions
1
High Moderate Low

Decision Age [Days) State Priority Source Owmer Target Date

Becision 1 20 W Active Moderate Meeting  PPP Project Manager

Decision 2 1 == On Hold High Meeting  PPP Project Manager

Decision 3 n | Deferred Low Conversation PPP Project Manager
4 Link to the Decision
Suatus Report Timalne Financlals Effert I5ees Risks Changes. Actions m Leens Banafas Cejectives Reguirements Snakcahoider
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9.9 Lessons
The Lessons tab provides a detailed overview of all lessons learned in the project:
Project overview (1):
= Project Name
= Number of successful Lessons
= Number of problematic Lessons
Filter by rating:
= Use the slider to display only lessons with specific ratings. (2)
Visualization of Lessons Learned:
= Graphical representation of all lessons by knowledge area (3)

= Tabular list of all goals with the most important information and link to the lesson (4)

Project - Lessons & vome [ Fomtolio [l Propa O Requsr R Resourcs ‘

N Lessons by Rating Leszons by Knowledge Area
Project X b Rating " g "
4 | Success Lessons Problem Lessons H 5 3
3 2 O O
1 i 1
Lesson Type Deseription Knowledge Area Star Rating
Lesson 1 Success Communications Management 1 1 9 1
Lesson 2 Problem Risk Management
Leszon 3 Success Tirme Management
Lesson 4 Success Cost Management
Lesson § Problem Scope Management
4 Link to the Lesson
St Report Tienafing Financials Effon lsues Ry Changes Acting Decirigns Lessons Barates Ogectives Raquinemants Srakeholder
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9.10 Benefits

The Benefits tab provides a detailed overview of all benefits in the project.
Project overview (1):
= Project Name
= Visualization of the realized Benefits as a bar chart
Visualization of the Benefits:
= Bar chart: Comparison between realized Benefits and allocated Benefits (2)
= Graphical representation of all Benefits by status (3)

= Tabular list of all Benefits with the most important information and link to the Benefit (4)

Project - Benefits & Home B Forolio [l Project G Reasen g Resource ‘

2

Benefits by State
Mot Reakzed

Project X e || |#resized @ Avccated
1 € 25

Benefits Amount Realized

~€ 24K

@ L€ 1.95K Benefit Age (Days) Category Allocated  Realized Date Realized  Target Date

Benefit1 & Efficiency Gains €2,000 €1.200 14.08.2025
Benefit 2 8 Improves Customer Satisfaction
Benefit 3 8 Enables Network Integrity

€ 15K \ 4

Link to the Benefit
€ 1.05K

~€ 06K

€ 1,200

Stams Rapent Timaine Financisly Etfon [t Risks Changes Actions Decisions Lessons m Objactives Requintments  Stakeholder
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9.11 Objectives

The Objectives tab provides a detailed overview of all objectives in the project.

Project overview (1):

= Project Name

= Number of active Objective

= Number of postponed Objectives
Visualization of Objectives:

= Bar chart by priority: Shows the distribution of objectives by priority level (2)

= Graphical representation of all objectives by status (3)

= Tabular list of all objectives with the most important information and link to the objective (4)

#& Home 2 Portioli ] Projea 0 Request dh,  Resource ‘

Project - Objectives

Project X e Objectives by Priority Objectives by State
1 In Progress Objectives Deferred Objectives 3
1
High Moderate
Objective Age [Days) Owner Assigned To Type Priority State Description
Objective 1 12 PPP Project Manager  PPP Project Qutcome Moderate Completed
Manager
Objective 2 12 PPP Project Manager  PPP Project User  Process Low Not Started
Objective 3 12 PPP Project Manager  PPP Project Perfarmance Kigh In Progress
Manager
4 Link to the Objective
s Rapon Timaling Financials Effort lssuas Risis Changes Actions Dacisions. Lesions Barafics Raguiremenis Salahcider
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The Requirements tab provides a detailed overview of all requirements in the project.

Project overview (1):
= Project Name

= Number of open Requirements

= Number of Requirements in waiting status

Visualization of Requirements:

= Bar chart by type: Shows the distribution of Requirements by type (2)

= Graphical representation of all Requirements by status (3)

= Tabular list of all Requirements with the most important information and link to the Requirement

Project - Requirements [ = S O Ressen [ Resource ‘
Project X v Requirements by Type Requirement by State
1 Open Requirements. Waiting Requirements - - 3
2
Business User Functional - Inte.

Requirement Age (Days) Stakeholder StatelD State Effort Estimate Houwrly Rate Material Cost Tota

Feguirement 1 T ] Draft 12 €22

Requirement 2 T 2 Approved 16 €28

Requirement 3 7 3 Rejected €30

Link to the Requirement

Stauas Repent Timaing Finamsials Efor: Iszaes Risks Changes Astiong Cecisiens Lessons Benatas Otjectives Smakehalder
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9.13 Stakeholder
The Stakeholders tab provides a detailed overview of all stakeholders in the project.
Project overview (1):
= Project Name
Visualization of Stakeholders:
= Bar chart by role: Shows the distribution of Stakeholders by role in the project (2)

= Graphical representation by involvement and influence: Visualizes Stakeholders according to their

contribution and influence on the project (3)

= Tabular list of all Stakeholders with the most important information and link to the Stakeholder

(4)

Project - Stakeholders #  Home B Porfolio [l Project [ Request gy Resource ‘

Il P I
1 Project X - Stakeholder by Project Role
3
avobrement
Low
vehement
End User Executive Project Manager
Stakeholder Management Strategy Supporter Support Met Support Criteria
PPP Partfolio Manager Manage Closely Yes Yes
PP Project Manager Manage Closely Yes. Partial
PPP Project User Keep Satishied Yes ez
Link to the Stakeholder
Statuss Report Timaling Financials ENort Issoes Risks Changes Actians Dedisions Lessons Banafits Objactives Ragquiremaent
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10 Risks

On the Risks tab, you will find a tabular list of all risks and a risk matrix that visualizes risks based on

their likelihood and consequences.

The Risk Matrix is a useful tool for identifying and prioritizing risks. Each risk is positioned in the matrix

according to its likelihood and the severity of its potential consequences.
In this section, you will learn how to:

= Add Risks] 1]

Edit Risks|1_3ah
= Deactivate and Activate Risks@
= Read the Risk Matrix and set filtersm

= Use additional Commands for Risksm

10.1 Add Risks

To add a Risk, proceed as follows:

» Click on New Risk. » The Quick Create: Risk form for creating a risk opens.

All Risks ~ 0 Refresh o Flow

[l Risk Name + Assigned To ~ Exposure ~  Category v Due Date ~ State ~
] Risk2 12 Budget Active
] Risk 3 6 Scope Active
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Quick Create: Risk %
General
Risk Mame N
Project " Il Project X x D
Cwimer - cl PPP Project Manager (Offine = 2
Assigned To _ o
Category v
Due Date . =
Siate Active v
Exposure
Likelihood N |

0
Consequence * '

0
Cost -
Trigger - i)
Details
Description -

Mitigation Flan

Contingency Plan

Trigger Description

Save and Close . Cancel

> Fill out the form:

P To add a Risk, the mandatory fields must be filled out. All mandatory fields are marked with
a red star.
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= General:

= Risk Name: Enter a meaningful name for the Risk.

= Project: The current project is selected by default.

= Owner: Creator of the risk. The current user is entered by default.
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P You can select a different project or owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= Assigned To: Stakeholder to whom the Risk is assigned.

» Click in the input field, press the Enter key, and enter the desired stakeholder.

= Category:

» Click in the field and select the desired category from the drop-down menu.

Category --Selack--
Due Date ' --Select--
Scope
Siate
Schedule
Exposure Budget
Vendor
Likelinood & Crther
= Due Date:

» Click on the calendar icon and enter the due date.

Due Date -

State Februar 2025
So Mo Di M

Exposure 26 27 28 290
2 3 4 5

Likelihood g w0 o1 12
1w 17 18 19

Consequence q 8 A 5%
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= State:

» Click in the field and select the desired status from the drop-down menu.

State Active e
--Select--
Exposure
v Active
Likelihood - Postponed
Closed

= Exposure:
= Likelihood: Probability that the Risk will occur.
» Use the five-point slider (1 = minimum, 5 = maximum) to set the likelihood.
= Consequence: Severity of the impact if the Risk occurs.

» Use the five-point slider to determine the severity of the potential impact.

Cost: Enter an amount.
= Trigger:

» Click in the field and select the trigger from the drop-down menu.

Trigger --Select-- w
N -
Details seed
Date
Description Expasure over threshold

Tasks not completed

Other

= Details:
= Description, Mitigation Plan, Contingency Plan, Trigger Description:

» Enter meaningful descriptions in the appropriate fields.
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» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Risk.

Save & Create Mew

Save and Close -

P A Risk is added.

P The Risk appears in the All Risks table.

10.2 Edit Risks
A Risk can be edited as follows:

» Click on the preview in the Risk Name column. P The form for editing the Risk opens.

(] Risk Name ~ Assigned Tc

[] |Risk2

Or
» Click on the row of the desired Risk to select it. (1)

» Click on Edit. (2)

All Risks 2 D

(]  Risk Name ~ Assigned To ~ Exposure ~  Category ~ Due Date

1 Risk 2 12 Budget

» Enter the desired changes in the form.
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» Click Save & Close to save the changes and finish editing.

€ O E} Save ‘] Save & Close [E;. Deactivate ]ﬁ[ Delete |

Risk 2 - saved

Risk
General

Risk Name " Risk 2

Owner " @M PP Project Manager (Offline) X

P Only Risks with the status Active can be edited. Deactivated Risks are locked for editing.

10.3 Deactivate and Activate Risks

Risks are active by default. You can deactivate Risks:
> Select the Risk you want to deactivate.
» Click on the Risk row to highlight it. (1)

» Click on Deactivate. (2)

All Risks ~ & et O Acliva1e2 :

(@  Risk Name ~ Assigned To ~ Exposure ¥~ Category Due Date ~ State ~

1 Risk 2 12 Budget Active

» The Confirm Deactivation field opens.
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» Click Deactivate to deactivate the Risk.

Confirm Deactivation X

Do you want to deactivate the selected 1 Risk? You can reactivate it later, if you wish.

This action will change the status of the selected Risk to Inactive.

By default, all active and inactive Risks are listed in the table.
Display only inactive Risks:

» Go to All Risks.

» Click the down arrow.

» Click on Inactive Risks.
All Risks

System Views

Active Risks

Inactive Risks

My Active Risks

All Risks

Activate Risks:
» Select the Risk as described above.

» Click on Activate.

All Risks ~ 7 Edit [® Deactiy
£ Filter by key,

(@  Risk Name ~ Assigned To v Exposure ¥  Category ¥ Due Date ~ State v
Risk 2 12 Budget Active

» The Confirm Risk Activation field opens.
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» Click on Activate to activate the Risk.
Confirm Risk Activation X
Are you sure you want to activate the selected 1 Risk?
This will set the Risk to the Active state.
Activate Cancel

10.4 Risk Matrix

The Risks tab displays a Risk Matrix that shows the number of Risks per likelihood and consequence.

P The number is displayed as a white digit in the respective fields of the matrix.

Risk Matrix

Cansequence
[¥5)

ra

2 3 4 5

Likelihood

The exposure is calculated from the Likelihood and Consequence values. The following formula applies:

Exposure = Likelihood * Consequence (1)
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O

All Risks ~

Risk Name ~

Assigned To
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N S |
g |
I
=
Filter Risks by likelihood and consequence:

> Click on the corresponding field in the matrix (2).

P Only Risks with the selected combination of likelihood and consequence are displayed in the

table.

Remove filter:
» Click on the field in the matrix again (2).
Or

» Click on Clear Filter (3).

10.5 Additional Commands for Risks
Above the All Risks table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

ral

t  Mew Risk () Refresh

= Flow >
\ Run Report h
88 Excel Templates h
t B! Export Risks >

{ BE, See associated records

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 142 /271



>

THE PROJECT GROUP

P If you have selected a Risk, additional commands related to the selected Risk will appear in
the drop-down menu:
& Edit Activate

bJ

Deactivate

=

Delete Risk

»

Assign Risks

o

Share

&

Email a Link

Flow >

B %

Run Report >

&

Word Templates >

[ =]
przs)

Export to Excel

il

See associated records

» Select the desired command:

= Delete Risk: Permanently deletes the selected Risk.

/\ This action cannot be undone.

= Assign Risks: Changes the owner of the selected Risk.
= Share: Shares the Risk with selected individuals or teams without changing ownership.
= Email a Link: Sends a link to the selected Risk via email.

= flow: Runs a flow for the Risk.

= Run Report: Select a report to run.

= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot

table.

= See associated records: Shows records associated with this view.
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11 Issues

The Issues tab allows you to centrally record and manage project-related challenges or obstacles. This

feature helps project teams keep track of open issues, assign responsibilities, and document progress
in resolving issues.

In this section, you will learn how to:
= Add Issues] 1]
= Edit Issues] 14!
= Deactivate and Activate Issuesm

= Use additional Commands for Issues@

11.1 Add Issues

To add an Issue, proceed as follows:

» Click on New Issue. » The Quick Create: Issue form for creating an Issue opens.

Issue Name T ~ Assigned To ~ Priority ~ Category ~
Problem 2 @ #PP Project Manager (Offine)  Medium Schedule
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Quick Create: Issue %
General

Issue Name *

Project * =l Project X X o
Owner " @ PPP Project Manager (Offling) x 2
Status Active e
Assigned To . je
Discussion -

Category I w
Due Date _—
Priority Medium e
Resolution

Save and Close . Cancel

» Fill out the form:

P To add an Issue, the mandatory fields must be filled out. All mandatory fields are marked
with a red star.
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= General:
= /ssue Name: Enter a meaningful name for the Issue.
= Project: The current project is selected by default.

= Owner: Creator of the Issue. The current user is entered by default.

P You can select a different project or owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= Status:

» Click in the field and select the desired status from the drop-down menu.

Assigned To: Stakeholder to whom the risk is assigned.

» Click on the input field, press the Enter key, and enter the desired name.
= Dijscussion: Enter the discussion points for the Issue.

= Category:

» Click in the field and select the desired category from the drop-down menu.

Category —Salect—- e
Due Date " —-Select--
Scope
Priorit
riormy Schedule
Resolution Budget
Vendor
Other
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» Click on the calendar icon and enter the due date.

Due Date _

Priority Februar 2025
S0 Mo Di Mi

Resolution e a7 s oo
2 3 4 5
9 1w 1 12
16 17 18 19
23 24 25 28

= Priority:

14

21

28

Sa

13

22

» Click in the field and select the priority of the Issue from the drop-down menu.

= Resolution:
> Enter a description of the resolution.
» Click Save and Close.

Or

» Click the down arrow and Save & Create New to add another Issue.

Save & Create New

Save and Close -

P An Issue is added.

P The Issue appears in the Active Issues table.
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An Issue can be edited as follows:
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» Click on the preview in the Issue Name column. > The form for editing the Issue opens.

[ Issue Name T~

0[]

Or
» Click on the row of the desired Issue to select it. (1)

» Click on Edit. (2)

Active Issues ~

[ Issue Mame T+ Assigned To ~

1 B Poblem1

» Enter the desired changes in the form.

» Click Save & Close to save the changes and finish editing.

3 (7 B Save | @ Save & Close

Problem 1 - saved

Issue

General

lssue Mame BTl

Priority ~

High

[;!. Deactiv:

Assig

Category ¥

Vendor

P Only Issues with the status Active can be edited. Deactivated Issues are locked for editing.
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11.3 Deactivate and Activate Issues
Issues are active by default. You can deactivate Issues:
> Select the Issue you want to deactivate.
» Click on the Issue row to highlight it. (1)

» Click on Deactivate. (2)

®  issue Name T~ Assigned Ta Priority Category = State =

1 Problem 1 High Vendor Active

P The Confirm Deactivation field opens.

» Click Deactivate to deactivate the Issue.

Confirm Deactivation X

Do you want to deactivate the selected 1 Issue? You can reactivate it later, if you wish.

This action will change the status of the selected lssue to Inactive.

By default, all active and inactive Issues are listed in the table.
Display only inactive Issues:

» Go to Active Issues.

» Click the down arrow.

» Click on Inactive Issues.

Active Issues

System Views

Active |ssues

Inactive lssues

My Active lssues
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Activate Issues:
> Select the Issue as described above.
» Click on Activate.
Inactive Issues « & Edit G o

Issue Name T Assigned To ~ Priority ~ Category

Problem 1 High Vendor
P The Confirm Issue Activation field opens.
» Click on Activate to activate the Issue.

Confirm Issue Activation X

Are you sure you want to activate the selected 1 Issue?

This will set the Issue to the Active state.

11.4 Additional Commands for Issues
Above the Active Issues table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.
b New Issue {3 Refresh D

=* Flow

>
Run Report >
1 Excel Templates >

>

@ Export Issue

EE. See associated records
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P If you have selected an Issue, additional commands related to the selected Issue will appear
in the drop-down menu:

O Activate [& Deactivate

il Delete Issue
A,

Assign Issue

B

Share

&

Email a Link

Flow >

B %

Run Report >

B

Word Templates >

[ |
pra)

Export to Excel

il

See associated records

|G=e e

> Select the desired command:

= Delete Issue: Permanently deletes the selected Issue.

/\ This action cannot be undone.

= Assign Issue: Changes the owner of the selected Issue.
= Share: Shares the Issue with selected individuals or teams without changing ownership.
= Email a Link: Sends a link to the selected Issue via email.

= flow: Runs a flow for the Issue.

= Run Report: Select a report to run.

» Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot
table.

= See associated records: Shows records associated with this view.
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12 Changes

The Changes tab allows you to document and track planned or implemented adjustments within a
project. This feature enables project teams to record changes in a structured manner, assign

responsibilities, and manage the status of individual change requests transparently.
In this section, you will learn how to:

= Add Changes|1_52'1

= Edit ChangeslTssﬁ

= Deactivate and Activate Changes|1_5§|

= Use additional Commands for Changesm

12.1 Add Changes
To add a Change, proceed as follows:

» Click on New Change. » The Quick Create: Change form for creating a Change opens.

Active Changes o

[ Tite T+ Created On ~ Approval v Change Type v State v Assigned To ~ Priority ~

[0 Cchange Requested Scope Active @\ PP Project M. Moderate
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Quick Create: Change W
General

Title -

Project * Ml ProjectX ® gl
Deetails

Clwner * @ PPP Project Manager (Offlim x O
Requested By =
Aszigned To 2
Reguested Dats [
Change Typs o
Planned 5tart Cate Il
Planned End Date 5|
State o
Approval Mot Yet Requested w
Priority = wr
Risk Nona o
Impact o
Cost Impact

Additional Commants

Work Notes

Benafits

Change Plan

Backout Plan

e -

= Fill out the form:

P To add a Change, the mandatory fields must be filled out. All mandatory fields are marked
with a red star.
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= General:
= Title: Enter a meaningful title for the Change.
= Project: The current project is selected by default.
= Details:
> Enter a meaningful description of the Change.

= Owner: Creator of the Change. The current user is entered by default.

P You can select a different project and owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= Requested By: Stakeholder requesting the Change.

» Click on the input field, press the Enter key, and enter the desired name.
= Assigned To: Stakeholder to whom the Change is assigned.

» Click on the input field, press the Enter key, and enter the desired name.
= Requested Date, Planned Start Date, Planned End Date:

» Click on the calendar icon and enter the date.

Reguested Date —

Change Type Februar 2025 9

S50 Mo Di Mi Do Fr Sa
Planned Start Date ) i I

Planned End Date : !
9 10 11 12 13 14 15

State % 1w 18 19 20 21 22

Approval
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= Change Type:

» Click in the field and select the type of Change from the drop-down menu. .

Change Type --Select-- w
Planned Start Date v --Select--
Scope
Pl d End Dat
srnea Ena e Schedule
State Cost
MNone

= State:

» Click in the field and select the status from the drop-down menu.

State --Select-- ~
Approval v --Select--
Active
Priorit
rery Postponed
Risk Closed
= Approval:

> Click in the field and select the approval status from the drop-down menu.

Approval Mot Yet Requested v
Priority —Select--
+" Mot Yet Requested
Risk
IS Requestad
Impact Approved
Rejected

T mmie L m i
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= Priority:

> Click in the field and select the priority from the drop-down menu.

Priority --Select-- “
Risk v --Select--
Critical
| ct
mpa High
Cost Impact Moderate
Low

N Adimemal T s d e
= Risk:

» Click in the field and select the risk from the drop-down menu.

Risk None ~
Impact --Select--

Very High
Cost | ct
oe s High
Additional Comments Moderate

Low

+ Mone

= /mpact:

» Click in the field and select the impact from the drop-down menu..

Impact —Select-- w
Cost Impact v --Select--
High
Additional C t
itional Comments Medium
Low

= Cost Impact:

» Enter an amount.
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= Additional Comments, Work Notes, Benefits, Change Plan, Backout Plan, Test Plan:
» Enter meaningful descriptions in the appropriate fields. .
» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Change.

Save & Create Mew

Save and Close -

P A Change has been added.

P The Change appears in the Active Changes table.
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12.2 Edit Changes
A Change can be edited as follows:

» Click on the preview in the Title column. P The form for editing the Change opens.

Active Changes ~

(]  Title T+~

[] Change 1

Or
» Click on the row of the desired Change to select it. (1)

» Click on Edit. (2)

Active Changes ~ 2 0O A
(@) Title 7+ Created On ~ Approval ¥ Change Type ~ State ¥ Assigned To ~ Priority +
1 B Changel Requested Scope Active @ eepPoject . Moderal

» Enter the desired change in the form.

» Click Save & Close to save the changes and finish editing.

€ 7 = Save | @ Save & Close | [& De

Change 1 - saved
Change

General

Title Change 1
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P Only Changes with the status Active can be edited. Deactivated Changes are locked for
editing.

12.3 Deactivate and Activate Changes
Changes are active by default. You can deactivate Changes:
> Select the Change you want to deactivate.
» Click on the Change row to highlight it. (1)

» Click on Deactivate. (2)

2 5
m  Title T+ Created On » Approval ~ Change Type State v Assigned To ~ Priority ~ Cost Impact = Ir
1 Change 1 Requested Scope Active @ peEProject M. Moderate

P The Confirm Deactivation field opens.

» Click Deactivate to deactivate the Change.

Confirm Deactivation b

Do you want to deactivate the selected 1 Change? You can reactivate it later, if you wish.

This actien will change the status of the selected Change to Inactive.

Deactivate Cancel

By default, all active and inactive Changes are listed in the table.
Display only inactive changes:
> Go to Active Changes.

» Click the down arrow.
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» Click on Inactive Changes.

Active Changes

System Views

Active Changes

Inactive Changes

Activate Changes:
» Select the Change as described above.

» Click on Activate.

Inactive Changes ~ & Edit G o

Titke 7~ Created On ~ Approval ~ Change Type ~ State ~ Assigned To ~ Priority ~ <

Change 1 . Requested Scope Active @ eepPoieciMa.  Moderate

P The Confirm Change Activation field opens.

> Click on Activate to activate the change.

Confirm Change Activation X

Are you sure you want to activate the selected 1 Change?

This will set the Change to the Active state.

Activate Cancel

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 160/ 271



>

THE PROJECT GROUP

12.4 Additional Commands for Changes

Above the Active Changes table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

- New Change ) Refresh |:|

o/

P|

Flow >
Run Report >
Excel Templates >
Export Changes >

See associated records

P If you have selected a Change, additional commands related to the selected Change will
appear in the drop-down menu:

O  Activate [% Deactivate

» =

bt

!

&

Delete Change
Assign Changes
Share

Email a Link

2 B B %

il

Flow >
Run Report >
Word Templates >
Export to Excel

See associated records

» Select the desired command:

= Delete Change: Permanently deletes the selected Change.

/\ This action cannot be undone.

= Assign Changes: Changes the owner of the selected Change.

= Share: Shares the Change with selected individuals or teams without changing ownership.
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= Email a Link: Sends a link to the selected Change via email.
= Flow: Runs a flow for the Change.
= Run Report: Select a report to run.
» Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot

table.

= See associated records: Shows records associated with this view.
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13 Actions

You can assign actions to tasks in the TPG Scheduler. Actions are jobs that are linked to one or more

tasks.

A Kanban board is integrated to visualize and manage tasks within a project. This Kanban board can be
found on the Actions tab. In the following chapter, you will learn how to create, edit and manage

actions.

PPP

Project Details  Schedule  Board  Resource Plan  Financials  Status Update  StatusReport  Risks Issues Changes Actio.. Decisions Stakehokders Objectives Benefits Requirements  Lessons Leamed

Mot Started £ - n Progress n € v Completed € = Defemed € -t Waiting on someone else =

Action @ Action 1 Action 3

Kanban Board

13.1 Actions - current Project
On the Actions tab, you can create, edit and organize actions for the current project in a Kanban view.
The actions are grouped by state in columns. There are the following states:

= Not Started: The action has not yet been started.

® |n Progress: The action is being processed.

= Completed: The action has been completed.

= Deferred: The action is on hold.

= Waiting on someone else: The action must be processed by someone.
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Lo 11 2~ ]
-
Two filter options are available:
= Filter actions by assigned persons. (1)
= Actions by name and/or content. (2)
For better clarity, you can collapse or expand the columns:
» Select the column you want to collapse or expand.
» Click the arrow pointing left or right in the state column.
» The column will be collapsed or expanded.
Filter by Assigned To - ‘ Collapse In Progress
> In Progress (1) Completed
P
=
W Action 1
o
2 Start Date: 06.01.2025

i

b
)
=

Expand In Progress

> > > Deferred

Action 3

Task:

(L) paliels 10N
(1) ssauboid u|
(0) pe3z|dwo)
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P The Actions can be assigned to tasks in the TPG Scheduler (Schedule tab). How to show
columns is described under Task Attributes! s .

P The Schedule shows how many actions are assigned to the task and whether these actions

are open or completed.

+ Add Edit Deleta 2 °.0 . . = a8
B Hame % Complete  Start
1 - Project Start 23122024
2 ~ Phase - Initiation @ 23022024
3 8 + Create Project Request a3
28 + Review Project Request 06.01.2025
5 a + Igernify Risks @ 20012025
6 + Initiation Compieted @ 30.01.2025
7 “ Phasa 2 Planning O 31.012025
8 + Praiminary Panning 102025
9 + Detaded Planning O 07.022025
+ Financing -) 21022025
] « Planring Compisted aY  zozans

B, 4

Firish

23922024

30.01.2025

27.02.2035

06022025

20.02.2025

27022025

27022025

Example: 2 actions are assigned to a task

open.

Actual Hours Actions

Duration

0 days

29 days

0 days

Predecesson

Sdays 4

0 days

20 days

5 days

3

-] Features = Baseline

Assigned Resources

+ Esportyimport

Key Milestane Effort

0 hours

160 hours

8 hours

80 howrs

72 hours

Custorner 0 hours

245 hours

& hours

85 hours

& hours

Ohours

Actual Hours  Actions

. One of these actions has already been completed and one is

1 open, 1 complete

13.1.1 Create Actions

There are two ways to create an action:

» Click on the three dots on the right-hand side of the state column. » A drop-down menu opens.
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» Click on Add item.
Not Started <[]

+ Add item

Action 1

Or
» Click on the plus symbol in the state column below. (1)
P A new action is created and appears in the state column.

P The number of actions in the state column is updated automatically. (2)

Mot Started 2 E 4

Action 1

Action 2

1 [
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13.1.2 Edit Actions
You can edit actions in the Kanban view. Information about the action is displayed in the Kanban view:
= Name of the action (1)
= Progress of the action (2)
= Open tasks within the action (3)
= Completed tasks within the action (4)

= Priority (5)

[hction1] | 2

Change the name of the action:
When you create a new action, the name is New item by default.
» Double-click on New item. P> A text field appears.
» Enter the name for the action.
P The action is renamed.
Edit action in the form:
» Double-click on the action.
Or
» Right-click on the action. P> A drop-down menu opens.

» Click on Edit item.
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P The form for editing the action opens.

Action 1

) Task 2

) Task 3

~ # Edit item

Resources >

+ Change column >

Remove item

Fill in the following fields:

Title: Name of the action
» Click in the text field to edit the name of the action.
Project: Project to which the action is assigned.

» Click on the search icon (magnifying glass) in the text field to select another project in the drop-

down menu to which you want to assign the action.
Owner: Person who created the action.

» Click on the search icon (magnifying glass) in the text field to select another owner from the

drop-down menu.
Assigned To: Person to whom the action is assigned.

» Click on the search icon (magnifying glass) in the text field to select a person in the drop-down

menu to whom the action is to be assigned.
%Completed: Progress bar of the action. The progress is shown as a percentage.

» Click on the slider and, holding down the mouse button, move it to the desired position to

change the progress.
Description: Description of the action.
» Click in the text field and enter the description.

Priority: Priority of the task.
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» Click on the arrow in the text field. » A drop-down menu opens.

» Click on High, Medium or Low.

Priceity High
Due Date select
o Hagh
Shart Date [P
Tk e
= Due Date:

> Click in the text field. P The calendar opens.

» Select the due date of the action.
= Start Date:

» Click in the text field. » The calendar opens.

» Select the start date of the action.
= Task: Assign a task to the action.

» Click in the text field. » A drop-down menu opens.

» Click on the task that you would like to assign to the action.
= State: State of the action

» Click in the text field. » A drop-down menu opens.

» Click on the state of the action.

Stabe In Frogress

Tecdod Salect
Mot Slared

= Ini Progress
Completed

Daderred

Waiting on sameans ehie

= Todos: Tasks within the action.
> Click on Add an item. (1) P> A text field appears.
» Enter the name of the task and confirm with the Enter key.

» Click on the delete icon (2) to delete a task.
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» Click in the circle (3) to mark the task as completed.
» Click on the 6 dots (4) to change the order of the tasks using drag & drop.
Todos 3 H—‘[-
P 5 Task 2
47" Ofrddanitem] 1 2
» Click on Save or Save and Close to complete the editing of the action.
Action XY B X
2 [:} Save ‘] Save & Close [g Deactivate ]ﬂ[ Delete O Refresh [ Share ~
Action XY - saved
Action ltem
General
Title Action XY
Project I*| Project XY x o,
Owner " @ Gabi Gantt (Available) X Jol
Assigned To - L0
% Complete ] '
100 %
Description L
Priority Medium ~
Due Date dd/MM/yyyy
State Completed v
Task . po
Start Date dd/MM/yyyy
Todos @ TFaskt
() Task 2
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13.1.3 Delete or move Actions

In the Kanban board on the Action tab, you can delete actions and move actions to another column to

assign them a different state. (see Actions - current Project@)
Delete action:

» Select the action you want to delete.

» Right-click on the action. » A drop-down menu opens.

» Click on Remove item.

Action 1

Start Date: 06.01.2025
O Task 2

ry

Edit item

Resources >

+ Change column >

Remove item

]

Move actions:
> Select the action you want to move.
» Right-click on the action. A drop-down menu opens.
» Go to Change Column.
» Click on the desired state.

Action 1

QO Task 2

| = # Edit item
a Resources 7
B Not Started
W Remove item n Progress
B Completed
B Deferred
B Waiting on someone else
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In this section, you will learn how to display and manage actions from multiple projects. This function

allows you to obtain a comprehensive overview of all assigned actions and their states. Another

Kanban board is integrated in PPP for this purpose, which displays actions across projects.

» Click on Actions in the navigation bar. P> By default, all active action items are displayed on the

Kanban board.

i = — TPG Scheculer £ Seaech
B3 Read Only Grid () Show Chart New T Deleta ) Reresh o Visualize ths view 0 Email a Link B Flow [l fun Report ] Excel Temgiates EE=n
O v | e pctoniens ]1
D 2 3
. 5 [[5varty s | |6 4
~ [ ot Started G In Progress { = Completed 3 = Deferred n g - Waiting on somecne else @ =
# Daushboard A~ PPP Implemennaton 12}
R S e e
4 Progect Requests
B Portfobos + + + A
- A Project X (3)
Agtion 2 Action 1 Action §
o
B Resource Plans
P A Py
@ Approvals Action XY
[ .
There are options available to you to customize the view:
= Selection menu of displayed Actions (1):
» Click on the down arrow. P> A drop-down menu opens.
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> Click on the desired display option.

Active Action ltems

O Search views M
s

~ Active Action ltems Default
Active Project Actions ltems
Inactive Action ltems -
My Action ltems
My Action Items by Due Date

My Tasks

= Ianage and share views

= Edit columns (2): Add columns and change the order of the columns using drag & drop.

» Click on Edit columns. (2) » A form opens.
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» Click on Add columns and select the columns you want to add.

Edit columns: Action Items *

—f— Add columns

BE B U

m

a [

g

BE B &

State

Project

Tithe

Description

Priority

Due Date

% Complete

Start Date

Assigned To

Weight

Todos
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» Click on the column you want to move and drag the column to the desired position while

holding down the mouse button.

» Click on the 3 dots in the column and select Remove from the drop-down menu to delete a

column.

HE

» Click Reset to default to restore the default settings.

Project

Title

Description

l] Remove

T~ Move up

J» Move down

» Click on Apply to apply the changes to the view.

= Edit filters (3): Filter options for displayed action items.
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» Click on Add. » A drop-down menu opens.
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> In the drop-down menu, select whether you want to add a row, a group or a related entity.

Edit filters: Action [tems

I' 1 Reset 1o celadh " Dwlete all Tihers I

Fiaid

|:| Related entity

Propect (Propicis)

Fiiedcd

[ | s vaeiamn

-+ Add

=+ Add
:f Al ey

= Add groue

EE Add related entity

Operator

Operatos

Coriains data

Oiparatcs

Does net equal

Valug

Actve

Valus

s

> Set the attributes according to which the action items are to be filtered.

> Click on the three dots next to the filter and click on Delete to delete a filter.

Fiasld
:I Status

[] Related entity
Propect (Fropecti]

Fiaeled

[ | s ariant

Oparator

Equals

Oparator

Contairs data

Operator

Does nat egua

» Click on Delete all filters to delete all filters.

Waluie

Waluig

L x I [E Dehere I

> Click Reset to default to restore the default settings.

» Click on Apply. P> Only the action items to which the desired filters apply are displayed.

= Filter by keyword (4):

» Click on the Filter by keyword field.
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» Enter the keyword you want to filter by.
» Click on the cross in the Filter by keyword field to delete the filter.
P The action items in which the keyword occurs are displayed.

= Filter by Assigned To (5): Filter action items across projects according to the users to whom they

are assigned.
> Click on the Filter by Assigned To field. » A drop-down menu opens.
> Select the user whose assigned action items you want to display in the overview.

= Swimlanes selected (6): Display action items of a project in rows (swimlanes) below each other on

the Kanban board. (see Actions - show across projectsm)
» Click on the swimlanes selected field. » A drop-down menu opens.

> Select the projects that you want to display on the Kanban board.

| 3 swimlanes selected -

PPP Implementation
D Project A
- [ ] Project c2 -
Project X
[ ] Projekt B2
Projekt XY
[ ] Projekt xv2

[ ] Upgrade DO 3000 to 3500
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13.2.1 Actions - show across projects

The action items from multiple projects are displayed in swimlanes on the Kanban board, giving you a

clear and structured overview of all actions and their states.
Swimlane = line in which all action items of a project are displayed.

This display makes it easier to manage and prioritize actions across different projects:

Active Action Items
Number of all action items in the column

3 pwirnlands sebected

Completed € = Defered 1 € = Waiting onsomeone else & -

Mot Started 2 € = InProgress [m] < -

[™™ W PPPImplementation (2
= A roject o] —— Number of all action items in the Swimlane/Project

Astion 2 Action 1

Swimlanes=—

— A Projeka XY (1)

Action XY

For a better clarity, you can expand and collapse the action items of a swimlane:

» Click on the arrow pointing up on the left of the project name. P The action items are collapsed.

Collapse Project X plementation (2)

Project X (3)

Action 2

Description for Action 2

Or
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» Click on the arrow pointing down on the left of the project name. P The action items are
expanded.

Expand PPP Implementation 2 € -

[3 1PPP Implementation (2)

P You can also expand and collapse the columns. (see Action - current Projectm)

13.2.2 Actions - create and edit across projects
Creating actions in the cross-project Kanban board:
There are two ways to create an action in the cross-project Kanban board:

» Go to the state column to which you want to add an action.

» Click on the three dots on the right-hand side of the state column. » A drop-down menu opens.

» Click on Add item.

P The action is inserted into the first swimlane. You can move the action to another swimlane

via drag & drop, thereby assigning it to a different project. (see Actions - delete and move
across projectsm)
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Not Started ) | ==

A\ PPP Implementation (7 + Additem

Workpackage 1

Add itemn

Or
> Select the project to which you want to add an action and go to the project's swimlane.

» Click on the plus symbol in the state column.

P A new action is created and appears in the state column and swimlane of the desired project.

Edit actions in the cross-project Kanban board:

You can edit the actions in the cross-project view. To do so, proceed as described in Edit Actions/e7.

13.2.3 Actions - delete and move across projects

In the Kanban board for cross-project actions, you can assign actions to a different state or project and

delete actions.
Delete action:

> Select the action you want to delete.

» Right-click on the action. P A drop-down menu opens.
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» Click on Remove item.

 Project X (3)

Action 2 Action 1
Description for Action 2 Start Date: ¢
# Edit item H
& Resources ?
- #+ Change column >

1 cChange swimlane »

v Projekt XY (1)
; 4 W Remove item

Move actions:

There are several options for moving actions. The actions can be moved within a column and a

swimlane or to other columns and swimlanes.

> Select the actions you want to move.

> Move the action to the desired column and swimlane using drag & drop.
Or

» Right-click on the action. » A drop-down menu opens.

» Go to Change column.

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 180/ 271



>

THE PROJECT GROUP

» Click on the desired column.

A Project X (3)
Action 2 (pu] Action 1
Description for Action 2 Start Date: 06.01.2025
‘Medium () Item 3
S # Edititem
& Resources >
+ B Mot Started
$ Change swimlane > B InProgress
A Projekt XY (1)
W Remove item | ® completed
Action XY | @ peferred
O Task1 B Waiting on someone else

Or
> Right-click on the action. A drop-down menu opens.
> Go to Change swimlane.

> Click on the desired swimlane.

A Project X (3)
Action 2 f,l Action 1
Description for Action 2 Start Ciate 06.01.2005
: ) Hem 3 B PPP Iimplementation
# Edititem |
‘| W Projecta
& Resources >
@ Projectc2
+ ++ Changecolumn >
|:| -
. Projekt XY (1) B Frojekt B2
B Remove item N il
B Projekt XY
Action XY
W Projekt XY2
(O Task1
B Upgrade DO 3000 to 3500
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14 Decisions

On the Decisions tab, you can document decisions made during the course of a project. This feature
supports traceability and transparency throughout the project by consolidating all relevant information

about decisions in one place.
In this section, you will learn how to:
= Add Decisions/ 1]
= Edit Decisions 1l
= Deactivate and Activate Decisions|1_sh

= Use additional Commands for Decisions@

14.1 Add Decisions
To add a Decision, proceed as follows:

» Click on New Decision. » The Quick Create: Decision form for creating a Decision opens.

Active Decisions ©) Refresh

[0 Decsion T+ Category ~ Priority © State ~ Target Date ~

[J Dedsion 1 Moderate Active
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Quick Create: Decision %
General
Decision "
Project * =l ProjectX X L
Impact
Details
Pricrity N
Source o
State o
Cwner * i i

@j PPP Project Manager (Offling x 2
Approval

Approved Date - E)

Executive Reporting @ No

Category - s
Target Date B

Resulting Actions

Save and Close . Cancel

= Fill out the form:

P To add a Decision, the mandatory fields must be filled out. All mandatory fields are marked
with a red star.
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= General:
= Decision: Enter a meaningful name for the Decision.
= Project: The current project is selected by default.
® Impact, Details:
> Enter a meaningful description of the impact and details of the Decision.
= Priority:

» Click in the field and select the priority from the drop-down menu.

Priority —Select-- w
Source v --Select--
Critical
State .
High
Owner * Moderate
Low
= Source:

» Click in the field and select the source from the drop-down menu.

Source --Select-- =
State v --Select--

Meeting
Cwner 3

Conversation

Approval self

= State:

» Click in the field and select the status from the drop-down menu.

State --Select-- o
Owner « " --Select--
Not Started
Approval Active
On Hold
Approved Date
Deferred
Executive Reporting Completed
Rejected

Category

= Owner: Creator of the Decision. By default, the current user is entered.
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P You can select a different project and owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= Approval:
= Approved Date:

» Click on the calendar icon and enter the approved date.

Approved Date

Executive Reporting Februar 2025
S0 Mo Di Mi Do Fr Sa
Category V
26 27 28 29 30 31 1
Target Date 2 3 4 5 & 7 %

Resulting Actions 16 17 18 19 20 21 22

23 24 25 % 27 I8

= Executive Reporting: Create a report for management. No is selected by default..
» Click on the slider to select Yes.
= Category:

» Click in the field and select the category from the drop-down menu.

Category --Select-- w

Target Date v --Select--

Project

Resulting Actions Technical

Functional
Process
Cther
= Target Date:
» Click on the calendar icon and enter the target date.

= Resulting Actions:

» Enter a meaningful description of the resulting action.
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» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Decision.

Save & Create Mew

Save and Close -

P A Decision has been added.

P The Decision appears in the Active Decisions table.

14.2 Edit Decisions
A Decision can be edited as follows:

» Click on the preview in the Decision column. P The form for editing the Decision opens.

Active Decisions ~

[] Decision T+

[] Decision 1

Or
» Click on the row of the desired Decision to select it. (1)

> Click on Edit. (2)

Active Decisions 2 G
Ii\ Decision T+ Category v Priority v State v Tan
1 Decision 1 Moderate Active

» Enter the desired changes in the form.

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 186 /271



» Click Save & Close to save the Decision and finish editing.

>

THE PROJECT GROUP

3 9 B Save | @ Save & Close | [ Deactivate

Decision 1 - saved

Decision

General

- . * - .
Decision Decision 1

P Only Decisions with the status Active can be edited. Deactivated Decisions are locked for

editing.

14.3 Deactivate and Activate Decisions
Decisions are active by default. You can deactivate Decisions:
> Select the Decision you want to deactivate.
» Click on the Decision row to highlight it. (1)

» Click on Deactivate. (2)

Active Decisions +

Catagory Priority ~ State =

Moderate Active

P The Confirm Deactivation field opens.
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» Click Deactivate to deactivate the Decision.

Confirm Deactivation X

Do you want to deactivate the selected 1 Decision? You can reactivate it later, if you wish,

This action will change the status of the selected Decision to Inactive.

By default, all active and inactive Decisions are listed in the table.
Display only inactive Decisions:

» Go to Active Decisions.

» Click the down arrow.

» Click on Inactive Decisions.

Active Decisions

System Views

Active Decisions

Inactive Decisions

Activate Decisions:
» Select the Decision as described above.

» Click on Activate.

Inactive Decisions ~ & Edit ()
B  Decsion T+ Category ~ Priority ~ State ~ Target Date ~
Decision 1 Moderate Active

» The Confirm Decision Activation field opens.
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» Click on Activate to activate the Decision.

Confirm Decision Activation X

Are you sure you want to activate the selected 1 Decision?

This will set the Decision to the Active state,

Activate Cancel

14.4 Additional Commands for Decisions
Above the Active Decisions table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

- New Decision () Refresh El

=  Flow >
Run Report >
B85 Excel Templates >
B Export Decisions >

B8, See associated records
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P If you have selected a Decision, additional commands related to the selected Decision will
appear in the drop-down menu:

0O Activate [ Deactivate

=

Delete Decision

>

Assign Decisions

S

Share

&

Email a Link

Flow >

B %

Run Report >

&

Word Templates >

=]
fe

Export to Excel

;

See associated records

» Select the desired command:

= Delete Decision: Permanently deletes the selected Decision.

/\ This action cannot be undone.

= Assign Decisions: Changes the owner of the selected Decision.
= Share: Shares the Decision with selected individuals or teams without changing ownership.
= Email a Link: Sends a link to the selected Decision via email.

= Flow: Runs a flow for the Decision.

= Run Report: Select a report to run.

= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot
table.

= See associated records: Shows records associated with this view.
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15 Stakeholders

On the Stakeholders tab, you can enter information about project participants. This allows you to keep

track of the roles, influences, and involvement of your stakeholders.
In this section, you will learn how to:

= Add Stakeholders! 1l

= Edit Stakeholders/ 1os]

= Deactivate and Activate Stakeholders/ 1)

= Use additional Commands for Stakeholders|1_g7'1

15.1 Add Stakeholders

To add a Stakeholder, proceed as follows:

» Click on New Stakeholder. » The Quick Create: Stakeholder form for creating a Stakeholder

opens.
[] Stakeholder Name Project Role ~ Organization Member ~  Influence ~ Involvem... ~  Supporter - Suppert Criteria - Support C
PPP Project User End User Yes Lew High Yes Yes
TPG PPP - Scheduler User Guide 2.16 EN
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Quick Create: Stakeholder %
General

Organization Member () Yes

Stakeholder User M 0
Project * = Project X % jo.
Praoject Role i R

Influence @ Low

Involvement @ Low

Supporter - v

Support Criteria Met - v

Support Criteria

Save and Close . Cancel

= Fill out the form:

P To add a Stakeholder, the mandatory fields must be filled out. All mandatory fields are
marked with a red star.
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= General:
= Organization Member: Stakeholder is a member of the organization. Yes is selected by default.
» Click on the slider to select No.
= Stakeholder User:
» Click on the input field, then press the Enter key and enter the desired Stakeholder User.
= Project: The current project is selected by default.
= Project Role:

» Click in the field and select the role from the drop-down menu.

Froject Role --Select-- "
Influence V' --Select--
Executive
Involvement
Sponsor
Supporter Froject Manager

Fesource Manager
Support Criteria Met

End User

Support Criteria Client

Vendor

= Influence: Influence of the Stakeholder on the project. Low is selected by default..
» Click on the slider to select High.

= /nvolvement: Involvement of the Stakeholder in the project. Low is selected by default.
> Click on the slider to select High.

= Supporter: Support of the Stakeholder in the project.
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» Click in the field and select the supporter from the drop-down menu.
Supporter --Select-- S
Support Criteria Met v —-Select--
Mo
5 rt Criteri
upport Criteria Ves
Indifferent
= Support Criteria Met:
» Click in the field and select an option from the drop-down menu..
Support Criteria Met —_Salect-- o
Support Criteria v --Select--
Mo
Yes
Partial

= Support Criteria:
» Enter a meaningful description of the support criteria.
» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Stakeholder.

Save & Create Mew

Save and Close -

P A Stakeholder is added.

P The stakeholder appears in the All Stakeholders table.
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15.2 Edit Stakeholders

A Stakeholder can be edited as follows:

» Click on the preview in the Stakeholder Name column. P The form for editing the Stakeholder

opens.

All Stakeholders -

] Stakeholder Name ~
] PPP Project User

Or

» Click on the row of the desired Stakeholder to select it. (1)

» Click on Edit. (2)

All Stakeholders « 2 O Activat

@]  Stakeholder Name ~ Project Role Organization Member ~ Influence ~ Involvem... ~  Supporter ~ Support Criteria ~ Support C

1 PPP Project User End User Yes Low High Yes Yes

> Enter the desired changes in the form.

» Click Save & Close to save the Stakeholder and finish editing.

€ [ E Save | @ Save & Close | [& Dea

1001 - saved

Stakeholder

General

Organization Member m Yes

Stakeholder User * @ PeP Project User (Offline)

P Only Stakeholder with the status Active can be edited. Deactivated Stakeholders are locked
for editing.
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15.3 Deactivate and Activate Stakeholders
Stakeholders are active by default. You can deactivate Stakeholders:
» Select the Stakeholder you want to deactivate.
» Click on the Stakeholder row to highlight it. (1)
» Click on Deactivate. (2)
All Stakeholders # Edt [ Activate
2
(W Stakeholder Name ~ Project Role ~ Organization Member ~  Influence ~ Involver... ¥ Supporter ~ Support Criteria ~ Support Criteria Met =~ Manage
1 PPP Project User End User Yes Low High Yes Yes Keep Sa
P The Confirm Deactivation field opens.
» Click Deactivate to deactivate the Stakeholder.
Confirm Deactivation X

Do you want to deactivate the selected 1 Stakeholder? You can reactivate it later. if you
wish,

This action will change the status of the selected Stakeholder to Inactive,

By default, all active and inactive Stakeholders are listed in the table.
Display only inactive Stakeholders:

» Go to All Stakeholders.

» Click the down arrow.

> Click on Inactive Stakeholders.

All Stakeholders

System Views

All Stakeholders

Inactive Stakeholders
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Activate Stakeholders:
» Select the Stakeholder as described above.

» Click on Activate.

Stakeholder User = Project Role ~ Orgarization M... ~  Influence ~ Involvement = Support Criteria~  Support Criteri
(@ £eP Project User (Offine) End User Yes Low High Yes

P The Confirm Stakeholder Activation field opens.

» Click on Activate to activate the Stakeholder.

Confirm Stakeholder Activation X

Are you sure you want to activate the selected 1 Stakeholder?

This will set the Stakeholder to the Active state.

Activate Cancel

15.4 Additional Commands for Stakeholders
Above the All Stakeholders table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

- New Stakeholder ) Refresh D

= Flow

| Run Report >
85 Excel Templates >
B  Export Stakeholders >

B8 See associated records
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P If you have selected a Stakeholder, additional commands related to the selected Stakeholder
will appear in the drop-down menu:

B Activate [ Deactivate

il Delete Stakeholder

A, Assign Stakeholders

it

Share

&

Email a Link

Flow >

B %

Run Report >

&

Word Templates >

[ =1
f3

Export to Excel

&0

See associated records

» Select the desired command:

= Delete Stakeholder: Permanently deletes the selected Stakeholder.

/\ This action cannot be undone.

= Assign Stakeholders: Changes the owner of the selected Stakeholder.
= Share: Shares the Stakeholder with selected individuals or teams without changing ownership.
= Email a Link: Sends a link to the selected Stakeholder via email.

= Flow: Runs a flow for the Stakeholder.

= Run Report: Select a report to run.

= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot
table.

= See associated records: Shows records associated with this view.
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16 Objectives

On the Objectives tab, you can enter structured project-related Objectives.
This section describes how to:

= Add Objectivesm

= Edit Objectives@

= Deactivate and Activate Objectiveslz_oh

= Use additional Commands for Objectiveslz_oﬁ

16.1 Add Objectives
To add an Objective, proceed as follows:

» Click on New Objective. » The Quick Create: Objective form for creating an Objective opens.

etve Oectives o
[[] Objective Title T ~ Objective Description ~ Priority v Created On ~ Assigned To ~
[0 Objective 1 Moderate 24.07.2025 14:44 @ FPP Project Man
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Quick Create: Objective X
General

Objective Title *

Project * =l Project X x jol
Owner " @ PPP Project Manager (Offline) x 2

Objective Description

Priority - A
Assigned To - je
Objective Status . ~
Objective Type . ~

Save and Close . Cancel

= Fill out the form:

P To add an Objective, the mandatory fields must be filled out. All mandatory fields are
marked with a red star.
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= General:
= Objective Title: Enter a meaningful name for the Objective.
= Project: The current project is selected by default.

= Owner: Creator of the Objective. The current user is entered by default.

P You can select a different project and owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= QObjective Description:
> Enter meaningful descriptions in the field.
= Priority:

» Click in the field and select the priority from the drop-down menu..

Priority --Select-- v
Assigned To v/ —Select--
Critical
Objective Stat
jective Status High
Objective Type Moderate
Low

= Assigned To: Stakeholder to whom the Objective is assigned.
> Click on the input field, then press the Enter key and enter the desired stakeholder.
= Objective Status:

» Click in the field and select the status from the drop-down menu.

Objective Status —Select-- g

Objective Type v/ —Select--
Mot Started
In Progress

Completed

Deferred
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= Objective Type:
» Click in the field and select the type from the drop-down menu.

Objective Type —-Select-- v

v --Select--
Outcome
Performance

Process

» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Objective.

Save & Create Mew

Save and Close -

P A Objective is added.

» The Objective appears in the Active Objectives table.
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16.2 Edit Objectives

An Objective can be edited as follows:

» Click on the preview in the Objective Title column. P The form for editing the Objective opens.

Active Objectives

[] Objective Title T~

] | Objective 1

Or

» Click on the row of the desired Objective to select it. (1)

» Click on Edit. (2)
2[2 e | o aana

Active Objectives

(@  Objective Title T~ Objective Description ~ Priority ~ Created On ~ Assigned To ~
1 B Objective 1 Moderate @ £22 Project Mar

» Enter the desired changes in the form.

» Click Save & Close to save the Objective and finish editing.

€ 3 E Save | EP Save & Close | [ Deactivat

Objective 1 - saved

Objective

General

Objective Title * Objective 1

Owner * @\ PRP Project Manager (Offline)

P Only Objectives with the status Active can be edited. Deactivated Objectives are locked for

editing.

TPG PPP - Scheduler User Guide 2.16 EN

© The Project Group GmbH | All rights reserved 203 /271



>

THE PROJECT GROUP

16.3 Deactivate and Activate Objectives
Objectives are active by default. You can deactivate Objectives:
> Select the Objective you want to deactivate.
» Click on the Objective row to highlight it. (1)

» Click on Deactivate. (2)

Active Objectives

@]  Objective Title T~ Objective Description Priority Created On ~ Assigned To ~ Objective State Obj

1 Objgctive 1 Moderate @ eeeProject Man..  Completed oy

» The Confirm Deactivation field opens.

» Click Deactivate to deactivate the Objective.

Confirm Deactivation X

Do you want to deactivate the selected 1 Objective? You can reactivate it later, if you

wish.

This action will change the status of the selected Objective to Inactive,

By default, all active and inactive Objectives are listed in the table.
Display only inactive Objectives:

> Go to Active Objectives.

» Click the down arrow.

» Click on Inactive Objectives.

Active Objectives

System Views

Active Objectives

Inactive Objectives
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Activate Objectives:
> Select the Objective as described above.
» Click on Activate.
Inactive Objectives ~ Z  Edit [

B Objective Title T~ Priority ~ Assigned To ~ Objective Type Objective State ~

Objective 1 Moderate @ppaprgjecwanager. Qutcome Completed
P The Confirm Objective Activation field opens.
» Click on Activate to activate the Objective.

Confirm Objective Activation X

Are you sure you want to activate the selected 1 Objective?

This will set the Objective to the Active state.

16.4 Additional Commands for Objectives
Above the Active Objektives table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

t New Objective ) Refresh

=" Flow >

Run Report b3
ect

88 Excel Templates b3

B! Export Objectives >

B, See associated records
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P If you have selected an Objective, additional commands related to the selected Objective will
appear in the drop-down menu:

O  Activate [3 Deactivate

il Delete Objective
A,

Assign Objectives

S

Share

&

Email a Link

Flow >

B %

Run Report >

B

Word Templates >

=
pra)

Export to Excel

il

See associated records

» Select the desired command:

= Delete Objective: Permanently deletes the selected Objective.

/\ This action cannot be undone.

= Assign Objectives: Changes the owner of the selected Objective.
= Share: Shares the Objective with selected individuals or teams without changing ownership.
= Email a Link: Sends a link to the selected Objective via email.

= Flow: Runs a flow for the Objective.

= Run Report: Select a report to run.

= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot
table.

= See associated records: Shows records associated with this view.
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17 Benefits

The Benefits tab is used for the systematic recording and ongoing tracking of the added value targeted
in the project.

This section describes how to:
= Add Benefits| 2l
= Edit Benefits| 2l
= Deactivate and Activate Benefits|zis]

= Use additional Commands for Benefitsm

17.1 Add Benefits

To add a Benefit, proceed as follows:

» Click on New Benefit. » The Quick Create: Benefit form for creating a Benefit opens.

Active Benefits ~ = New Benefit
EI Title T~ Benefit Amount v Benefit A... ~ Benefit O... v Benefit Ty... v Benefit C... ~ Measure... ~ Measure... ~  Benefit St...
[0 Benefit1 2.000.00 € 1.20000€ (@M PPP Projec..  Financial Efficiency..  wochentlich Docume..
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Quick Create: Benefit %
General

Title * -

Project " =l ProjectX X L
Owner : % PPP Project Manager (Offline x O
Benefit Owner 0
Description

Benefit Type v

Measurement Frequency

Measurement Process
Benefit State o
Benefit Categaory V
Benefit Amount

Benefit Target -

Benefit Target Date =)
Baseline Data Date E)

Benefit Amount Realized

Save and Close . Cancel

= Fill out the form:

P To add a Benefit, the mandatory fields must be filled out. All mandatory fields are marked
with a red star.
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= General:
= Title: Enter a meaningful name for the Benefit.
= Project: The current project is selected by default.

= Owner: Creator of the Benefit. The current user is entered by default.

P You can select a different project and owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= Benefit Owner:
» Click on the input field, then press the Enter key and enter the responsible person.
= Description:
> Enter a meaningful description of the Benefit.
= Benefit Type:

» Click in the field and select the Benefit Type from the drop-down menu.

Benefit Type _select-- y
Measurement Frequency v --Select--

Financial

Mon-Financial

= Measurement Frequency:
» Enter the measurement frequency.
= Measurement Process:

» Enter the measurement process.
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= Benefit State:

» Click in the field and select the status from the drop-down menu.

Benefit State Select- 9
Benefit Category v --Select--
Documentad
Benefit Amount
On Track
Benefit Target Partial
Realized
Mot Realized

Benefit Target Date

= Benefit Category:

» Click in the field and select the category from the drop-down menu.

Benefit Category --Selact-- "
Benefit Amount v --Select--
Efficiency Gains
Benefit Target .
Enables Digital Strategy
Enables Network Integrity
Benefit Target Date Improves Customer Satisfaction

] Supports Customer Growth
Baseline Data Date

= Benefit Amount:
» Enter the amount.
= Benefit Target:

> Enter a meaningful description.
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= Benefit Target Date, Baseline Data Date, Benefit Realized Date:

» Click on the calendar icon and enter the date.

Benefit Target Date

Baseline Data Date Februar 2025 i : =)
Benefit Amount Realized

Benefit Realized Date )
9 10 11 12 13 14 15

23 24 25 26 27 28 1  ancel

= Benefit Amount Realized:
» Enter the amount.
» Click Save and Close.
Or

> Click the down arrow and Save & Create New to add another Benefit.

Save & Create New

Save and Close -

P A Benefit is added.

P The Benefit appears in the Active Benefits table.
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17.2 Edit Benefits

A Benefit can be edited as follows:

» Click on the preview in the Title column. P> The form for editing the Benefit opens.

Active Benefits

] Title T~

o [

Or
» Click on the row of the desired Benefit to select it. (1)

» Click on Edit. (2)

Active Benefits 2 0 ac

m  Tite T~ Benefit Amount ~  Benefit A.. ¥  Benefit O... ¥ BenefitTy.. v BenefitC.. v~ Measure.. ¥ Measure.. ~  BenefitSt.. ~
1 Benefit 1 2.00000 € 1.200,00 € @ PPP Projec...  Financial Efficiency..  wochentlich Docume...

» Enter the desired changes in the form.

» Click Save & Close to save the Benefit and finish editing.

< [ ] Save | @ Save & Close | [ Dea

Benefit 1 - saved
Benefit

General

Title " Benefit 1

P Only Benefits with the status Active can be edited. Deactivated Benefits are locked for
editing.
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17.3 Deactivate and Activate Benefits
Benefits are active by default. You can deactivate Benefits:
> Select the Benefit you want to deactivate.
» Click on the Benefit row to highlight it. (1)

» Click on Deactivate. (2)

2 o

L] Title T~ Benefit Amount ~  Benefit A v  BenefitO.. ~ Benefit Ty .~ BenefitC.. v Measure.. ~ Measure.. ~ BenefitSt. « BenefitTa. v  BenefitTa. ~

1 Benafit | 200000 € 120000€ (@ peeProiec.  Financial Efficiency..  wochentiich Docume

» The Confirm Deactivation field opens.

» Click Deactivate to deactivate the Benefit.

Confirm Deactivation X

Do you want to deactivate the selected 1 Benefit? You can reactivate it later, if you wish.

This action will change the status of the selected Benefit to Inactive.

By default, all active and inactive Benefits are listed in the table.
Display only inactive Benefits:

> Go to Active Benefits.

» Click the down arrow.

» Click on Inactive Benefits.

Active Benefits

System Views

Active Benefits

Inactive Benefits
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Activate Benefits:
» Select the Benefit as described above.

» Click on Activate.

Inactive Benefits ~ & Edit G o

Title T~ Created On ~ Descript... »  Benefit ... ~  Benefit.. ~ Benefit.. v Benefit.. ~ Benefit.. ~ Benefit.. ~ Benefit.. ~ Benefit.. ~
B Benefit 200000€  120000€  Docum.. Efficien.. (@ PPP Proj..

P The Confirm Benefit Activation field opens.

» Click on Activate to activate the Benefit.

Confirm Benefit Activation X

Are you sure you want to activate the selected 1 Benefit?

This will set the Benefit to the Active state.

Activate Cancel

17.4 Additional Commands for Benefits
Above the Active Benefits table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

- New Benefit ()} Refresh

“ Flow >
! Fun Report >
88 Excel Templates h
i @ Export Benefits >

r .
BE, See associated records

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 214 /271



>

THE PROJECT GROUP

P If you have selected a Benefit, additional commands related to the selected Benefit will
appear in the drop-down menu:

0B Activate [ Deactivate

=

Delete Benefit

»

Assign Benefits

bt

Share

&

Email a Link

Flow »

B %

Run Report >

)

Word Templates >

(=1
pra)

Export to Excel

il

See associated records

> Select the desired command:

= Delete Benefit: Permanently deletes the selected Benefit.

/\ This action cannot be undone.

= Assign Benefits: Changes the owner of the selected Benefit.
= Share: Shares the Benefit with selected individuals or teams without changing ownership.
® Email a Link: Sends a link to the selected Benefit via email.

= Flow: Runs a flow for the Benefit.

= Run Report: Select a report to run.

= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot
table.

= See associated records: Shows records associated with this view.
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18 Requirements

On the Requirements tab, you can record all project-related requirements centrally and in a structured

manner.
This section describes how to:
= Add Requirementsl?a
= Edit Requirements@
= Deactivate and Activate Requirements@

= Use additional Commands for Requirements@

18.1 Add Requirements

To add a Requirement, proceed as follows:

» Click on New Requirement. » The Quick Create: Requirement form for creating a Requirement

opens.

Active Requirements ~

Requirement T ~ Created On ~ Description ~ Requiremen t Type ~ State ~
Requirement 1

Business Draft

Requirement 2 User Approved

O o0 oo

Requiremen t3 Functional - Interface Rejected

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 216 /271



>

THE PROJECT GROUP

Quick Create: Requirement X
General

Requirement * -

Project * =l ProjectX x 0
State - ~
Requirement Origin - N
Requirement Type - ~
Responsible Team . v
Owner * @M PP Project Manager (Offline) X O

Stakeholders i

o

Effort Estimate i
Hourly Rate .
MaterialCost i

Description

Solution Response

Save and Close . Cancel

= Fill out the form:

P To add a Requirement, the mandatory fields must be filled out. All mandatory fields are
marked with a red star.

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 217 /271



>

THE PROJECT GROUP

= General:
= Requirement: Enter a meaningful name for the Requirement.

= Project: The current project is selected by default.

P You can select a different project by clicking on the search icon (magnifying glass) and

selecting a different project from the drop-down menu.

= State:

» Click in the field and select the status from the drop-down menu.

State --Select-- v

Requirement Origin v ~—Select--

Draft

Requi tT
equirement Type Ready for Review

Responsible Team Approved
Rejected
ouner | Deferred
Stakeholders Waiting for Assignment

Waiting for Estimate

= Requirement Origin:

» Click in the field and select the source of the Requirement from the drop-down menu.

Requirement Origin —Select-- o
Requirement Type v --Select--
RFP
R ible Te
esponsible Team .
* 50w

Owner

Change Request

Stakehold
akeholders Stakeholder Request
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= Requirement Type:

» Click in the field and select the requirement type from the drop-down menu.

Requirement Type —Select-- o
Responsible Team + —-Select--
Business
Owner *
User
Stakeholders Functional - Usability

Functional - Performance

Effort Estimat
ort tstimate Functional - Supportability
Hourly Rate Functional - Security

Functional - Interface

= Responsible Team:

» Click in the field and select the responsible team from the drop-down menu.

Responsible Team --Select-- -
Owrner « " --Select--
PMO

Stakehold
akenolders Business Analysis

Effort Estimate Development

Configuration

Hourly Rat

ey T Testing

MaterialCost Training
Finance

= Owner: Creator of the Requirement. The current user is entered by default.

P You can select a different owner by clicking on the search icon (magnifying glass) and selecting

a different owner from the drop-down menu.

= Stakeholders:
» Click on the input field, press the Enter key, and enter the stakeholder.
= Effort Estimate:

> Enter the effort estimate numerically.
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= Hourly Rate:
» Enter the amount.
= Material Cost:
» Enter the amount.
= Description, Solution Response:

> Enter a description and a proposed solution for the Requirement. The descriptions should be

as meaningful as possible.
» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Requirement.

Save & Create New

Save and Close -

P A Requirement is added.

P The Requirement appears in the Active Requirements table.
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18.2 Edit Requirements
A Requirement can be edited as follows:

» Click on the preview in the Requirement column. P The form for editing the Requirement opens.

Active Requirements ~

[l Requirement T~

0 [Fewrenen |

Or
» Click on the row of the desired Requirement to select it. (1)

» Click on Edit. (2)

Active Requirements 2 0 Activate [3
@]  Requirement T~ Created On ~ Description ~ Requirement Type ~ State ~
1 Requirement 1 Business Draft

» Enter the desired changes in the form.

» Click Save & Close to save the Requirement and finish editing.

< 2 & Save | @Y Save & Close | [3

Requirement 1 - saved

Requirement

General

Requirement " Requirement 1

P Only Requirements with the status Active can be edited. Deactivated Requirements are
locked for editing.
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18.3 Deactivate and Activate Requirements
Requirements are active by default. You can deactivate Requirements:
> Select the Requirement you want to deactivate.
» Click on the Requirement row to highlight it. (1)

» Click on Deactivate. (2)

Active Requirements ~ & Bt B Activate

2

(B  Requirement T~ Created On v D ion ~ Type ~ State

1 Requirement 1 Business. Draft

P The Confirm Deactivation field opens.

» Click Deactivate to deactivate the Requirement.

Confirm Deactivation X

Do you want to deactivate the selected 1 Requirement? You can reactivate it later, if you
wish.

This action will change the status of the selected Requirement to Inactive,

By default, all active and inactive Requirements are listed in the table.
Display only inactive Requirements:

> Go to Active Requirements.

» Click the down arrow.

» Click on Inactive Requirements.
Active Requirements

System Views

Active Requirements

Inactive Requirements
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> Select the Requirement as described above.

» Click on Activate.

Inactive Requirements ~

Requirement T~

e 1

P The Confirm Requirement Activation field opens.

» Click on Activate to activate the Requirement.

Confirm Requirement Activation

Are you sure you want to activate the selected 1 Requirement?

This will set the Requirement to the Active state.

18.4 Additional Commands for Requirements

>
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Description ~ Requirement Type ~ State ~
Business Draft

Above the Active Requirements table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

- New Requirement

="

Flow

Fun Report

Excel Templates
Export Requirements

See associated records

() Refresh
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P If you have selected a Requirement, additional commands related to the selected
Requirement will appear in the drop-down menu:

G Activate [& Deactivate

=

Delete Requirement

»

Assign Reguirements

S

Share

&

Email a Link

Flow >

B %

Run Report >

&

Word Templates >

=]
=

Export to Excel

il

See associated records

» Select the desired command:

= Delete Requirement: Permanently deletes the selected Requirement.

/\ This action cannot be undone.

= Assign Requirements: Changes the owner of the selected Requirement.
= Share: Shares the Requirement with selected individuals or teams without changing ownership.
= Email a Link: Sends a link to the selected Requirement via email.

= Flow: Runs a flow for the Requirement.

= Run Report: Select a report to run.

= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot
table.

= See associated records: Shows records associated with this view.
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19 Lessons Learned

On the Lessons Learned tab, you can document insights gained during the course of the project. Both

positive experiences and potential for improvement can be recorded in this section.
This section describes how to:

= Add Lessons Learned| s

= Edit Lessons Learned| 2!

= Deactivate and Activate Lessons Learned |zl

= Use additional Commands for Lessons Learned|z_3h

19.1 Add Lessons Learned

To add Lessons Learned, proceed as follows:

» Click on New Lesson Learned. > The Quick Create: Lesson Learned form for creating a Lesson

Learned opens.

Active Lessons Learned « - Mew Lesson Learned
O  Lesson 1~ Created On ~ Knowledge Area Lesson Type ~ Description ~ Impact ~ Recommar,

[J tessont Communicatio... Success

[0 tesson2 Risk Managem Problem
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Quick Create: Lesson Learned %
General

Lesson *

Project * =l Project X x 0
Owner * @ FPP Project Manager (Offline) x 0O
Knowledge Area - w
Lesson Type . v

Description

Impact

Recommendations

Rating

Save and Close . Cancel

= Fill out the form:

P To add a Lesson Learned, the mandatory fields must be filled out. All mandatory fields are
marked with a red star.
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= General:
= [esson: Enter a meaningful name for the Lesson Learned.
= Project: The current project is selected by default.

= Owner: Creator of the Lesson Learned. The current user is entered by default.

P You can select a different project and owner by clicking on the search icon (magnifying glass)

and selecting a different project or owner from the drop-down menu.

= Knowledge Area:

» Click in the field and select the knowledge area from the drop-down menu.

Knowledge Area --Select-- =

Lesson Type v —Select--

Integration Management

Description Scope Management
Time Management
Cost Management

Impact Quality Management

Human Resource Management

Communications Management

= lesson Type:

» Click in the field and select the type of Lesson Learned from the drop-down menu.

Knowledge Area o y
Lesson Type - Select- .
Description v --Select--

Problem

Success

= Description, Impact, Recommendations::

> Enter a description, impact, and recommendation. The descriptions should be as meaningful

as possible.
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= Rating:
» Give your rating by selecting 1 (minimum) to 5 stars (maximum).
» Click Save and Close.
Or

» Click the down arrow and Save & Create New to add another Lesson Learned.

Save & Create Mew

Save and Close -

P A Lesson Learned is added.

P The Lesson Learned appears in the Active Lessons Learned table.

19.2 Edit Lessons Learned

A Lesson Learned can be edited as follows:

» Click on the preview in the Lesson column. P The form for editing the Lesson Learned opens.

Active Lessons Learned ~

[] Lesson T~

[] Lesson 1

Or

» Click on the row of the desired Lesson Learned to select it. (1)
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» Click on Edit. (2)

Active Lessons Learned ~

@ Lesson T~ Created On ~ Knowledge Area~  Lesson Type ~

1 Lesson 1 Communicatio... Success

» Enter the desired changes in the form.

» Click Save & Close to save the Lesson Learned and finish editing.

€ 2 B Save | @ Save & Close| [ Deacti

Lesson 1 - saved

Lesson Learned

General

.
Lesson Lesson 1

THE PROJECT GROUP

2[7 e ] B s

Description Impact ~

P Only Lessons Learned with the status Active can be edited. Deactivated Lessons Learned are

locked for editing.

19.3 Deactivate and Activate Lessons Learned

Lessons Learned are active by default. You can deactivate Lessons Learned:
» Select the Lesson Learned you want to deactivate.
» Click on the Lesson Learned row to highlight it. (1)

» Click on Deactivate. (2)

Active Lessons Learned

@  Lesson T~ Created On ~ Knowledge Area ~ Lesson Type ~ Description ~

1 Lesson 1 Communicatio.. Success
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P The Confirm Deactivation field opens.
» Click Deactivate to deactivate the Lesson Learned.
Confirm Deactivation X

Do you want to deactivate the selected 1 Lesson Leamed? You can reactivate it later, if
you wish,

This action will change the status of the selected Lesson Learned to Inactive.

By default, all active and inactive Lessons Learned are listed in the table.
Display only inactive Lessons Learned:

» Go to Active Lessons Learned.

» Click the down arrow.

» Click on Inactive Lessons Learned.

Active Lessons Learned «

System Views

Active Lessons Learned

Inactive Lessons Learned

Activate Lessons Learned:
> Select the Lesson Learned as described above.

» Click on Activate.
Inactive Lessons Learned & Edit  pe

Lesson T~ Created On ~ Knowledge Area~  Lesson Type ~ Description ~ Impact ~ Rec

B lessoni Communicatio... Success

P The Confirm Lesson Learned Activation field opens.
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> Click on Activate to activate the Lesson Learned.
Confirm Lesson Learned Activation X
Are you sure you want to activate the selected 1 Lesson Learned?
This will set the Lesson Learned to the Active state.
Activate Cancel

19.4 Additional Commands for Lessons Learned
Above the Active Lessons Learned table, there are additional commands that you can use:

» Click on the three dots to the left above the table. » A drop-down menu will open.

| MNew Lesson Learned ) Refresh D

=  Flow >
. Run Report >
85 Excel Templates >
B  Export Lessons Learned >

B See associated records
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P If you have selected a Lesson Learned, additional commands related to the selected Lesson
Learned will appear in the drop-down menu:

B Activate [& Deactivate

=

Delete Lesson Learned

»

Assign Lessons Learned

o

Share

&

Email a Link

Flow p

B %

Run Report >

&

Word Templates >

[ =]
pau

Export to Excel

il

See associated records

» Select the desired command:

= Delete Lesson Learned: Permanently deletes the selected Lesson Learned.

/\ This action cannot be undone.

= Assign Lessons Learned: Changes the owner of the selected Lesson Learned.

= Share: Shares the Lesson Learned with selected individuals or teams without changing

ownership.
= Email a Link: Sends a link to the selected Lesson Learned via email.
= flow: Runs a flow for the Lesson Learned.
= Run Report: Select a report to run.
= Word Templates: Creates Word documents and templates.

= Export to Excel: Exports the data to a static or dynamic Excel worksheet or to an Excel pivot

table.

= See associated records: Shows records associated with this view.
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20 Drivers

On the Drivers tab, you can manage drivers for your project.
This section describes how to:

= Load and rate drivers in the project@

= Create and view drivers|z]

= Access the Priority Dashboard/ 2!

20.1 Load and rate drivers

Loading drivers:

To load drivers in your project, proceed as follows:
» Open the desired project.
» Go to the Drivers tab.

> Click Load drivers.

Project Details  Schedule Board Resource Plan  Financials  Status Update  Status Report  Risks  Issues Changes Actions Decisions Stakeholders Objectives Benefits  Drivers -

Prioritization Score

Drivers

B Ove Impact Diives S Comments Priocitization Score  Created On
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P A list of all active drivers is displayed.
B Drver lenpact Driver ¢, Commants Priocitization Score  Cenated Ga
B
B
B
B
B
B ased
B
Deleting drivers:
You can delete drivers that are no longer needed as follows:
» Click the checkbox in front of the desired driver.
» Click Delete.
P The driver is deleted from the project.
4 Luaddr.ms

] B Oriver + Impact Driver Sc..  Comments Prioritization Score  Created On

Alignment with Organizati 02.01.2025 15:...

TPG Cost reduction

Rate drivers:

You can specify the impact of a driver on the project as follows:

» In the Impact column, click the cell of the desired driver. P A drop-down menu opens.
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» Click on the desired impact level.
Drivers
B' Driver T Impact Driver Sc... Comments

= TPG Alignment with Organizational Strategy T
B TPG Cost reduction Q

B  TPG Cost Saving

Extreme
TPGE d into new ket
x¥pand into new markets High
= TPG Improve Employee Productivity Moderate
Low
= TPG Increased Market Share
None

O 00000 D0.
W

= TPG Supports product strategy

P The Driver Score column is filled in automatically. The Driver Score is based on the degree of

impact and indicates how strongly a driver influences the project.

P The Prioritization Score is calculated automatically. The Prioritization Score is based on the Driver

Weighting and helps you decide which drivers should be considered first.

Drivers
° o
D B Driver T Impact Driver Score  Comments Prioritization Score
s = YR STCrg T
0 B TPG Alignment with Organizational Strategy Low 25,00 75,00
O B TPG Cost reduction High 75,00 225,00
a B  TPG Cost Saving Moderate 50,00 200,00
O =4 TPG Expand into new markets Extreme 100.00 400.00
O B TPG Improve Employee Productivity MNone 0.00 0.00
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Display driver weighting:

» Click on the desired driver to open its detailed view.

» The Driver Weighting is displayed there in the form of a star rating:

= (O stars = lowest weighting

= 5 stars = highest weighting

TPG Cost reductio

Driver

General Related

Tl LU TR L R T TS T

Mone

Low

Moderate

Strong

Extreme

n - Saved

Mo impact

up to 3%

up to 6%

up to 10%

10% and more

Driver Weighting

Weighting

B 6 6
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In the Portfolio Strategy section of the Navigation ba r|Tsh|, you can create or view drivers, depending on

your permissions.

P The ability to create or edit drivers depends on your user role and access rights.

Create drivers:

» Click Drivers in the Portfolio Strategy section of the Navigation bar. (1) P A list of all active drivers

is displayed.

> Click New in the Command bar +41. (2) @ The New Driver form opens.

TPG Scheduler

Requests

4F  Project Requests

Projects
[ Porifolios
@ Programs

=l Projects

Actions

People

% Resource Plans
A% Resources

R Contacts

Timesheets
® Timesheets

@ Approvals

Reports

EE'} Dashboard

Portfolio Strategy

¢ [ Show Chart IE Delete ~ O Refresh 1 Visuali
2

Active Drivers -

|

I 1 e A I B A L A O

;

¥ Priority Dashboard

% Financials

Weighting | ~

4

4

Name ~

MNachhaltigkeit steigern

Marktanteil in existierenden Markten erhdhen

TPG Cost Saving

TPG Expand into new markets

TPG Supports product strategy

Ausbau neuer Markte und Segmente

TPG Alignment with Organizational Strategy

TPG Cost reduction

TPG Increased Market Share

Kundenzufriedenheit steigern

TPG Improve Employee Productivity

Kosten reduzieren

> Fill out the New Driver form. Select Yes for Project Request? (3)

> Click Save or Save & Close. (4)
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P A new driver is created.

« | 00| & | Save @ Save & Close |E Flow ~

MNew Driver

General

Mame M

Ovimer * (@) Petrs Portfoliona (Offiine) *
Description -

Project Request? @ =3

Project Impact Statements

Maone

Low

Moderate

Strong

Extreme

Driver Weighting

Weighting =
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Even without permission to create, you can view the details of an existing driver:
» Click on the desired driver in the overview.

P The read-only form with the driver details opens. You can view the information, but not edit it.

] Read-only: You don't have access to edit this record.

< [ O Refresh eﬁ Check Access 2 Flow ~ = W

TPG Cost Saving - saved

Driver

General Related

Mame " TPG Cost Saving
Owner * '
Description

Project Request?
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20.3 Priority Dashboard

In the Portfolio Strategy section of the Navigation barm, you can access a Priority Dashboard. The

dashboard supports you in strategically evaluating and prioritizing projects.
The priority values of the projects are based on two factors:
= General weighting of the individual drivers

= The impact that the drivers are expected to have on the respective project

Priority Dashboard

The Priority Dashboard contains two charts and two tables that present key information visually and in

tabular form:
= Overview (bar chart): Top 10: Prioritization Score by Name
= Shows the ten projects with the highest Prioritization Score.
= Active Drivers (pie chart): Count of Drivers by Weighting
= Shows the distribution of active drivers by weighting.
= Project list (table): Project Priority (by default)
= Contains additional information such as project name, status, and responsible person.

= QOther lists can be displayed using the drop-down menu.

(Lists sorted by priority can also be found in the view options under Project Requests and
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Projects in the navigation bar.)

Project Priority ~
System Views

Project Associated View
Active Projects
Owerview

All Projects

Inactive Projects

My Active Projects

Portfolio Summary

Project Priority

Status

Template Lookup View

= List of drivers (table): Active Drivers (by default)
= Shows all drivers currently available in the system.
= QOther lists can be displayed using the drop-down menu.
Active Drivers ~

My Views
Active Drivers List
System Views

Driver Associated View

Active Drivers

Inactive Drivers

Project Request Driver Lockup View
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P The dashboard is automatically updated as soon as changes are made to drivers or projects.

P If necessary, you can update it manually using the Refresh button (if available).

- New Project : Active Drivers v

D Filter by keyword i Delete >
OO Refresh

.~  Ownerv N
B Seeall records

0 £ . E]

] Visualize this view

0 € ‘ = Email a Link > !

10 € ‘ o Flow SN

0 € ﬁ @  Excel Templates > !
@1 Export to Excel >

o i I
@  Import from Excel >

i< @ ooo aa. :
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21 Timesheets

Timesheets allows you to track the work performed for each task in the project. Approved entries are

displayed in the project on the Timesheets tab.
Timesheets offers the following functions:

= Select projects and tasks for a specific period

= Create favourites to quickly transfer tasks and work values to multiple periods

= Status indicators that show the processing status of individual entries

= Callback function to cancel entries that have already been submitted

= Comment function for project team members and approvers
Project employees can record and report their working hours in the My Timesheets view.
Reported times appear in the My Approvals view for project managers, where they can be approved.
In this chapter, you will learn how to use the TPG ProjectPowerPack (PPP) to:

= Use the user interface of the My Timesheets view[2u]

= Assign Timesheets permissions@

= Add tasks to Timesheets|zs]

= Record working timel oss)

= Approve entries 2l

= View approved entries in the project@
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21.1 User interface for Timesheets
The My Timesheets view can be accessed via the Timesheets section in the Navigation barls )
» Go to the Timesheets section in the Navigation bar.

» Click on Timesheets.

P The My Timesheets view opens by default.

= < B9 ReadOnlyGrid G Show Chart (O Refresh | Visualize this view (%) Emailalink =~ 2 Flow v RunReport ~ B Excel Templates @1 ExporttoExcel =~ @Y Import from Excel = v & Share
@ Home
® Recent ) My Timesheets @3 Edit columns Y/ Edit filters
S Pinned v . [
< Previous [ Current DI Next 2025-45 = Favourites E5] Add tasks 2 * O + New
Start
Project ™ @
# My Work
[m] Project Assignment Mon (03.11) Tue (04.11) Wed (05.11) Thu (06.11) Fri (07.11) Sat (... Sun.. Total  Comment it Onsite
Requests
< (] v Project X(3) 3,00 3,00 600 6,00 400 22,00
X Project Requests
Planning Completed 500 2,00 7,00
Projects Financing 300 1,00 600 200 1200
B Portfolios 0O e Project X Detailed Planning 0,00 2,00 1.00 3,00 @ )Mo
® Programs
(] v Project XY(2) 100 100 2,00 4,00
1=l Projects
8 [m] . Project XY Milestone 1 1,00 1,00 Comment to Milestone 1 @ ) No.
Actions ®
v Subtask 3 1,00 200 300
People
(m] v Zeitriickmeldung (5) 400 5,00 2,00 100 2,00 14,00
& Resource Plans
~ v 0 1.00 1.00 4,00
Resources
@ @ (] Zeitruckmeldung Vorgang 1 1.00 300 100 500 @ ) No
0o e Zeitriickmeldung Vorgang 2 1,00 050 1,50 @ N
Timesheets
0O e Zeitrickmeldung Aufgabe 5 1,00 1,00 2,00 @ ) nNo
Timesheets
@ Approvals (m} . Zeitriickmeldung Aufgabe 4 1.00 050 150 @ ) No|
X : 0 800 800 8o 800 w0
Reports

You can switch to other views using the drop-down menu:

My Timesheets[-]

O Search views

All Timesheets
Approved by me
Inactive Timesheets
My Approvals
My Favourites
My Rejected Timesheets
« My Timesheets Default
Timesheet Project View

fE] Manage and share views
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Below the drop-down menu, you will find a command bar. The following commands are available for

time reporting:

|4 Previous [ Current [»| Next 2025-45 Y= Favourites  [E5] Add tasks ~ -] Submit 2 4+ 3 -+ New ©= Duplicate [ij Delete O B S @\ &
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18

= Jump back to the previous week (1)
= Jump to the current week (2)
= Jump to the next week (3)

= QOpen list of all available time periods (4)
2025-42
2025-45 2025-43
2025-44

2025-45

2025-46

2025-47

= Open the Favourites drop-down menu (5)

Tir

Favourites “~ F=1 Add tasks

3% Add to favourites

= Add favourites to timesheet
E

= Open the drop-down menu for adding tasks to Timesheets (6)

E=1 Addtasks ~ -] Subm

i= Add tasks

i= Add current tasks
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= Send selected rows for approval (7)

= Recall selected rows after sending (8)

® Undo last action and repeat last undone action (9)

= Collapse and expand rows in the table and expand up to a specific point (10)
= Add a new row to the table (11)

= Duplicate selected rows (12)

= Delete selected rows (13)

= Reload page (14)

= Shows or hides a graphical representation of the time spent per project (15)
= Expands and opens the page content in a separate window (16)

= Export all or selected rows to Excel (17)

VAR S
B Export all

B Export selected rows

= Open drop-down menu to display more rows per page or reset display settings (18)

W S O B
D Show more lines

[El Reset view settings
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Overview Timesheets:

My Timesheets i Editcolumns Y7 Edit filters

14 Pravious [ Current DI Next 2025-45 v ¥= Favourites v E53 Add tasks + @ + New O J v
= project ™ @ Show/hide graphical representation
E Project T Assignment Mon (03.11) Tue (04.171) Wed (05.11) Thu (06.11) Frii (07.1) Sat (... Sun ... Total ‘Comment Onsite

~ Project X(3) 3.00 3.00 600 600 4,00 22,00
> Project X Planning Completed 500 200 7.00
> Project X Financing 3.00 1,00 500 200 12,00
O . Project X Detailed Planning 0,00 2,00 1,00 3,00 @)
[m} ~ Project XY (2) 100 100 2,00 4,00
(] . Project XY Milestone 1 1,00 1,00 Comment to Milestone 1 @)
v Project XY Subtask 3 1.00 200 3,00
[m] v Zeitriickmeldung (5) 4.00 5.00 200 100 200 14,00
~ = Status Indicator 2,00 1,00 1,00 4,00
O X Zeitriickmeldung Vorgang 1 1,00 3,00 1,00 5,00 @)
(] . Zeitruckmeldung Vargang 2 1,00 050 1,50 @)
(] . Zeitriickmeldung Aufgabe 5 1.00 1,00 2.00 @ )
T

Selection of rows to be
submitted, recalled,

duplicated or deleted . )
Graphical representation

Mon (03.11) Tue (04:22) Wed (05.13) Thu (@6.11) Fri (07.12) Sat (08.11) Sun (09.12)
[ zeitriickmeldung [l Project XY [ Project X

Explanation of status indicator:
= Dot = Draft
= Blue arrow = Submitted
= Green check mark = Approved

= Red cross = Rejected
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21.2 Assign permissions

Members of the project team without comprehensive permissions in PPP can only record their working

hours if the project has been approved for them.
Here's how you can give selected individuals the necessary permissions:
» Click on Projects in the Navigation barls). (1)

» Select the project from the list by clicking on the checkbox (2).

{m Home
© Recent ~ Active Projects
57 Pinned ~ N
a @ @ Q 14 ©pl

Start
- Project ID Name
* My Work

20241017 = PPP Implementation
Requests
X Project Requests 2023-1001 = Project A

2024-10M * Project C2
Projects
& portiolios 20241018 » Project X
@ Programs 1 2 |:| 2025-1019 + Project XY
I =l Projects

2024-1014 = Projekt B2
E& Actions

» Click Share in the Command barm(3).

A, Assign |12 Share |[CZ] Email a Link
3

Or
> Click Share in the Command bar[ +41in the open project. » The drop-down menu opens.

» Click Manage access (4).

L,-""" Share -
= Email link

1 =2 Copy link 4

N

27 Manage access
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» Click in the Add user/team field and search for a team member (5).
> Select the person from the search results.

» Click on the person's name or activate the checkbox (6).

> Under Permissions (7), select at least Read and Append to.

> Click on Share (8) in the bottom right corner.

P The project has been shared with the person in question. They are now authorized to record

times.

Share records X

Manage who can see your record and how much access they get.
Changes made to all users or teams will be shared and options saved after clicking on the Share button.

Add user/team 5

PPP Project User
2 Grant this user or team access to this record by assigning them permissions
) Permissions ()
(m) Previously shared access
Read
C PP PPP Project Manager Wite
Delete ?
. Append
9, GG Gabi Gantt D
Append to
Aszign
(] PP PP ProjectUser G
Share

h ith 1
Share with 1 users 8
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21.3 Add tasks to Timesheets

There are three ways to add a task to Timesheets:
1. Insert a task using the Add tasks drop-down menu.
2. Create a new row in the table.
3. Insert existing tasks that are marked as favorites into the table.

Add tasks drop-down menu:

» Click on Add tasks. » The drop-down menu opens.

Fs? Add tasks ~ -] Subrm

i= Add tasks

= Add current tasks

» Click on Add tasks. P All projects that contain tasks in the selected time period are displayed.

> Select the task you want to add to the table by clicking on the checkbox.

Add tasks
= Current I

i Task Effort Start Finish

] > PPP Implementation (5)

| Vv Project X(3)

: Planning Completed 28.11.2025 28.11.2025
Financing 40 hrs 24.11.2025 28.11.2025
: Detailed Planning 80 hrs 10.11.2025 21.11.2025
~  Project XY (8)

Task 11 35 hrs 06.02.2025 14.02.2025
Subtask 4 40 hrs 03.11.2025 07.11.2025
Task 10 & hrs 06.02.2025 06.02.2025
Milestone 1 28.11.2025 28.11.2025
Task 9 15 hrs 06.02.2025 07.02.2025
\:‘ Show completed tasks | Show department tasks Cancel
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> (Optional) Select the Show department tasks option to also select tasks that are assigned to

generic resources in your department.

P Advantage: This allows you to record team- or department-related tasks, even if they are not
specifically assigned to you. This means that team-related activities can be booked
independently without having to duplicate or reschedule processes for individual persons. This
speeds up time recording and facilitates collaboration on jointly responsible tasks.

P If the Show department tasks checkbox is not available or is not displayed, it must be

activated by the administrator.

Or

> Click on Add current tasks to insert all tasks that take place in the selected period.

» Click on Confirm.

P The selected tasks are added to the Timesheets table.
Add a new row to the table:

> Navigate to the week in which you want to add tasks. (1)

> Click New. (2)

P A new row appears in the table.

My Timesheets

[ 14 Previous 5 curvent b1 Newt 2025-45 4= Favourites ~ £ Add tasks

Project 1+ Hasigament Mon (10,11} Tue (1111} Wed (12:11) Thw (1341) Fri (i1t
~  Project X(4) 400 500 200 100
. reject X Planning Completed

. roject X Detailed Planning

» Click in the Project cell. » A drop-down menu opens.
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Q,

PPP Implementation
Project A

@ Project C2

Project X

Project XY

@ Projekt B2

O 00000000 g
L J

» Select the desired project.

Use favourites:

>
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Favourites allow you to transfer existing tasks to other weeks. The transfer can be done with or

without recorded working hours.

Marking favourites:

» Check the box for the task you want to mark as a favourite.

» Click on Favourites. » The drop-down menu opens.

» Select Add to favourites.

My Timesheets -

Favourites ~ FE=1 Add tasks

Add to favourites

|<l Previous [EZ] Current [»| Next 2025-46 v 3=
= i Project ‘T @ | 77
—| Project M Assignme
-] v Project X(1)
& Project X Financing
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P The selected task will be displayed in the My Favourites view.
My Favourites
e
= i Project ™ @
O Project T Assignment
O ~  Project X(2)
O ® Project X Financing
P If you no longer need a favorite, delete it from the My Favourites view.
My Favourites 3 Editcolumns 7 Ed
+ O = Duplicate
F I Project 1@
-] Project T Assignment Men Tue Wed Thu Fri Sat Total  Comment
-] ~  Project X(2) 5.00 5.00 10.00
. . Project X Financing 0.00
Insert favourites:
» Navigate to the week in which you want to insert the favourites.
» Click on Favourites.
» Click on Add favourites to timesheet. » A form will open.
My Timesheets -
|<| Previous [Z Current [»| Next 2025-47 3= Favourites ~ =3 Add tasks
= # Project T @
= Add f, ites to timesheat
: iject ~ Assignmel aAVOoUrites 1o timesnee ")

> Select the tasks you want to insert. (3)
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» Check the Include values checkbox to transfer the working hours of the task. (4)

» Click Confirm. (5)

Add favourites

Task Mon  Tue Wed Thu Fri Sat Sun Total  Comment
¥  Project X(2)

Financing 1]

Detailed Planning 5 H 10

3

Include values 4 5 Cancel

P The tasks are added to the desired week.
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21.4 Record working time
Record your working time for the desired week as follows:

> Navigate to the week for which you want to record your working times. If the required activity is

not available in the table, add it (see Add tasks to Timesheets@).

» Enter the number of hours worked for each day and task in the table. (1)

P The last row shows the total number of working hours for all entries in the column. (2)

> Hover your mouse pointer over a cell to view the budget information for that allocation.

P The Timesheet Budget displays the planned budget, the hours already logged, the remaining
hours, and the current utilization rate.

P These values always refer to all hours already logged for this assignment.

The following table shows how the system behaves depending on the budget status and overbooking

settings:
Scenario Behavior
The logged hours are below the warning The entry is allowed. The tooltip shows the
threshold. current budget status.
The logged hours reach the warning threshold. After submitting, the timesheet cell shows a

yellow warning.

The logged hours exceed the budget and Editing is allowed. The timesheet cell shows an
overbooking is allowed. orange or yellow warning.
The logged hours exceed the budget and The timesheet cell shows a red error. Submission
overbooking is not allowed. is blocked.
The logged hours exceed 100% utilization and After submitting, the timesheet cell is marked in
overbooking is not allowed. red.

TPG PPP - Scheduler User Guide 2.16 EN
© The Project Group GmbH | All rights reserved 255 /271



>

THE PROJECT GROUP

> Enter details or comments for the person approving the entry in the Comment column (optional).

(3)

> If the work took place on site, set the value in the Onsite column to Yes. (4)

My Timesheets - % Editcolumns 7 Edit filters |/ Filter b
I Previous [Z Current Il Next 202545 7= Favourites £ Add tasks 8 b New O W/
i Project T @
U Project T Assignment Mon (03.11) Tue (04.11) Wed (05.11) Thu (06.11) Fri (07.11) Sat fun Sun e Total Comment Onsite Approver
O ~ ProjectX(3) 3.00 3,00 6,00 600 400 22.00
Planning Completed 500 2,00 7,00
Financing 3,00 1,00 6,00 2,00 12,00
O . Project X Detailed Planning 0,00 2,00 1,00 2,00 @ ) no
m] ~  Project XY(2) 1,00 1,00 2,00 4,00
0 . Project XY Milestene 1 E 1 100 100 Comment to Milestone 1 3 @ Do
v Project Subtask 3 1,00 2,00 3,00
O v Zeitriickmeldung (5) 4,00 500 2,00 1,00 2,00 14,00
v 00 1,00 1,00 400
Zeitrickmeldung Vorgang 1 100 300 1,00 5,00 @ ) No
0O . Zeitrickmeldung Vorgang 2 1,00 050 1,50 @ 4
O . Zeitruckmeldung Aufgabe 5 1,00 1,00 2,00 @ o
O . Zeitruckmeldung Aufgabe 4 1,00 0,50 1,50 @ Do
) 2 [300 8,00 800 200 5,00 40,00

P When entering hours, be sure to check for budget warnings or error messages.

P If the budget is nearly reached, you will receive a warning. If the budget is exceeded, you can
only enter the hours if overbooking is allowed.

P If overbooking is not allowed, correct your entry before submitting the timesheet.

Submit entries for approval:

> Select the checkbox for the row(s) you want to submit for approval.

» Click Submit to send the entry. P A confirmation dialog will open.
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My Timesheets -
|4 Previous [E Current [Pl Next 2025-46 - ¥= Favourites 55 Add tasks ~ |2] Submit
= i Project T @
= Project ‘T Assignment Mon (10.11) Tue {11.1
-] ~  Project X (1) 4,00 5.0
L] Project X Financing 4,00 3,0

» Click Yes to confirm the confirmation dialog.

Confirm submission

Are you sure you want to submit the selected

row?
=

P The transaction(s) have been submitted for approval.

» An arrow will appear in the indicator column.

i Project 1T @

Project ‘T Assignment

o O

“~  Project X(3)
I:l Project Planning Completed

Recall entries:

You have the option to recall entries that have already been submitted.

> Select the checkbox for the line you want to recall.

» Click Recall. » A confirmation dialog will open.
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My Timesheets -
|4 Previous [ Current [*] Next 2025-45 - ¥= Favourites ~ &5 Add tasks = Recall
I i Project T @
= Project T Assignment Mon (03.11) Tue (04.11) Wed
— | v  Project X(3) 3,00 3,00
‘ ‘ ’

Project » Planning Completed
» Click Yes to confirm the confirmation dialog.

Confirm recall

Are you sure you want to recall the selected
row?

. -

Check approval status:
The name of the approving person is shown in the Approver column.
The status is shown in the indicator column:

= Green check mark = approved

= Red cross = rejected

P If the approving person has left a comment, it will appear in the Approvers comment column.

Edit rejected entries:

If your entries has been rejected, edit the line as described above. Resubmit the entry.
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21.5 Approve entries

Project managers are responsible for reviewing and approving or rejecting the entries made by

members of their project team. To do this, proceed as follows:
» Click on Approvals in the navigation bar. (1) » The My Approvals view opens.
» Navigate to the desired week. (2) P The submitted entries are displayed.
» Select the checkbox for the line(s) you want to approve or reject. (3)

» Click on Approve or Reject. (4)

5 Pinned W
My Approvals -
Start 2 4
£ My Work |4 Previous [T Current [l Mext 2025-46 ™ =Y Approve 7 Reject
'
= # Submitter €
Requests
Line Status Submitter Project T
4+ Project Requests
= v Gabi Gantt(4)
Projects
) .
B porifolios
e
I Programs
) e
=!I Projects
Actions e
People .
3

2 Resource Plans
AR Resources

R Contacts

Timesheets

(D Timeshests 1

I & Approvals
|

» Enter a comment for the project team member (optional). This comment will appear in the

Approvers comment column.
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» Click on Confirm.

Confirm approval

Are you sure you want to approve the selected row?

Add approval comments

Confirm rejection

Are you sure you want to reject the selected row?

Add rejection comments

21.6 View approved entries in the project
Approved entries are listed in the Timesheets tab for each project.

» Open the desired project.

> Navigate to the Timesheets tab. (If this is not visible, click on the 3 dots on the right and select
Timesheets from the drop-down menu).

P All approved entries are displayed.

uests
= Project Details  Schedule Board Resource Plan  Commitments  Financials ~ Status Update  StatusReport  Risks lssues Changes Actions Decisions Stakeholders ~Objectives Benefits Requirements -

% Project Requests

% 8
Projects.
# Submitter ™ @
2 Portfolios

Submitter Task Assignment period period Start Period Finish Total  Comment Approver Approvers.

[ Programs

Il projects

B Actions

v Gabi Gantt(1)

Gabi Gantt Aufgabe 3 2025-45 03.11.2025 09.11.2025 400

400

O oo o G

People

P The approved entries for a project are also displayed as a total in the Actual Hours column in
the scheduler.
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22 Project Variants

The project variants feature is an optional component of TPG ProjectPowerPack (PPP) with TPG
Scheduler. With project variants, you can simulate different scenarios of a project. This allows you to

account for changes or issues that have occurred or may occur during the project's runtime.

A2 Search

B Esee @ Seescose B AppyTemplate (3 Deacovate @ CromteTeam @B TeamsSetings (D Retan B Chack Access B2 Process R, mssign B flow : EE
2 Home
S Recent ~ Project X - taw H H PPP Froject Manages  Project Created  Green ]
. Project Variants el e it | Gt | % tomehie
% Piened W Project
Stant Initiating (4 Ml Punsng Exncuting Contreding Clasing >
My Work
L Project Details  Sched.. Board ResourcePlan  Financisk  StatusUpdate  StatusReport  Risks  bsues Changes Actions Decisions Stakeholders  Objectives  Benefits  Requirements  Lessons Leamed -+
Requests
+ Add 7 Edt @ Dekte . % a LB B 1 bl Features = Baseline + Bportfimpont &8 Compare
4 Project Requests
02202004 5029Der2084  So0Skn2025  Soi2 Jan 2028 5019 Jan 2028
. Hama. % Complete  Start Finish Curation Predecessors  Assigned Re
s FSSMOMDFSSMOMDEFESSMOMDFSSMOMDF S5
Ficiests
T PR RN v
I v tject Start @ a 312 Days
IR Frograms 2 “ Phase I Initlation @ 231220 [ 2days 1 F
N—
ki 32 + Croate Projact Begquest @ 23122028 1 clay
Bk actions

A variant is a copy of a project that can be edited without altering the original project. Variants can be
compared with the original project and other variants in the schedule, resource plan, and financial

plan. A new variant is created with a copy of the following tables:
= Project Details (some fields)
= Team Members
= Tasks
= Dependencies
= Assignments
= Baselines
= Resource Plan

= Financials
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22.1 User Interface
Project variants are created and opened in the Project Variants sidebar within the original project.

> To open the Project Variants sidebar, open the original project and click on Variants in the

command barl 11

2 Search

€O B Bam @sencoe Basievme D owoon @ Cmeien @ wmsny O s © onrows [Bwoms | Boows v R Do v ¢ ([EESE
G Mame /
S Recent i Save H H PP Project Manager Py Croated G ]
Project Variants oM | e G |

Project X
Fropct Manager ProsectState Gandi % Compiete
2 Pined v Prcject
art Initiating (4 Ma Pansing Exncuting Contrsling Clasing ¥
E My wor - . - . . .
s Sched.. Board FResourcePlan Financials StatusUpdate  Status Report  Risks ksves Changes Actions Decisions Stakeholders Objectives Benefits  Requirements  Lessons Leamed -+
Requests
t Add 7 Edit @ Delete - -E % 8 S 1 o Features T Basaline * Exportfimport  &§ Compare
G Project Requests
S022Ber2024  So029Dex04 5005 lanIIS S0l lan 2035 S0 19 Jan 2025
. Hame % Complete  Start Finish Duration Predecessors  Assigned e
s FSSMOMDFSSMOMDFSSMOMOFSSMDMOF S S
Puopects
5 . Projecttant .
B Portiolos e @ Oens
B Programs 2 ~ Phase 1 Inftiation @ 29days 1 F
N roject b
B _Actions —

The user interface of the project variant is divided into the following areas:

= Information about the currently opened variant and the name of the original project (1)

Show/hide Project Variant sidebar (2)
= QOriginal Project (3)
= Variant whose project plan is currently open (blue framed) (4)

= Tabs with copied data from the original project (5)

Project Variants X

1 far 1: Start of Phase 2 postponed  Ready Praject X L] v Project X
Varisat Naene Voriset Gabus | Vaisetof Project | Visisnt Cossted On 3
: : : : ----- ect Manage:
Initiating (21 Hrs) Planning Exocuting Controlling Closing >
Variarte 2: Extarna Rossource sinsetzes & B

General |Schedule Project Team  Resource Plan Finan:ialsl Related -

5 PPP Praject Manage
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Under General, you will find data and information about the original project and the selected variant:

Projekt X . caec Var s St of Phune 2 postponed.  fesdy  Projedt X
et et e Vi et e - a0n
O o]
it (2 W) Pasring e g o
" Rescm icios Rl
Varant Detal ————————— H 1
Details current Variant

ariant Name Var 1: et of Brane 2 postoned % Compiete )
riert Deaeton Start of prase 2 posiponed due i SOy Of resources an e T e

sessan
wertolbwiet O papmiet

wen =

Generd General Information on the Original Project and Variant
B [ L.
frogram .

Proect Sate & Project Crmatns
gt it 5 mewsy
Varlart Crostid O 5 P

e Resoes

ameipoecodsd  Details Original Project

22.2 Working with Variants

In the following, you will learn how to work with variants. We will guide you step by step through the

process:
= Createa Variant@
= Edita Variant@

= Compare Variants and Original Projects|2_mh|

22.2.1 Create a Variant
To create a variant of a project plan, follow these steps:

» Open the project for which you want to create a variant.
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> Click on Variants in the Command barl 1. » The Project Variants sidebar will open. This area
displays all previously created variants of the project.

Project Vaniants b

War 2 Lhe evternal revcance

War 12 SLar1 of Phase 2 peditpaned

» Click on Add. » The fields Variant Name and Variant Description will appear.
» Enter the name of the variant in the Variant Name field. (1)

» Optionally, you can add a description for the variant. (2)

P Make sure to use a meaningful name and description. This will make it easier to compare
with the original project and other variants later.
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» Click on Create. (3)
Project Variants ®
Variant Hame *

1 Var 1; Start of Phase 2 postponed
Variant Description

Start of phase 2 postponed due to scarcity of resources.

2
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» The variant is displayed in the Project Variants sidebar under the original project.

Project Variants

X

PPP Project Manager

Status Active project

Var 2: Use external resource

Variant Description
ariant Status Ready
Var 1: Start of Phase 2 postponed P2
Variant Description Start of phase 2 postponed due
to scarcity of resources,
ariant Status Ready

P The variant includes the schedule with assignments, the project team, the resource plan, and

the financial plan of the original project.
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sidebar.
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To display and edit data in a variant, select the desired variant (e.g. Var 1) in the Project Variants

Project Variants

Project X

Active project

PPP Project Manager

Var 2: Use external resource &
aria at Ready
Var 1: Start of Phase 2 postponed P

Ready

Start of phase 2 postponed due
to scarcity of resources,

opens.

» Click on the desired variant or on the edit icon for the variant. » The corresponding project plan

Start of Phase 2 postponed

Ready

il

Start of phase 2 postponed due
to scarcity of resources,

~
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For a short time, a banner under the Header Barl 1 lindicates that you are editing a variant.

TPG Scheduler

A Currently editing a variant of project 'Project X'

< O £ Save - Save & Close

> Edit the data on the project tabs as required. How to edit the data is described in detail in the
chapters Task planning in the Schedule@, Resource Planningrsshl and Budget PIanningm.

Example:

In this example, the schedule is changed: An interval of 10 working days is inserted before phase 2. The

variant project thus ends 2 weeks later than the original project.

=+ Add H = Q. @ b (] =3 i= Features =. Bazeline =+ Export/Impaort &3 Compare
024 Dezember 2025 Januar 2025 Februar 2025 M
# Name % Complete  Start Finish
15 05 12 129 26 0z (] 16 23 02 0
1 = Project Start 23122024 23122024
2 “ Phase 1: Initiation 23.12.2024 30.01.2025 r "
3 2 « Create Project Request 23122024 23122024 [
42 - Review Project Request @ 06012025 17.012025 1
Y | - Identify Risks 20012025 30012025 [ |
6 = Initiation Completed 30.01.2025 30.01.2025
7 ~ Phase 2: Planning L) 17.02.2025 14.03.2025 )
8 = Preliminary Planning 17.02.2025 21.02.2025 .
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If changes are made to the schedule or assignments, the resource plan must be adjusted.

» Open the Resource Plan tab and click on Sync. » The Synchronize rows dialog box opens.

» Click Overwrite existing.

» Click Include working values if you also want to transfer the working values.

» Click on Update.

Synchronise rows

Synchronise tasks and team members with this
resource plan

Overwrite existing

Include work values

P There should no longer be any resource overloads in the resource plan.

> If the finances are affected by changes, open the Financials tab and adjust the data by moving the

costs to later periods. (see Budget Planningm)
Delete Variant:
> In the Project Variant sidebar, select the variant you want to delete.

» Click on the delete icon.

-

Var 1: 5tart of Phase 2 postponed & | W

Start of phase 2 postponed due
to scarcity of resources.

Ready
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22.2.3 Compare Variants and Original Projects

Project variants can be compared with the original project and its other variants on the Schedule,
Resource Plan and Financials tabs. This is possible in the plan of the original project or one of the

variants.

» Click on Compare. » A drop-down menu with all project variants appears.

» Click on the variants that you want to compare with the currently open plan.

+ Add w 8 8 @ b d b Features = Baseling — Export/import &5 Compare
2024 Dezember 2025 Januar 2025 Februar Var 1: Start of Phase 2 postooned
# Name % Complete  Start Finish B2 vor 1:5tart of Phase 2 postponec
15 o5 12 19 % 0z 0 16
Var Z: Use external resource
1 * Project Start 23122024 23122024
r |
2 * Phase 1: Initiation @ 23.12.2024 30.01.2025 "
3 a2 + Create Project Request @ 23122024 2312.2024
s 2 + Review Project Request 06.01.2025 17.012025
5 & +  Identify Risks @ 20.0M.2025 30.01.2025
6 @ + Initiation Completed @ 30.m.2025 30.01.2025 .
* Phase Z: Planning O 31.01.2025 27.02.2025

P You can select up to 3 variants for comparison in the schedule.

P A colored dot in front of the selected variant indicates the color in which the process bar is
displayed in the Gantt chart.

P On the Resource Plan and Financials tab, you can compare all variants at once. These are
displayed one below the other in the table.

Variant Mame

>  Project X(3) J

»  Var 1: Start of Pha... (5)

>  Var 2: Use extern... (3)
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The compact view is recommended for a better overview.
= In the schedule:

» Click on Features and select Show more lines.

= Features ~ =; Baseline

i
[

2 Draw dependencies 5

Show task labels

o

Show critical path
Draw start and end
Draw today indicator |

Highlight non-working time

Show more lines

Show resource utilization

(< IR < [N < < <

Show inter-project links

D Show timeline

= |n the Resource or Financials plan:

» Click on Settings (gear wheel) and select Show more lines.

ef S EE |8 v

Show more lines

El Reset view settings
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